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About this guide

About the guide
The Apple Style Guide provides editorial guidelines for text in Apple instructional materials, 
technical documentation, reference information, training programs, and user interfaces. 
The intent of these guidelines is to help maintain a consistent voice in Apple materials.

Writers, editors, and developers can use this document as a guide to writing style, usage, 
and Apple product terminology. Writers and editors should thoroughly review the guide to 
become familiar with the range of issues involved in creating high-quality, readable, and 
consistent materials. Apple developers and third-party developers should follow these 
guidelines for user-facing text.

You can also get this guide from Apple Books or view it on the web.

Other editorial resources used at Apple
In general, follow the style and usage rules in:

• The American Heritage Dictionary

• The Chicago Manual of Style

• Words into Type

Exceptions to guidelines in these resources are noted in this guide. In cases where 
resources conflict with each other, follow The Chicago Manual of Style for style and usage 
questions, and The American Heritage Dictionary for spelling guidance.

Some departments at Apple (Marcom, for example) have supplemental style guides.

For information about the user interface, consult these Apple documents:

• iOS Human Interface Guidelines

• macOS Human Interface Guidelines

• tvOS Human Interface Guidelines

• watchOS Human Interface Guidelines

https://itunes.apple.com/us/book/id1161855204?ls=1
https://help.apple.com/applestyleguide/
https://developer.apple.com/design/human-interface-guidelines/ios/overview/themes/
https://developer.apple.com/design/human-interface-guidelines/macos/overview/themes/#/
https://developer.apple.com/design/human-interface-guidelines/tvos/overview/themes/
https://developer.apple.com/design/human-interface-guidelines/watchos/overview/getting-started/
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Conventions used in this guide
Modifiers consisting of two or more words are often hyphenated when they precede a 
noun, but not when they follow the verb as a compound predicate adjective. This guide 
distinguishes the differences as follows:

• An entry followed by adj. in parentheses gives the form to be used when the adjective 
immediately precedes the noun it modifies.

• An entry followed by pred. adj. in parentheses gives the form to be used when the 
adjective is a predicate adjective. For example:

user-friendly (adj.), user friendly (pred. adj.)

• If a hyphenated compound has no pred. adj. entry, hyphenate the compound wherever 
it appears in a sentence.

How to request revisions
If you’re an Apple employee or a registered Apple developer, you can request additions 
or revisions to the Apple Style Guide by filing a bug report using bugreport.apple.com. 
Otherwise, you may email feedback to ASGFeedback@group.apple.com. (We regret that  
we can’t respond to feedback.)

Changes to the guide
This version of the Apple Style Guide includes a new chapter, Writing inclusively, as well as 
the changes listed below.

New entries
• accessibility

• AirDrop

• Apple Fitness+

• Apple M1 chip

• Apple News

• Apple News+

• Apple services

• Apple silicon

• Apple T2 Security Chip

• App Library

• AssistiveTouch

• Back button

• black box/white box (n., adj.)

• black hat/white hat

• black/white

• blind, low vision

https://bugreport.apple.com
mailto:ASGFeedback@group.apple.com
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• closed captions (n.), closed captioning (n., adj.), closed-captioned (adj.)

• color blind, color blindness

• colored

• deafblind, Deafblind

• deaf or hard of hearing, Deaf

• disability

• dummy

• Forward button

• grandfathered, grandfathered in

• Guides

• handicapped

• hearing impaired

• impairment

• information card

• kill

• livestream (n., v.), livestreaming (n.)

• man-in-the-middle attack

• master

• master branch

• master-detail (adj.)

• mate

• rotor

• rule of thumb

• sanity check, sanity test

• SDH

• sighted

• Smart Stack

• spatial audio

• stream (n., v.), streaming (n., adj.)

• surround sound (n., adj.)

• Today View

• visually impaired

• wheelchair user
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Changed entries
• Apple Books

• Apple logo

• Apple Music

• Apple Pay

• Apple TV+

• Apple Watch

• badge (n.)

• blacklist/whitelist (n., v.)

• button

• disable (v.), disabled (adj.)

• disclosure arrow

• disclosure button

• Dolby formats

• iPhone

• left arrow

• Mac

• pronouns

• right arrow

• Spotlight

• submenus

• voiceover, VoiceOver

• widget

• window controls

• zoom, Zoom

Deleted entries
• banner (replaced by information card)

• Graphite appearance

• submenu indicator

• zoom button
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Changes to the July 2020 version

New entries

action sheet; Apple Diagnostics; Apple Original; Apple TV+; Asia Pacific (n., adj.); Black (adj.); blacklist/whitelist 
(n., v.); CarPlay; device; HDR (n., adj.); high dynamic range (n.), high-dynamic-range (adj.); HomePod; LCI; 
liquid contact indicator; logic board; master/slave; Medical ID; onsite; product; recovery mode (n., adj.); safe 
mode; SDR (n., adj.); share sheet; slave; smart TV; standard dynamic range (n.), standard-dynamic-range (adj.); 
streaming device, streaming player; whitelist; wide color gamut (n.), wide-color-gamut (adj.)

Changed entries

computer; drag and drop (n., v.), drag-and-drop (adj.); iPod; italics (n.), italic (adj.); let; main logic board; mobile 
device; Picture in Picture (n., adj.), picture-in-picture (adj.); pointer; pop-up (n., adj.); quotation marks; screen; 
sheet; sync, synced, syncing; system; tooltip; type (v.); Wi-Fi

Deleted entries

dock adapter; Hold switch

Changes to the December 2019 version

New entries

Catalyst; clamshell; country; EU; Files app; gallery view; Gallery View button; hover (v.); Hover Text; inclusive 
language; iPadOS; iPadOS device; lid; long press (n.), long-press (adj.); Look Around; Macao; Mac Catalyst; 
Managed Apple ID; pronouns; Sidecar; Sign in with Apple; whether

Changed entries

Apple now lowercases internet, resulting in changes to internet, Internet and throughout the guide; references 
to the iTunes app were deleted throughout the guide; 3D Touch; abbreviations and acronyms (added new bullet, 
“Articles”); Apple Remote; Apple Store; Apple TV Remote; calendar; cross-references; Dark Mode; download 
(n., v.), downloadable (adj.); Downtime; FileMaker (was previously FileMaker, Inc.); GIF (deleted pronunciation 
advice); help; iCloud; iCloud Drive; iOS; iOS device (in addition, references to iOS device were edited throughout 
the guide); Menu button; Personal Hotspot, Instant Hotspot; press; push; Raise to Speak; Siri Remote; they, their, 
them; touch and hold; U.S.

Deleted entries

Cover Flow; Cover Flow button; fair language (replaced by inclusive language); Glances; help book; Mac Help; 
Peek and Pop; universal app

Changes to the February 2019 version

New entries

Activity rings; Animoji; APFS; Apple Books; Apple File System; Apple Pencil; Auto Exposure; Auto Focus; Books; 
Book Store; Countries (addition to “International Style”); Dark Mode; Emergency SOS; Face ID; fall detection; 
Haptic Touch; iBooks; iCloud Photos; kilogram-force centimeter (addition to Names and unit symbols for 
units of measure); like, love; Memoji; Raise to Speak; Raise to Wake; Shared Albums; SIM; Siri Shortcuts; Siri 
Suggestions; Tap to Wake; TrueDepth; True Tone; Voice Memos; Walkie-Talkie; watchlist

Changed entries

Apple menu; App Store; dialog; Do Not Disturb; earlier, later; highlight (v.); iCloud; iCloud Photo Library; iCloud 
Photo Sharing; iMovie; iPhone; latest; most recent; movie; single sign-on (n., adj.); social media (pl. n., adj.); 
Stacks; Touch ID; update; upgrade; version number
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Style and usage

Numbers
2-byte character  Don’t use; use double-byte character.

2D  Abbreviation for two-dimensional. No hyphen in the abbreviation. For guidelines about 
spelling out abbreviations, see abbreviations and acronyms.

2K, 4K, 5K, 6K, 8K (adj.)  Horizontal screen resolution or image resolution measured in 
thousands of pixels. Don’t use a space between the numeral and the K.

The 27-inch iMac has a Retina 5K display.

Apple ProRes codecs support all standard frame sizes (including SD, 
HD, 2K, and 4K).

3D  Abbreviation for three-dimensional. No hyphen in the abbreviation. For guidelines 
about spelling out abbreviations, see abbreviations and acronyms.

3D Touch  A technology used in some older iPhone models that lets users access 
additional features by pressing the display. Newer models use Haptic Touch. See also 
Force Touch; Haptic Touch; press. 

10Base-T, 100Base-T, 1000Base-T  Note capitalization. See also Ethernet; Fast Ethernet 
(100Base-T); Gigabit Ethernet (1000Base-T).

24/7  Not 24x7. To spell out, use the form 24 hours a day, 7 days a week; a 24-hour-a-day, 
7-day-a-week support program.

A
AAC  Abbreviation for Advanced Audio Coding, an industry-standard audio compression 
format. For guidelines about spelling out abbreviations, see abbreviations and acronyms.

abbreviations and acronyms  An acronym is a pronounceable word formed from the initial 
letter or letters of major parts of a compound term. An abbreviation is usually formed 
in the same way but isn’t pronounced as a word. Abbreviations are often lowercase or a 
mix of lowercase and uppercase. Acronyms are almost always all caps, regardless of the 
capitalization style of the spelled-out form.

Abbreviation: mph—for miles per hour; MB/s—for megabytes  
per second

Acronym: ROM—for read-only memory
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• When to spell out: If you think your audience might not be familiar with an abbreviation 
or acronym, spell out its first occurrence on a page or in a section. In user materials, 
spell out the term when you introduce it.

• How to spell out: When you spell out a term, generally put the spelled-out version first, 
with the abbreviation or acronym in parentheses.

internet service provider (ISP)

If the abbreviation or acronym is much more familiar than the spelled-out version, 
you can put the abbreviation or acronym first, followed by the spelled-out version in 
parentheses, or you can explain that the abbreviation is “short for” the spelled-out 
version and place the spelled-out version in italics.

You can share your personal URL (Uniform Resource Locator).

An internet address is sometimes called a URL, short for Uniform 
Resource Locator.

• File types: Use all caps for abbreviations of file types.

a JPEG file, an AIFF file, the MP3 file

Filename extensions, which indicate the file type, should be in lowercase.

.jpg, .aif, .mp3, .iba

See also filename extensions; file types.

• Pronunciation: If you think the reader might not know how to pronounce the acronym, 
provide a pronunciation key.

WYSIWYG (pronounced “WIZ-zee-wig”)

See also pronunciation.

• Articles: Use the article a or an with an abbreviation or acronym, depending on  
its pronunciation.

a SAN, a USB port, an FAQ, an LCD screen

• Punctuation: Don’t use periods except in abbreviations for nonmetric units of measure 
and in the abbreviations a.m., p.m., and U.S. (see U.S. for exception).

• Plural: Don’t add an apostrophe before the s when you form the plural of an 
abbreviation.

CDs, ICs, ISPs

• Latin: Avoid using Latin abbreviations.

Correct: for example, and others, and so on, and that is, or equivalent 
phrases

Incorrect: e.g. (for example), et al. (and others), etc. (and so on),  
i.e. (that is)

• Units of measure: See Units of measure for detailed usage guidelines.

• Product names: Don’t abbreviate any Apple product or service names, whether or not 
the product or service is trademarked or has a service mark.
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abort  Avoid in user materials. See also exit; interrupt; quit; stop.

above, below  You can use above or below to describe text or an object that closely 
precedes or follows the current paragraph.

In the example above, clip B is shortened and clip C is lengthened, but 
their combined duration stays the same. [earlier figure]

These sliders mirror the settings of the Levels sliders, described 
above. [earlier text]

The diagram below shows a typical network configuration. [later figure]

The process for creating a multicam project is outlined below. [later text]

Otherwise, use a cross-reference (consult your department’s guidelines about the style of 
cross-references).

See also cross-references.

AC  Abbreviation for alternating current. For guidelines about spelling out abbreviations, 
see abbreviations and acronyms.

AC adapter  Don’t use; use power adapter. See also adapter; power adapter.

access (n., v.)  It’s OK to use access as a verb when you can’t be more specific. Even in 
developer materials, consider more precise terms, such as log in to.

Avoid: Access the server using an administrator account.

Preferable: Log in to the server using an administrator account.

Avoid: You can access the internet with your MacBook Air.

Preferable: You can connect to the internet with your MacBook Air.

accessibility  Refers to features that enable people with disabilities to successfully use 
Apple products and services. Capitalize the names of accessibility features. For example:

Accessibility Keyboard; AssistiveTouch; Guided Access; Hover Text; 
Invert Colors; Larger Dynamic Type; Live Listen; Magnifier; Safari 
Reader; Speak Screen; Speak Selection; Switch Control; Text to Speech; 
Type to Siri; Typing Feedback; Voice Control; VoiceOver; Zoom

See also Writing about disability.

access point  Also called a wireless access point. A device, such as a base station, that 
transmits and receives data in a wireless network. See also AirPort.

Access Point Name  See APN.

acronyms  See abbreviations and acronyms.
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action  A component of an Automator workflow. A workflow is an entire task. Each action is 
a specific part of the task (such as opening a new message in Mail).

action description  In Automator, the description of the selected workflow action.

Action pop-up menu  A pop-up menu labeled with a gear and a down arrow in the Finder 
and in apps for Mac such as Mail.

action sheet  In iOS and iPadOS, refers to an alert that appears in response to a control or 
action and presents a set of two or more choices related to the current context.

In user materials, don’t use the term action sheet, sheet, or popover; instead, describe 
what the user must select or do.

Correct: Tap New Tab.

Incorrect: Tap New Tab in the sheet that appears.

In developer materials, action sheet is OK.

See also popover; share sheet; sheet.

activate, deactivate  Avoid; instead, use turn on, turn off.

active  Use to refer to the app or window currently being used. Preferred to in front.  
See also front, frontmost; in front.

Activity rings  Capitalize the names of the rings that track your daily activity in the Activity 
app (for example, Stand ring, Exercise ring).

adapter  Not adaptor. Capitalize names of adapters that are sold separately.

address  Can refer either to an internet address or to the location in the computer’s 
memory where a piece of information is stored. OK to use just address for either, as long 
as the context is clear. See also email addresses; internet addresses; memory address, 
memory location.
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addresses (mailing)  Use the forms shown here for addresses. To include the country 
name in a U.S.-based Apple address, use USA (no periods).

• Apple corporate address: Use this form:

Apple [not Apple Inc.] 
One Apple Park Way
Cupertino, CA 95014

• Specific Apple mailing addresses:

Department Name
Apple
One Apple Park Way, MS xx-xx
Cupertino, CA 95014

• Other addresses: For other addresses, spell out elements such as Avenue, Drive, Road, 
Street, and Suite. It’s OK to abbreviate Blvd. and Bldg. Use the format shown in the 
preceding examples for city and state. Use two-letter abbreviations for state names 
(see The Chicago Manual of Style).

adjuster  Don’t use to refer to a control that has up and down arrows, or left and right 
arrows, to increase or decrease a value. In user materials, use up arrow, down arrow, 
right arrow, left arrow, or arrows, as appropriate. For example, Click one of the arrows to 
increase or decrease the volume. If it’s necessary to refer to the control itself, use stepper. 
See also stepper.

administrator (n.)  A person who has administrative authority for networks, servers, 
databases, or other information technology assets. Don’t shorten to admin.

To maintain the distinction between professional administrators and macOS users 
with administrator accounts, avoid using the noun administrator by itself to describe a 
person who has an administrator account in macOS. Instead, you can say a user with an 
administrator account—typically, the owner (or owners) of a particular Mac computer.

Correct: To obtain a static IP address for your computer, contact your 
network administrator.

Correct: You must have an administrator account to modify other user 
accounts on a Mac.

Incorrect: You must be an administrator to install software.

See also administrator (adj.); System Administrator.

administrator (adj.)  Use in macOS to describe the primary account (or accounts) that 
can create other accounts, set access privileges, install software, and make systemwide 
settings. OK to shorten to admin in server and training materials. Don’t use the possessive 
form: administrator’s account, administrator’s password, or admin’s permissions.

Correct: Log in with an administrator account to install software.

Correct: To give a user broad privileges on a Mac, create an admin 
account for the user.

Incorrect: Log in with an administrator’s account to install software.

An administrator computer is a computer with macOS or macOS Server that you use to 
manage remote servers.

See also administrator (n.); standard user; System Administrator.
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Advanced Video Coding High Definition  See AVCHD.

advisor, Advisor  Use Advisor to refer to a person in a customer-facing AppleCare  
Support position, including those at one of Apple’s outsourced vendor sites. Don’t use 
agent or representative. Use advisor if you’re not referring specifically to an AppleCare 
Support person.

College students can apply to be Apple At-Home Advisors.

AFP  Abbreviation for Apple Filing Protocol. For guidelines about spelling out abbreviations, 
see abbreviations and acronyms.

afterward  Not afterwards.

agent  Don’t use when referring to an AppleCare Support person. See also advisor, Advisor.

AirDrop  Don’t use as a verb.

Correct: You can use AirDrop to send photos, documents, and more to 
other Apple devices nearby.

Incorrect: You can AirDrop photos, documents, and more to other Apple 
devices nearby.

AirMac  The name for AirPort in Japan: AirMac wireless networking, AirMac Extreme  
Base Station, AirMac Express Base Station, and so on.

airplane mode  Note lowercase.

AirPlay  Don’t use as a verb.

Correct: You can use AirPlay to stream videos from iPhone to Apple TV.

Incorrect: You can AirPlay videos from iPhone to Apple TV.

AirPods  In general references, don’t use an article with AirPods; when referring to the 
user’s particular AirPods, it’s OK to use your. You can use just AirPods to refer to one or 
more models if the context makes clear which model (or models) you’re referring to.

You can use AirPods to make and answer phone calls with your iPhone.

AirPods Pro connect to your Apple devices automatically.

Avoid using singular AirPod; instead, try to rewrite the sentence. If you do use singular 
AirPod, use the plural form of the name nearby, and don’t use it in a prominent location, 
such as a heading.

Avoid: You can change how each AirPod responds when you press or 
tap it.

Preferable: You can change how each of your AirPods responds when 
you press or tap it.
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AirPort  Versions include AirPort, AirPort Extreme, and AirPort Time Capsule. You can use 
AirPort to refer generally to Apple’s wireless networking products or technologies or to 
refer to the family of AirPort products: your AirPort network, AirPort software.

• Software: AirPort software includes AirPort Utility and AirPort Disk Utility. Don’t precede 
these app names with the.

• Hardware: AirPort hardware includes the AirPort Express Base Station, the 
AirPort Extreme Base Station, and AirPort Time Capsule. You can shorten 
AirPort Express Base Station to AirPort Express, but don’t use AirPort Extreme unless 
you’re referring to the technology. Use an article or your with AirPort Express. Use 
lowercase for base station if you don’t use the full product name.

Correct: The AirPort Extreme Base Station is an Apple product.

Correct: Avoid placing the base station near sources of interference.

Incorrect: Avoid placing the Base Station near sources of interference.

alert (n., adj.)  Refers generically to a signal, either visual (a dialog) or auditory (a beep), 
that calls the user’s attention to an unusual situation. Visual alerts, such as the one shown 
here, provide messages about error conditions or warn users about potentially hazardous 
situations or actions.

In user materials, you can use alert sound or alert message to describe generic alerts. 
Avoid error message except in developer materials.

The computer plays a sound (called the alert sound) when it needs  
your attention.

An alert message appears if a problem occurs during the installation.

In specific situations, however, avoid the word alert if you can simply describe what happens.

A message appears when the installation is finished.

alias  Use for with alias (not of or to).

The alias for the selected file is on the desktop.

The object the alias represents is called the original item. Don’t use aliased. See also  
email alias.
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alignment  Use instead of justification to refer to the horizontal placement of lines of  
text with respect to the left and right edges of the margin. Alignment can be flush left, 
flush right, centered, or justified (that is, flush on both the left and right margins).  
See also justification.

all-in-one (adj.)  Refers to computers with built-in displays, such as iMac computers. Also 
refers to products that combine functions such as printing, faxing, scanning, and copying.

allow  Avoid using allow when you can restructure a sentence to make the reader the subject.

Avoid: FileMaker Pro allows you to create a database.

Preferable: You can create a database with FileMaker Pro.

See also enable (v.), enabled (adj.); let.

alphabet column  Don’t use to refer to the vertical column of letters at the right side of a 
list in some iOS apps; use index.

alphabetization  Alphabetize letter by letter, not word by word.

file format
filename
file server
widget
Wi-Fi
window

For detailed information about letter-by-letter alphabetizing, see The Chicago Manual  
of Style.

alphanumeric  One word.

alternate (adj.), alternative (adj.)  Use alternate to mean every other or occurring or 
proceeding by turn. Use alternative to mean allowing two or more choices.

You can shade alternate rows of a table.

When traffic is heavy, Apple Maps provides alternative routes.

alternating current  See AC.

Alt key  Don’t use, except when you give instructions for Windows users. For Mac users, 
use Option key.

a.m.  Note periods: 8:30 a.m. Use a space before the abbreviation.

ambient light sensor  Don’t use ALS.

America, American  Refers to both North and South America. Don’t use when you mean 
United States. See also U.S.

American National Standards Institute  See ANSI.
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ampersand  Use the ampersand character (&) in text only when you refer to onscreen 
elements, document titles, or other items containing the character.

Choose Insert > Date & Time.

To change the system voice, use Dictation & Speech preferences.

analog  Note spelling. Use hyphens in the adjectives analog-to-digital and digital-to-analog.

and/or  Rewrite to avoid this construction.

Correct: document and app icons

Avoid: document and/or app icons

angle brackets  Use angle brackets, not brackets, to describe the < and > symbols.

Use left angle bracket and right angle bracket when you need to distinguish between 
opening and closing angle brackets.

You can also use less-than sign and greater-than sign for these symbols if appropriate in 
the context. See also braces; brackets; greater-than sign; less-than sign; menus.

Animoji  Animated emoji that users can choose to represent themselves in some apps. Use 
Animoji for both singular and plural.

Choose an Animoji to use in a FaceTime call.

Express yourself with Animoji that mirror your facial expressions.

See also emoji; Memoji.

ANSI  Acronym for American National Standards Institute. For guidelines about spelling out 
acronyms, see abbreviations and acronyms.

antenna, antennas  Not antennae in relation to wireless products.

anti (prefix)  Close up except before i or a capital letter.

antiphishing, antivirus

anti-intellectual, anti-Linux

antialiasing (n., adj.), antialiased (adj.)  Don’t use antialias as a verb.

APFS  Abbreviation for Apple File System, the default file system used to format Apple 
devices and external storage devices.

API  Abbreviation for application programming interface (not application program 
interface). To refer to more than one API, use APIs. For guidelines about spelling out 
abbreviations, see abbreviations and acronyms.

APN  Abbreviation for Access Point Name. For guidelines about spelling out abbreviations, 
see abbreviations and acronyms.

apostrophes  Use the curly apostrophe (Option-Shift-Right Bracket) except in code font 
and for units of measure.  See also plurals; possessives; quotation marks.



18Apple Style Guide

app, application, program  An app (short for application) is a computer program that 
performs a specific task, such as a word processor, game, and so on.

Use app when referring to apps for iOS and iPadOS devices, Apple Watch, or Apple TV.

Tap a photo to open it in the Photos app.

In most cases, you can use app instead of application to refer to software for the Mac, but 
be consistent within a document.

Some apps have versions that work on multiple platforms. To distinguish between versions 
of an app, use [app name] for [platform].

Learn about the new features of Pages for iOS and iPadOS.

You can add tracks to a song in GarageBand for Mac.

In general, use program only to refer to software that doesn’t have a graphical user interface.

The launchd program consolidates all system startup activities into  
a single program.

See also software development kit; system software.

appear  Use appear, not display, to refer to items becoming visible on the screen.

Correct: The setup assistant appears.

Incorrect: The setup assistant is displayed.

Incorrect: The setup assistant displays.

In a task, avoid stating that an item appears; if necessary for clarity, try to work it into the 
context of the task.

1. Click the close button.

2. In the message that appears, click Save.

However, it’s OK to use appear in a task for information like the following:

The printer icon appears only when there are jobs in the printing queue.

Photos, videos, and any other files appear in a grid.

appendix  Use an appendix for background information and other supplementary material 
that doesn’t contribute directly to the main subject of the document. In user materials, 
technical information should go in an appendix.

Appendixes are lettered: Appendix A, Appendix B, and so on. When a document has only 
one appendix, it should be titled Appendix, not Appendix A.

appendixes  Not appendices.
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Apple  The company’s official name is Apple Inc. Use Apple Inc. in copyright notices and 
credit lines and in communications that require the legal name of the company, such as 
legal documents, contracts, and forms.

© 2021 Apple Inc. All rights reserved.

In the text of corporate and marketing communications and in the corporate address,  
refer to the company as Apple. You can also use Apple to refer to the company’s products 
and services.

Today Apple announced a new MacBook computer.

Apple displays offer a brilliant view of your work.

Don’t use Apple alone to refer to products or services; always include a noun: an Apple 
computer, not an Apple; Apple computers, not Apples; your Apple computer’s screen,  
not your Apple’s screen.

You can use the possessive form in references to the company.

AirPort Extreme is Apple’s wireless networking technology.

You can also use the hyphenated form.

Apple-approved video card, Apple-certified parts, Apple-designed 
templates

See also addresses (mailing).

Apple-authorized (adj.), Apple authorized (pred. adj.)  OK to use in general references  
to Apple authorization: Apple-authorized procedure. No hyphen in proper names:  
Apple Authorized Reseller.

Apple Authorized Reseller  Use the full term unless many references are required; in that 
case you can shorten to reseller.

Apple Authorized Service Provider  Use the full term unless many references are required; 
in that case you can shorten to AASP.

Apple Books  You can use Apple Books to refer to the app and service that let users 
purchase, download, and read ebooks.

You can see your Apple Books purchases on all your devices.

To see what’s trending, check the top charts in Apple Books.

When you refer to the app specifically, you can use the Books app or just Books.

To see all your books, click Library in the Books app.

To search for new books, open Books and tap Book Store.

In text, don’t write the name Apple Books by combining the  symbol with Books.

Correct: Get started with Apple Books.

Incorrect: Get started with Books.

See also Apple logo; Book Store; ebook (n.); iBooks.
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Apple computer  Avoid where Mac computer would work. See also Mac.

Apple Diagnostics  A built-in utility that can be used to test Mac computers for  
hardware issues.

Apple event  Capitalize the names of Apple events (but not the word event): Open 
Application event, Quit Application event, Open Documents event, Print Documents event, 
and so on. See also events, Events.

Apple File System  See APFS.

Apple Filing Protocol  See AFP.

Apple Fitness+  A subscription service that provides a catalog of workouts led by expert 
trainers. Don’t use Apple Fitness Plus or other variations.

In text, don’t write the name Apple Fitness+ by combining the  symbol with Fitness+. Use 
regular punctuation after the name.

Correct: Get started with Apple Fitness+.

Incorrect: Get started with Fitness+.

See also Apple logo.

Apple Gift Card  OK to use card or gift card after the first reference.

Apple ID  An account that identifies a user of services such as iCloud, the iTunes Store, 
and iMessage. Because a user can have more than one Apple ID, you might need to specify 
a particular one—for example, the Apple ID you used to purchase the songs.

Sign in to the iTunes Store with your Apple ID.

To use Find My, you need an Apple ID.

Sign in with the Apple ID you used to join Apple Music.

Apple Inc.  The company’s legal name; formerly Apple Computer, Inc. See also Apple.

Apple logo  In the phrase Apple logo, use lowercase for the word logo.

In text, don’t use the  symbol in place of the word Apple, and don’t write product or 
service names (like Apple News+) by combining the  symbol with text.

Correct: Subscribe to Apple News+.

Incorrect: Subscribe to News+.

Combinations of a product name and logo—known as product lockups—are carefully 
designed graphics approved by Apple Marketing. For information about how to use product 
lockups and the Apple logo, see Guidelines for using the Apple logo.

Apple Loops  Always plural; not an Apple Loop. An open-standard file format for audio 
loops and sound effects; also refers to the audio and effects files.

Apple Loops Utility  Note plural Loops.

Apple Lossless  Note capitalization. The audio compression format.

https://corpid.apple.com/logo
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Apple M1 chip  After the first reference, it’s OK to shorten to M1 chip.

First reference: You can now run your favorite iPad apps on MacBook Air 
with the Apple M1 chip.

Subsequent references: The M1 chip extends battery life while providing 
increased performance.

In text where you refer to the chip repeatedly, it’s OK to shorten to just M1.

Systems with the M1 chip wake instantly, and the processing speed of 
M1 delivers a huge boost to even the most demanding apps.

Apple menu  When you refer to the Apple menu in user materials, you can include  
the  symbol with the phrase Apple menu on first occurrence.

The Apple menu  is located in the top-left corner of your screen.

If your department uses parentheses around inline icons, treat the Apple logo the same way.

To restart your computer, choose Apple menu ( ) > Restart.

After the first occurrence, use the phrase Apple menu without the symbol. Don’t replace 
the word Apple with the  symbol.

Correct: You can open the App Store from the Apple menu.

Incorrect: To restart your computer, choose  menu > Restart.

Apple Music  You can use Apple Music to refer to the app and service that let users 
discover, play, and download music.

With Apple Music, you can stream your favorite music ad-free.

Apple Music learns what you like and recommends music based on  
your tastes.

When you refer to the app specifically, you can use the Music app or just Music.

To listen to Apple Music radio, tap Radio in the Music app.

Open Music, and then tap Listen Now.

Users subscribe to Apple Music and become Apple Music subscribers (not members).

In text, don’t write the name Apple Music by combining the  symbol with Music.

Correct: Get started with Apple Music.

Incorrect: Get started with Music.

See also Apple logo.
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Apple News  You can use Apple News to refer to the app and service that let users read 
stories from a variety of news sources.

Experienced Apple News editors curate the day’s top stories.

Apple News learns your interests as you read, and suggests  
relevant stories.

When you refer to the app specifically, you can use the News app or just News.

To see the top stories for today, tap Today in the News app.

Open News, and then tap the Following tab.

In text, don’t write the name Apple News by combining the  symbol with News.

Correct: Get started with Apple News.

Incorrect: Get started with News.

See also Apple logo.

Apple News+  A subscription service that provides complete issues of magazines  
and newspapers, along with the features of Apple News. Don’t use Apple News Plus  
or other variations.

In text, don’t write the name Apple News+ by combining the  symbol with News+.  
Use regular punctuation after the name.

Correct: Get started with Apple News+.

Incorrect: Get started with News+.

See also Apple logo.

Apple Online Store  Don’t use. To refer to Apple’s main website as a place to purchase 
products, say something like Shop online at apple.com or Visit the Apple website.  
See also App Store.

Apple Original  Use Apple Originals or an Apple Original to refer to content that’s produced 
by Apple and available from Apple TV+.

With an Apple TV+ subscription, you can catch the latest 
Apple Originals.

Watch For All Mankind, an Apple Original, from Apple TV+.

See also Apple TV+.

Apple Pay  In text, don’t write the name Apple Pay by combining the  symbol with the 
word Pay.

Correct: Find out where you can use Apple Pay.

Incorrect: Find out where you can use Pay.

See also Apple logo.
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Apple Pencil  In general references, don’t use an article with Apple Pencil; when referring 
to the user’s particular Apple Pencil, it’s OK to use your.

In most cases, refer to Apple Pencil by its full name. You can use just pencil when the 
context has made clear that the subject is Apple Pencil.

If you don’t see the Pair button, wait for a minute while your 
Apple Pencil charges. Then unplug the pencil, plug it back in, and wait 
until you see the Pair button.

Apple Remote  Use to refer to the remote control that’s compatible with Mac, iOS and 
iPadOS devices, and Apple TV (2nd and 3rd generations).

To refer to the remote used with Apple TV HD and Apple TV 4K, use Siri Remote.  
(In countries or regions where Siri isn’t available for use with Apple TV, use  
Apple TV Remote instead.)

See also Apple TV Remote; Siri Remote.

Apple Retail Store  Don’t use. See also Apple Store.

AppleScript  AppleScript is used to create a script or scripts, not an AppleScript or 
AppleScripts. Don’t use terms such as AppleScriptable or AppleScripting.

Apple services  Note lowercase services.

With a single subscription, customers can enjoy their favorite Apple 
services across all their devices.

A single Apple ID gives you access to all Apple services.

Apple silicon  To refer to Mac models with Apple silicon, say Mac with Apple silicon.  
To refer to other Mac models, use Intel-based Mac or other Mac computers.

If you have a Mac with Apple silicon…

If you have an Intel-based Mac…

For other Mac computers…

In content where you frequently compare the two types of computers, you can use Apple 
silicon as shorthand for a Mac with Apple silicon.

Create a version of your app that runs on both Apple silicon and Intel-
based Mac computers.

Apple silicon runs all performance tools found on Intel-based Mac 
computers.

See also Apple M1 chip.

Apple Store  Use Apple Store to refer to Apple retail stores. After the first reference, you 
can use the full name or shorten to store. It’s OK to use terms such as retail store and retail 
location; don’t use Apple Retail Store.

Precede Apple Store with an article or pronoun in text: the Apple Store, an Apple Store, 
your local Apple Store.

Don’t use Apple Store in the plural or possessive form. For the plural, use a term such as 
Apple Store locations or simply stores; for the possessive, use store’s.
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To refer to a specific Apple Store, use Apple followed by the store name.

Apple Union Square opened on May 21, 2016.

Products and services are available at, from, in, or through the Apple Store.

Apple Store app  An app for iOS, iPadOS, and watchOS that offers users a more personal 
way to shop for Apple products and accessories.

Apple Support  Capitalize in reference to Apple’s service and support resources and staff; 
use lowercase in general references to support.

Contact Apple Support for assistance with your new Mac.

You can get hands-on technical support for your Apple products at the 
Genius Bar.

applet  Can be any small application, but usually refers to a piece of code that’s attached 
to an HTML document on the web.

Apple T2 Security Chip  Note capitalization. After the first reference, it’s OK to shorten  
to T2 chip.

First reference: The Apple T2 Security Chip brings a new level of 
integration and security to the Mac.

Subsequent references: The T2 chip includes a secure enclave 
coprocessor that provides new encrypted storage capabilities.

Apple TV  In general references, don’t use an article with Apple TV. When referring to the 
user’s particular Apple TV, it’s OK to use your. Don’t abbreviate as ATV.

Apple TV+  The streaming subscription service. Don’t use Apple tv+, Apple TV Plus,  
or other variations. In text, don’t write the name Apple TV+ by combining the  symbol 
with TV+. Use regular punctuation after the name.

Correct: Get started with Apple TV+.

Incorrect: Get started with TV+.

Users subscribe to Apple TV+, and they can watch content from Apple TV+, on the 
Apple TV app.

Correct: Subscribe to Apple TV+ on the Apple TV app.

Correct: Catch up on For All Mankind from Apple TV+ on the Apple TV app.

Incorrect: Subscribe on Apple TV+.

Incorrect: You can watch For All Mankind in Apple TV+.

OK to use as an adjective: Apple TV+ subscription, Apple TV+ content.

See also Apple logo; Apple Original.

Apple TV Remote  Use to refer to the Siri Remote in countries or regions where 
Apple TV HD and Apple TV 4K don’t support Siri.

Use the Touch surface on the Apple TV Remote to set up your Apple TV.

See also Apple Remote; Siri Remote; Touch surface.
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Apple Watch  In general references, don’t use an article with Apple Watch; when referring 
to the user’s particular Apple Watch, it’s OK to use your.

In most cases, refer to Apple Watch by its full name. However, you can use just watch if it’s 
clear in context that you mean Apple Watch.

You can pair more than one Apple Watch with your iPhone and then 
customize each watch with its own settings.

Always use the full name of Apple Watch models: Apple Watch Edition, not Edition.

In text, don’t write the name Apple Watch by combining the  symbol with the word Watch.

Correct: Get started with your Apple Watch.

Incorrect: Get started with your Watch.

See also Apple logo.

Apple Watch app  The iPhone app that manages settings for Apple Watch. Although the 
app icon may be labeled Watch, don’t refer to the app as the Watch app; instead, use the 
full name: the Apple Watch app.

Apple website  To refer to the Apple website address, use www.apple.com, not apple.com 
or Apple.com: Visit the Apple website at www.apple.com. See also internet addresses. 

App Library  Precede with the.

You can use the App Library to organize your Home Screen.

application  See app, application, program.

Application Chooser menu  In VoiceOver, a menu for navigating among open apps. The 
menu appears when the user presses Control-Option-F1 twice.

application menu  The menu to the right of the Apple menu. The app menu shows the app 
name in boldface.

You don’t need to include the word application or app when you refer to a specific app menu.

Commands for hiding Mail and for showing and hiding other apps are in 
the Mail menu.

application programming interface  See API.

Applications folder  Use the Applications folder to refer to the Applications folder located 
at the top level of the file system and accessible to all users of a computer. Use your 
Applications folder or a user’s Applications folder to refer to the Applications folder located 
in the user’s home folder.

application-specific integrated circuit  See ASIC.

app names  Follow the style of the software itself for capitalization and spaces—for 
example, TextEdit, Image Capture, DigitalColor Meter, iMovie. In general, don’t use the with 
app names (the Finder is an exception).

Correct: Open QuickTime Player.

Incorrect: Open the QuickTime Player.
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App Store  Apps are available in, on, or from the App Store. Precede the name with an 
article in text.

Find the item you want on the App Store.

You can purchase apps from the App Store.

Use App Store whether the context is macOS, iOS, watchOS, or tvOS. If you need to make 
the context clear, you can use the Mac App Store or the App Store for Apple TV. However, 
avoid Apple Watch App Store and Apple TV App Store.

If you need to refer collectively to the App Store, the iTunes Store, and Apple Books, you 
can use Apple online stores (but it’s preferable to list them).

See also Mac App Store.

arabic, Arabic (adj.)  Use lowercase when you refer to numerals. Capitalize when you refer 
to the script system. See also roman, Roman (adj.).

armband  One word.

arrow  In user materials, use pointer in general references. Use arrow or arrow pointer when 
you’re comparing different types of pointers and want to describe this type of pointer:

When you click the Text tool, the pointer becomes an I-beam.

Click the Selection tool to display the arrow pointer.

Cursor (as in the VoiceOver cursor) may be appropriate when you describe other interfaces 
and in developer materials.

See also cursor; insertion point; pointer.

arrowhead  Don’t use to refer to the arrow pointer. See also arrow.

arrow keys  Use lowercase in general references. Don’t use direction keys.

Capitalize and use the complete name of each arrow key when you refer to it by name.

Correct: Use the arrow keys to move the insertion point from cell to cell.

Incorrect: Use the Arrow keys to move the insertion point from  
cell to cell.

Correct: Use the Up Arrow and Down Arrow keys to scroll through  
the document.

Incorrect: Use the Up and Down Arrow keys to scroll through  
the document.

Correct: Press the Left Arrow key.

Incorrect: Press the Left arrow key.

ASCII  Acronym for American Standard Code for Information Interchange. For guidelines 
about spelling out acronyms, see abbreviations and acronyms.
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Asia Pacific (n., adj.)  Don’t list Japan separately; Asia Pacific includes Japan.

Correct: To see a list of banks in Asia Pacific that support Apple Pay…

Incorrect: To see a list of banks in Asia Pacific and Japan that support 
Apple Pay…

ASIC  Acronym for application-specific integrated circuit. Note hyphen in the spelled-out 
version. For guidelines about spelling out acronyms, see abbreviations and acronyms.

Ask to Buy  A feature of Family Sharing that allows the family organizer to control family 
members’ purchases. Don’t enclose the name in quotation marks.

Ask to Buy is available for any family member under age 18.

See also Family Sharing.

aspect ratio  The ratio of an image’s width to its height. Use a colon in aspect ratios:  
4:3, 16:9.

Assistant  Capitalize, and don’t use the, when the word is part of a full name.

Use AirPort Setup Assistant to…

Use lowercase when you use the term by itself or generically.

Use the assistant to…

You can use assistants to…

AssistiveTouch  One word.

assure  Don’t use when you mean ensure. Assure means to state positively, so as to 
remove doubt.

Assure customers that you’ll resolve the issue.

See also ensure, insure.

asynchronous progress indicator  In developer materials, the progress indicator that  
looks like a spinning gear. In user materials, use progress indicator and describe what it 
looks like.

Developer materials: Don’t use the asynchronous progress indicator for 
processes that start out indeterminate but could become determinate.

User materials: A progress indicator (looks like a spinning gear) appears.

See also indeterminate progress bar.

attach  Don’t use to mean connect (as in Connect the USB device to your computer).

audio  Close up the following words beginning with audio:

audiobook, audiocassette, audiotape, audiovisual

Don’t use a hyphen in compound adjectives that include audio: audio editing app.

audio CD  Not CD audio disc.

audio chat, audio chatting (n., v., adj.)  OK to use audio conference or audio chat.
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audio conference, audio conferencing (n., v., adj.)  OK to use audio conference or  
audio chat.

audio file  Use audio file or simply audio to refer to the source audio material imported into 
an app such as GarageBand or Final Cut Pro.

audio input, audio input/output, audio output (n., adj.)  You can shorten to audio in, audio 
in/out, and audio out. Types of audio input/output include audio line in, audio line out, 
analog audio, and optical digital audio (or optical audio).

Audio Units  Always plural; not Audio Unit. In user materials, use only as an adjective  
(the Audio Units format).

You can install third-party Audio Units filters.

GarageBand automates Audio Units instruments and effects.

audio/video  Refers to equipment and apps that deal with sound and sight. The term can 
be abbreviated as AV or A/V: A/V receiver, A/V equipment, Apple Composite AV Cable.

authenticate, authorize  Apple devices and services authenticate users to confirm  
their identity.

Signing in with AppleConnect authenticates your identity and gives you 
access to Apple’s internal apps and services.

Users authorize payments using methods such as a passcode. Users also authorize or 
deauthorize computers and devices. Banks and merchants authorize transactions when 
they confirm that the customer has the funds to pay for a purchase.

To prevent unauthorized purchases, use Restrictions preferences.

To play some iTunes Store purchases, you must authorize your 
computer.

See also code, passcode.

auto (prefix)  Close up except before a vowel.

autoconfiguration, autoplay, autosave, autosensing, autosync

auto-answer, auto-update

Auto Exposure  An iOS camera feature. Use autoexposure to refer to automatic exposure  
in general.

AutoFill  The Safari feature. Use autofill for the verb.

If you don’t want Safari to autofill your information, turn off AutoFill in 
Safari preferences.

Auto Focus  An iOS camera feature. Use autofocus to refer to automatic focusing  
in general.

autoplay, Autoplay  The feature is lowercase; the button name is capitalized.
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autosave  Use only as an adjective (the autosave feature). Don’t use as a verb.

Correct: Pages saves your changes automatically.

Incorrect: Pages autosaves your changes.

autosync (n., v., adj.)  Note spelling.

Auto Unlock  Use only as the feature name; don’t use as a verb.

Correct: When Auto Unlock is on, you can unlock your Mac with your 
Apple Watch.

Incorrect: You can use your Apple Watch to Auto Unlock your Mac when 
you wake it.

AVCHD  Abbreviation for Advanced Video Coding High Definition, a high-definition digital 
video format for recording and playback. For guidelines about spelling out abbreviations, 
see abbreviations and acronyms.

B
Back button  Use to refer to a button—usually in a toolbar or navigation bar—that lets 
users return to the previous screen or webpage.

See also left arrow.

back end (n.), back-end (adj.)  Note hyphenation of adjective.

backlight (n.), backlit (adj.)  One word.

back panel  Two words.

backslash  Use backslash to describe this character: \. See also slash.

backspace (n., v., adj.)  One word.

Backspace key  A key on Windows keyboards that’s equivalent to the Delete key on  
a Mac keyboard.

backup (n., adj.), back up (v.)  One word except as a verb; no hyphen.

backward (adv.)  Not backwards when you refer to direction. But in certain other contexts, 
such as putting a card in backwards, it’s OK to use backwards.

backward compatibility  Not backwards compatibility.

backward-compatible (adj.)  Note hyphenation.
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badge (n.)  A small icon, or a small graphic with text, that appears as an overlay on an app 
or toolbar icon, a file thumbnail, or other UI element to provide information about the item 
at a glance.

You can use badge to describe any of the following:

• A counter: Usually a red oval with a numeral that indicates the number of active or 
available items in an app (for example, new email or text messages), available updates, 
and so on.

A badge indicates the number of unread messages:

• An indicator of an item’s type or state: For example, in Photos, a photo can have a 
badge that indicates it’s a Live Photo.

A Live Photo has this badge in the top-left corner:

• A warning: An exclamation point on an app icon that indicates an issue that requires 
attention.

If there’s a problem, a badge with an exclamation point appears on the 
app icon:

Don’t use badge as a verb or badged as an adjective. An item has a badge, or a badge 
appears on an item.

bandwidth  One word.

based  Use a hyphen in compound adjectives that include based when they precede a noun.

application-based services, Windows-based computer

Use an en dash (Option-Hyphen) if based follows a term with two or more words.

Windows XP–based computer

Don’t use a hyphen or an en dash in predicate adjectives that include based.

Each track in a sequence is assigned an index value that is zero based.

base station  A device that transmits and receives data in a wireless network; also called 
access point, wireless access point, or wireless router. Capitalize in product names: 
AirPort Express Base Station, AirPort Extreme Base Station. See also AirPort.
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batteries  Describe batteries in terms of the number required, size, and type.

lithium-ion battery, lithium polymer battery

eight AAA alkaline batteries

one AA rechargeable nickel-cadmium battery

two nickel-metal-hydride batteries

Abbreviate the battery type only if space is limited. Abbreviations include the following:

NiCd (nickel-cadmium)

Li (lithium), Li-ion (lithium-ion)

NiMH (nickel-metal-hydride)

because  See since, because.

below  See above, below.

beta (n., adj.)  A prerelease version of software or hardware. Capitalize when part of a 
proper name.

Apple will give users a peek at the new app by releasing a public beta.

Apple has released a beta version of the next iOS.

Developers can now join the Apple Beta Software Program.

bidirectional (adj.)  Use to refer to a script system in which text is generally flush right and 
most characters are written from right to left, but some text is written from left to right as 
well. Arabic and Hebrew are the only bidirectional script systems in widespread use. See 
also mixed-directional (adj.).

bit (n., adj.)  Short for binary digit, the smallest unit of computer data. A bit has a single 
binary value, either 0 or 1. Don’t use when you mean pixel or dot. Hyphenate when used as 
an adjective or a predicate adjective.

The exported file uses 32 bits per pixel.

The AirPort Extreme Base Station provides 40-bit and 128-bit 
encryption.

Broadcast video is generally 24-bit, with 8 bits of color information  
per channel.

See also dot (n.); pixel.

bit depth  The number of bits used by a digital device. Use instead of bit resolution.

bitmap, bitmapping (n.), bitmap, bitmapped (adj.)  You can use either bitmap font or 
bitmapped font, but be consistent.

bit rate  Two words.

bit resolution  Don’t use; use bit depth. See also bit depth.

bit/s  Abbreviation for bits per second. For guidelines about spelling out abbreviations,  
see abbreviations and acronyms.

bits per second  See bit/s.
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Black (adj.)  Capitalize when referring to ethnicity or cultural identity.

Learn about Black leaders who have shaped the world.

black-and-white (adj.), black and white (pred. adj.)  Note hyphenation of adjective.

You can change a color picture to a black-and-white picture.

With Photos, you can change a picture to black and white.

For displays, monochrome is usually more appropriate because it encompasses amber and 
black, green and black, and so on.

black box/white box (n., adj.)  Avoid using to refer to a type of device or system, or a 
method of testing. For black box, use closed, closed box, opaque, or other alternatives; for 
white box, use open, open box, clear, transparent, or other alternatives.

Correct: Use a mix of closed and open testing.

Incorrect: Use a mix of black box and white box testing.

Correct: Treat the container as opaque.

Incorrect: Treat the container as a black box.

black hat/white hat  Don’t use to describe a type of hacker. Instead of black hat hacker, 
use malicious hacker or unethical hacker; for white hat hacker, use approved hacker or 
ethical hacker.

blacklist/whitelist (n., v.)  Don’t use. For the noun, use an alternative that’s appropriate to 
the context, such as deny list/allow list, deny list/permit list, unapproved list/approved list, 
or reject list/accept list.

Correct: To allow incoming email from an address, add the address to 
your server’s allow list.

Incorrect: To allow incoming email from an address, add the address to 
your server’s whitelist.

Avoid using terms such as deny list and allow list as verbs; instead, use deny, allow, and so 
on (or rewrite the sentence to refer to adding items to a list).

Avoid: You can deny list specific IP addresses to prevent them from 
accessing the server.

Preferable: You can deny specific IP addresses to prevent them from 
accessing the server.

Preferable: You can add specific IP addresses to a deny list to prevent 
them from accessing the server.

It’s OK to use terms such as deny list and allow list as adjectives (deny list data is stored at 
the partition level; export the allow list file).

Avoid using terms such as deny listed and allow listed; instead, use denied, allowed,  
and so on.

Avoid: Search for your server’s allow listed IP addresses.

Preferable: Search for your server’s list of allowed IP addresses.
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If the terms blacklist and whitelist are used in code you’re documenting and the code 
can’t be changed, show a code sample to make it clear what users need to enter, but use 
alternative terms in the documentation.

To add an address to the allow list, enter the following command: 
whitelist add.

black/white  Don’t use black or white in a way that has a positive or negative connotation. 
Use only to describe the color of items (black text on a white background, change a color 
photo to black and white, the white point of your display).

See also black box/white box (n., adj.); black hat/white hat; blacklist/whitelist (n., v.).

blank character  Don’t use; use space character. See also space character.

blind, low vision  To refer to people with vision loss, you can say a person who is blind, a 
person who has low vision, a person who is blind or has low vision, people who are blind or 
have low vision.

People who are blind or have low vision can use VoiceOver to navigate 
their devices.

If you have low vision, you can use Larger Dynamic Type to make text 
on your iPhone larger and easier to read.

Avoid visually impaired.

See also deafblind, Deafblind; impairment; Writing about disability.

blinking  Use to describe the insertion point. Don’t use flashing for this purpose.

Blue appearance  An appearance available in macOS.

Bluetooth  Don’t use Bluetooth as a noun.

Correct: If your computer didn’t come with an internal Bluetooth 
module, you can have one installed by an Apple Authorized  
Service Provider.

Correct: Your computer can connect to and transfer information to 
devices that use Bluetooth wireless technology.

Incorrect: Your computer can connect to devices that use Bluetooth.

Don’t use a hyphen with Bluetooth.

Correct: Bluetooth enabled device

Incorrect: Bluetooth-enabled device

Blu-ray  A high-capacity optical disc format, also referred to as Blu-ray Disc (BD). 
Capitalize Disc only when referring to the format. Use lowercase when referring to 
individual discs.

You can create Blu-ray video and audio files and burn them to  
a Blu-ray disc.

board  Don’t use when you mean card. A board is built in; a card can be removed by the 
user. See also card.

bookmark (n., v., adj.)  One word.
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Books  See Apple Books.

Book Store  In most cases, simply use Apple Books to refer to the service that lets users 
purchase, download, and read ebooks.

You can find the user guide on Apple Books.

Family members can share items they purchased from the App Store, 
the iTunes Store, and Apple Books.

If you need to differentiate the store from the app, you can use the Book Store, the store in 
Apple Books, or the Book Store in Apple Books.

You can search for new books in the Book Store.

Your library contains all the books you’ve purchased from the store in 
Apple Books.

Check out the Book Store in Apple Books to find recommendations for you.

Don’t use Apple Books store, Apple Books Store, Apple Book Store, or Apple Bookstore. 
Items are available in, on, or from the Book Store.

See also Apple Books.

Boolean (adj.)  Note capitalization.

boot  Don’t use for start up or switch on except in server materials. In materials written for 
new users, however, you may want to mention the term boot or include it in the glossary 
because users may see the term elsewhere.

boot chime  Don’t use for the chord heard during a successful startup sequence. Use 
startup sound.

boot disk  Don’t use except in server materials. Instead, use startup disk.

bot  Short for robot. An app that performs automated tasks, especially tasks that  
are repetitive.

You can set up a bot to perform integrations of your app each time a 
change is committed to your source repository.

See also chatbot.

bottommost  One word. 

box  Don’t use dialog box; use dialog. See also dialog.

bps  Don’t use as the abbreviation for bits per second. Use bit/s.

braces  Use braces, not curly brackets, to describe these symbols: { }.

When you need to distinguish between the opening and closing braces, use left brace and 
right brace.
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brackets  Use brackets, not square brackets, to describe these symbols: [ ]. Don’t use 
brackets when you mean angle brackets (< >).

When you need to distinguish between the opening and closing brackets, use left bracket 
and right bracket.

braille  Note lowercase.

bridge  Don’t use interchangeably with router. See also router.

broadband (n., adj.)  One word.

browsable  Not browseable.

browse (v.)  It’s OK to use browse as either a transitive verb (browse the web) or an 
intransitive verb (browse through a website).

buddy list  Two words.

bug  Avoid; use problem, condition, issue, or situation instead.

build-to-order  Not built-to-order. Always use as an adjective (your build-to-order 
computer). Don’t abbreviate as BTO.

built-in (adj.), built in (pred. adj.), built into (pred. adj.)  In headings that use title-style 
capitalization, don’t capitalize in (exception to the rule of capitalizing the second word of  
a hyphenated compound).

Built-in Apps on Your MacBook [heading]

You can use the built-in microphone or an external microphone.

Mac Pro has 512 GB of flash storage built in.

Two-factor authentication is built into iOS 9 and later.

built-in disk drive  You can use built-in disk drive, built-in drive, or internal disk drive.

built-in graphics card  Use to describe graphics cards that are installed at the factory. 
Don’t use onboard graphics card.

bullet  Use bullet, not dot, for the character that precedes an item in a list. See also dot (n.).

bundle, bundled  Refers to a collection of products or to products included with a 
computer. It’s preferable to use a term such as included or comes with. Don’t use 
prebundled.

In developer materials, a bundle is also a special type of directory that stores the code of 
applications and plug-ins in a file package that appears as a single file in the Finder.

burn  You burn files on a disc or to a disc, but not onto a disc. You can also burn a disc.

You can burn your photos on a CD.

Select the playlists you want to burn to a CD.

If you have a SuperDrive, you can burn DVDs.

See also write.
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bus, buses  Note spelling of plural. In materials for audio technology, you can use busses 
for the plural, but be consistent in all materials for a particular product.

bus-powered, self-powered  In user materials, try to avoid when indicating whether 
devices draw power from a power cord or from another USB device. When possible, 
describe the device; don’t give it a label.

Correct: a device that plugs into an electrical outlet

Incorrect: a self-powered device

Correct: a device that gets its power from another USB device

Incorrect: a bus-powered device

button  Buttons initiate an action when clicked, tapped, or pressed. You click or tap an 
onscreen button.

You press a mechanical button.

Press and hold the TV button .

• Buttons with text labels: In general, write the names of buttons exactly as they appear 
onscreen. If the button’s name uses sentence-style capitalization, enclose the name in 
quotation marks.

Click the “Position on screen” button.

If the button’s name uses title-style capitalization, don’t enclose the name in quotation 
marks, even if one of the words is lowercase.

Tap Add to Favorites.

If a button name uses all capital letters or all lowercase letters, use title-style 
capitalization when writing the button name.
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• Buttons that display icons or images: If an element in the user interface acts like a 
button (initiates an action when clicked or tapped), call it a button, even if it displays an 
icon or an image. For example, the following interface elements are buttons:

For some buttons with icons, you can simply refer to the button by what it looks like 
(use lowercase):

Exception: Sometimes app icons act like buttons—for example, icons in the macOS 
Dock or on the iOS Home Screen—but they’re still referred to as icons (Click the Safari 
icon in the Dock, tap the Mail icon on the Home Screen).

See also checkbox; click; icon; radio button; tab; tap (n., v.).

C
cable  Use cable to describe what physically connects two pieces of hardware. Don’t use 
cabling even when you mean cable collectively; use cables. See also cord.

cache (n., v.), cached (v., adj.), caching (n., v.)  Note spelling. See also level 2 cache, 
level 3 cache.

calendar  When you need to refer to a specific type of calendar, use Gregorian calendar 
to refer to the calendar used in Europe and the Western Hemisphere. Use Islamic calendar 
to refer to the lunar calendar used in predominantly Muslim countries or regions. Other 
calendar names are Buddhist, Hebrew, and Japanese.

Calendar  Capitalize when referring to the app name: You can import your data into 
Calendar. Use lowercase to refer to a user’s calendar: add events to your calendar; create 
calendars for work and home. See also iCloud.

callouts  Use a callout (a short text label with a line that points to part of a figure) when 
you need to identify something within a figure. A thin line without an arrowhead, known as 
a leader line, connects the text label to what it identifies within the figure.

• Simplicity: Use callouts freely when they’re really necessary, but keep in mind that too 
many callouts can be distracting to the reader. Keep callouts brief, both for clarity and 
for an uncluttered look.

• Capitalization and punctuation: Use sentence-style capitalization. Use a period for a 
complete sentence and no ending punctuation for a sentence fragment. It’s OK to have 
a mixture of complete sentences and fragments in one illustration.
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camcorder  Use to refer to a video camera and recording device combined in one unit. 
Don’t use video camera when you mean camcorder.

Correct: You can connect a camcorder to your computer to import your 
video footage.

Incorrect: You can connect a video camera to your computer to import 
your video footage.

Because most camcorders are now digital, it usually isn’t necessary to include the word 
digital, but you can use digital camcorder if the context requires it.

Today’s digital camcorders provide many advantages over their older 
analog counterparts.

In general references, it’s OK to use camera.

You can use the stabilization feature in Final Cut Pro to correct shaky 
camera movement.

See also video camera.

Camera Roll  You can use your Camera Roll or the Camera Roll to refer to the collection 
of photos on iPhone, iPad, or iPod touch. Use Camera Roll album when referring to the 
Camera Roll as an album.

You can save photos you receive in email to your Camera Roll.

With iCloud, photos you save to the Camera Roll are updated 
automatically in the Photos library on your Mac.

You can’t change the key photo for the Camera Roll album.

canceled (v.), canceling (v.), cancellation (n.)  Use one l for the verb cancel—for example 
canceled, canceling. Use two l’s for the noun cancellation.

can, might, may  Use can to express the capacity to do something; use might or may to 
suggest the possibility of doing something; use may to express permission.

You can log in to your account from another computer.

You might be able to connect to the internet at a nearby hotspot.

You may borrow my iPad if you return it tomorrow.

When used to express possibility, might typically suggests lower probability than may.

If the issue persists, you may need to restart your computer or you 
might need to restore software.

capability  If possible, avoid capability when you discuss features of software or hardware. 
Reword in terms of what the user can do with the feature.

Correct: With Photos, you can create slideshows.

Incorrect: Photos has the capability to create slideshows.
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capitalization  Two styles of capitalization are commonly used at Apple:

• Sentence-style capitalization: This line provides an example of sentence-style 
capitalization.

• Title-style capitalization: This Line Provides an Example of Title-Style Capitalization.

Except for user interface text, guidelines for when to use sentence-style capitalization and 
when to use title-style capitalization are a matter of department style.

In general, capitalize the names of onscreen elements exactly as they appear onscreen. 
If an onscreen element uses all capital letters or all lowercase letters, use title-style 
capitalization when writing the element name in documentation.

Don’t capitalize the word chapter or appendix, except in cross-references to actual titles.

See Chapter 2, “Units of Measure.”

See the appendix for specifications.

See Appendix B for a list of specifications.

When using title-style capitalization, don’t capitalize:

• Articles (a, an, the), unless an article is the first word or follows a colon

• Coordinating conjunctions (and, but, or, nor, for, yet, and so)

• The word to in infinitives (How to Start Your Computer)

• The word as, regardless of the part of speech

• Words that always begin with a lowercase letter, such as iPad and macOS

• Prepositions of four letters or fewer (at, by, for, from, in, into, of, off, on, onto, out, over, 
to, up, and with), except when the word is part of a verb phrase or is used as another 
part of speech (such as an adverb, adjective, noun, or verb)

Starting Up the Computer

Logging In to the Server

Getting Started with Your MacBook Pro
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When using title-style capitalization, capitalize:

• The first and last word, regardless of the part of speech

• The second word in a hyphenated compound (except for Built-in and Plug-in)

High-Level Events

32-Bit Addressing

See also abbreviations and acronyms.

Caps Lock key  Not Shift Lock.

captions  See figure captions; table captions.

card  Refers to a removable circuit board that’s installed in a slot. See also board; 
peripheral card.

card names  Capitalize the word card in a card name only if it’s part of the name (for 
example, AirPort Extreme Card). For generic names, don’t capitalize any part of the card 
name (for example, an internal modem card).

caret  In developer materials, use caret for the blinking bar that marks the insertion point. 
In user materials, the blinking bar is the insertion point.

Don’t use caret when you mean circumflex. A circumflex (ˆ) is an accent used in French 
words, such as être.

CarPlay  Don’t use as a verb.

Correct: You can use CarPlay to play audiobooks from your iPhone.

Incorrect: You can CarPlay audiobooks from your iPhone.

Users can connect devices to CarPlay and do tasks with CarPlay.

Connect your iPhone to CarPlay.

You can play music and make phone calls with CarPlay.

Users can open apps and change settings in CarPlay.

Open Maps in CarPlay and select a route.

You can change the map view in CarPlay.

carriage return  See CR.

carrier  Use this, or wireless carrier, to refer to a mobile network operator that provides 
wireless communication services (including network, voice, and data).

catalog  Refers to a list of all files and folders stored on a volume. Don’t use this term in 
user materials.

Catalyst  Don’t use; use Mac Catalyst. See also Mac Catalyst.

CD  Abbreviation for compact disc. Use disc, not disk, to refer to CD media.

cell phone, cellular phone  Don’t use; use mobile phone.

cell signal indicator  No hyphen.

central memory  Don’t use; use main memory.

central processing unit  See CPU.
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chain (n., v.)  OK to use when you mean a series of devices connected together.

chapter  Don’t capitalize the word chapter, except in cross-references to actual titles 
(exception to The Chicago Manual of Style).

in Chapter 5, “Expanding Your Computer”

in Chapters 4 and 5

in the next chapter

See also capitalization.

character  Use in reference to what a key on a keyboard stands for.

The Character Viewer provides access to nontypical characters like 
bullets, arrows, and currency symbols.

See also symbol.

chat (n., v., adj.)  Use as a noun only after identifying the context (typically audio chat or 
video chat).

When you finish chatting with your group, you can leave the group chat.

Customers can chat with AppleCare for technical support. 

Messages is the built-in chat client for Mac computers.

chatbot  Short for chatterbot. An app that uses artificial intelligence to simulate 
conversation, through voice or text, with human users.

Many businesses offer chatbots as automated support.

See also bot.

check  Don’t use when you mean the action of selecting a checkbox. See also checkbox.

checkbox  A labeled square control users select or deselect. Don’t instruct users to click a 
checkbox, because it’s ambiguous (you don’t know the checkbox’s initial state).

Using the word checkbox can be helpful, especially for people with visual disabilities.

Select “Allow repeated calls.”

Select the “Allow repeated calls” checkbox.

Select the checkbox labeled “Allow repeated calls.”

A checkbox can be selected or unselected. Avoid saying checked and unchecked.

If “Allow repeated calls” is unselected, multiple calls from the same 
person do not go through.

If “Allow repeated calls” isn’t selected, …

See also radio button; select (v.).



42Apple Style Guide

checkmark  One word. See also menus.

checkout (n., adj.), check out (v.)  One word except as a verb.

checksum  One word.

chip  Use integrated circuit or silicon chip (with an explanation of the term) on first 
occurrence. Don’t use chip when you mean microprocessor (Intel microprocessor,  
not Intel chip).

choose  Use choose, not select, for menu items. In general, the user selects something 
(such as a file or disk icon, an email message, or a section of text) and then chooses a 
command to act on the selection.

Choose View > Sort By > Date.

Select the text to copy, and then choose Edit > Copy.

Click the pop-up menu, and then choose High Priority.

Control-click the TextEdit icon, and then choose Make Alias.

See also menus; select (v.).

clamshell  Don’t use to refer to the lid of a notebook computer or device case (such as an 
AirPods case); use lid.

clean installation  Not clean install. Users perform a clean installation; they don’t do a 
clean install. See also install; installation.

click  Use to describe the act of selecting something or initiating an action by positioning the 
pointer over an onscreen element and briefly pressing and releasing the mouse or trackpad.

To open Mail, click the Mail icon in the Dock.

Click a disk icon to select it, and then choose File > Make Alias.

Don’t use click on. Don’t say click the mouse or click the trackpad; instead, use press  
and release.

Press the mouse, drag to enclose the area you want to select, and  
then release.

See also click and hold; click in; double click (n.), double-click (v.), double-clicking (n., v.); 
press; select (v.); tap (n., v.).

click and drag  Don’t use. You either click or drag.

Correct: Drag the icon to the Trash.

Incorrect: Click and drag the icon to the Trash.

click and hold  Refers to the act of positioning the pointer on an item on the screen and 
pressing the mouse or trackpad until something happens.

Click the Previous or Next button to go to the previous or next clip, or 
click and hold the Previous or Next button to rewind or fast-forward.

Don’t use click and hold to refer to the act of pressing deeper on a Force Touch trackpad; 
use force click.

See also click; force click (v.); hold down; press; touch and hold.
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click in  You click in a window or other area of the screen, such as an image; you click 
other onscreen elements, such as icons and buttons. See also click.

click on  Don’t use; use click. See also click.

client  Software that uses the services of another program; also the computer using the 
client software. The computer can be called the client computer, client system, or client.

client/server  Note slash.

clip art  Two words.

Clipboard  In user materials, use Clipboard, not pasteboard. In developer materials, it’s OK 
to use pasteboard when you discuss the NSPasteboard class, but point out that users view 
the contents of the pasteboard in the Clipboard. 

close  In macOS, users close windows or documents and quit apps.

In iOS, users can close an app (stop using it temporarily) by pressing the Home button; 
doing so may not quit the app (stop the app from running altogether). You can also use 
leave to refer to closing an app.

To leave an app and return to the Home screen, press the Home button.

See also open; quit.

close button  In macOS, refers to the leftmost button of the three window controls in the 
upper-left corner of the title bar.

closed captions (n.), closed captioning (n., adj.), closed-captioned (adj.)   
Note hyphenation.

You can turn closed captions on or off.

Change closed captioning preferences.

Closed-captioned programming is increasingly available to viewers.

See also SDH.

cloud  Avoid using the cloud to refer to iCloud. However, you can say content is in the 
cloud if the context makes clear you’re referring to iCloud.

With iCloud, you can store all of your content in the cloud so it’s 
available anytime, anywhere.

See also iCloud.

CLUT  Acronym for color lookup table. For guidelines about spelling out acronyms, see 
abbreviations and acronyms.

co (prefix)  Close up except before a few words beginning with o.

coexist, cooperate, coprocessor, coworker

co-op, co-owner

coax  Don’t use when you mean coaxial.



44Apple Style Guide

code, passcode  Use code to refer to the sequence of numbers sent to a device to verify a 
user’s identity.

Enter the six-digit code sent to your iPhone.

Use passcode to refer to the unique combination of numbers (and sometimes letters) that a 
user sets to lock or unlock a device, set restrictions on a device, or provide authentication 
for Apple Pay purchases.

To unlock Apple Watch, enter your passcode.

See also authenticate, authorize.

codec  Not CODEC. In the context of media apps, codec is short for compressor/
decompressor, a method for compressing and decompressing data. For example, MP3 and 
H.264 are codecs that reduce the amount of information used to represent audio and video 
content, respectively. In telecommunications, the term is short for coder/decoder, a device 
for encoding and decoding signals.

code file  Two words.

code font  A fixed-width font (such as Courier) used to represent code.

Use code font for the following:

• Text the user is to type (In some groups, double quotation marks or italics may  
be used for short words or phrases the user is to type. Consult your department’s  
style guidelines.)

• Code listings

• Small pieces of sample code

• Computer-language elements such as reserved words, literals, variables, and routines

• Commands that appear in running text

Use regular body font for any punctuation following a word or phrase in code font, unless 
the punctuation mark is part of the computer-language element represented or part of 
something the user is to type. Use regular body font for the spaces that immediately 
precede or follow text in code font.

If the language you’re working with has a standard style of indentation, use it. If it doesn’t 
have such a style, develop a logical style of your own and use it consistently.

Develop a method of spacing around punctuation and use it consistently. It’s often best to 
use standard spacing (one space between a punctuation mark and the next character).

In user materials, don’t use code font in any of the following:

• Part or chapter titles

• Text headings

• Cross-references to parts, chapters, or sections

• Entries in the table of contents

• Internet or web addresses

• Figure captions or callouts
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• Names of files, folders, or directories

• System or alert messages. If you quote a system message or alert message exactly as it 
appears on the screen, use body font in quotation marks. If you paraphrase a message, 
use body font without quotation marks.

If your source clip isn’t as long as the duration between the sequence 
start and end points, an “Insufficient content for edit” message appears.

When a message appears asking if you want to clear the keyboard 
layout, click Yes.

See also Technical notation overview.

code names  Use exactly the same form for a product’s code name throughout a 
document. (If the name is sometimes misspelled or otherwise treated inconsistently, a 
global search-and-replace operation isn’t possible.)

In final documentation, don’t refer to a product by its code name unless marketing 
specifically decides to associate the code name with the product.

cold start (n., v.), cold-start (adj.)  Not coldstart.

colons  Follow these guidelines for using colons:

• In running text: Capitalize the first word after the colon if the word begins a complete 
sentence (exception to The Chicago Manual of Style).

There are two ways to raise or lower text in relation to adjacent text: 
You can make characters superscript or subscript, or you can adjust the 
baseline shift.

Ordinary video clips and image files have three channels of color 
information: red, green, and blue.

• In headings: If you use a colon in a heading, capitalize the first word after the colon, 
regardless of its part of speech.

Setting up: A beginner’s guide

• With lists: Precede every list with a colon, whether the sentence before the colon is a 
complete thought or a partial thought (exception to The Chicago Manual of Style). See 
also lists (bulleted).

color blind, color blindness  To refer to people who have problems seeing different colors, 
you can say a person who is color blind, a person who has color blindness, people with 
color blindness.

If you are color blind, you can use Color Filters to help you differentiate 
between colors.

See also Writing about disability.

colored  Don’t use to describe items on the screen. Instead, use color (a sepia-color photo, 
a color pattern), or describe the specific color (a green arrow, the multicolor pinwheel).

color lookup table  See CLUT.

color picker  Don’t use. See also picker. 

color pixels  Not colored pixels.
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colors  Colors include shades of gray, so you can use colors to refer to settings for both 
grayscale and color displays. On first mention of setting colors, say, for example:

You can set the number of colors (or shades of gray) displayed  
on the screen.

Thereafter, use colors.

Colors window  The systemwide window for selecting colors.

color well  Refers to the small rectangular or square control used to select a color.

When you choose Gradient Fill, two color wells appear below the pop-
up menu; select a color from each color well.

Select the Alternating Row Color checkbox, and then click the color well 
to select a color.

column view  A way to display and select items in a hierarchy of data—for example, the 
column view in Finder windows.

Column View button  The button second from the right in the View control in  
Finder windows.

combined action  In developer materials, use to refer to a combination of mouse (or 
trackpad) actions with keyboard presses—for example, Option-Shift-click. In user 
materials, use keyboard shortcuts to refer to actions that include keyboard presses.

command  Use command or menu command in user materials.

Use the Print command to create a PDF of your document.

To change the way windows look, use the commands in the View menu.

Use item or option to refer to menu items that aren’t commands, such as names of fonts in 
a pop-up menu.

A command is in a menu, not on a menu; a menu contains commands. Users choose 
commands; they don’t select commands.

See also choose; command names; menus.

Command-click (v.)  Equivalent to press the Command key while you click.

Command-click to select multiple files.

See also key, keys.
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Command-drag (v.)  Equivalent to press and hold the Command key while you drag.

To rotate the masked image, Command-drag its selection handles.

See also key, keys.

Command key  On first use in printed user materials, it’s OK to identify the Command key 
with its symbol: Command ( ) key. Thereafter, just use Command key.

It’s OK to use the Command key symbol in a list of shortcuts.

Option- -Escape

Option-Shift- -Delete

Command-key equivalent  Don’t use; use keyboard shortcut even when all the 
combinations use the Command key.

command line (n.), command-line (adj.)  Note hyphenation of adjective.

command names  Use title-style capitalization for command names; don’t capitalize 
command.

the Find command

the Make Alias command

• Commands used as ordinary verbs: Don’t capitalize a command name when you use the 
name as a normal English verb.

Correct: Cut and paste the selected text.

Incorrect: Cut and Paste the selected text.

• Ellipsis: Some menu commands use an ellipsis to indicate that further action will be 
required. Don’t include the ellipsis when you refer to the command name in text or  
text headings.

Correct: Choose File > Print, and then enter the number of copies.

Incorrect: Choose File > Print…, and then enter the number of copies.

See also choose; command; menus.

commas  Use a serial comma before and or or in a list of three or more items.

Correct: You can ask Siri to place phone calls, send text messages, 
send reminders, and more.

Incorrect: You can ask Siri to place phone calls, send text messages, 
send reminders and more.

communication, communications  Use the singular to describe the act of communicating; 
use the plural to describe the technology.

compact disc  See CD.

companion iPhone  Don’t use. See also pair, paired.

Company, Co.  Spell out or abbreviate according to the particular company’s preference.

compile time (n.), compile-time (adj.)  Note hyphenation of adjective.
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complications  It’s OK to use complication to refer to a feature you can add to the watch 
face on Apple Watch, as long as you define complication on first use. However, in most 
cases, avoid using any specific term to refer to these features; simply discuss them 
generically—for example, you can add an alarm to the watch face, not you can add an 
alarm complication to the watch face.

component video  Note lowercase.

composite video  Note lowercase.

comprise  The whole comprises its parts. This word is misused so often that correct usage 
might confuse the reader; avoid it altogether. Use is composed of, includes, consists of, 
contains, or another word, as appropriate. Never use is comprised of, which in strict usage 
is equivalent to is included of.

computer  Use when you describe a computer without any peripherals. Don’t use machine 
or unit. See also system.

computer voice  See code font.

connect  Use to refer to the act of joining devices together; don’t use attach, hook up, 
or mate. You connect USB devices to a computer, and you can connect computers to a 
network. Don’t use connect when you mean plug in. See also plug in (v.), plug into (v.).

connector  Use to refer only to an item that can be plugged into a receptacle (such as a 
slot, port, or socket). Use the following terminology:

edge connector: the connector on the edge of a peripheral card; fits 
into a slot

minicircular connector: an 8-pin connector [Don’t use mini-DIN.]

plug: a connector with prongs or pins

In user materials, describe connectors by their shape and size, by the icon that appears 
on the connector, or in another way appropriate to the context. Users should be able to 
identify the connector easily, even if they don’t know the terminology.

Avoid obscure names such as power input unit in favor of more direct terms, such as plug. 
Don’t use male or female to describe types of connectors. 

See also jack; port; slot; socket; USB connector types.

constitute  Parts constitute a whole. A whole comprises parts. See also comprise.

contacts, Contacts  Use lowercase to refer to a user’s collection of contacts: Add a 
contact; update your contacts. Capitalize when referring to the app name: Use Contacts to 
call someone; get help using Contacts. See also iCloud.

contextual menu  The menu that appears when a user presses the Control key and 
clicks an item on the screen. In user materials, use shortcut menu, not contextual menu. 
However, you can refer to the menu parenthetically as a contextual menu on first reference 
for users who may be more familiar with that term.

A shortcut menu (also called a contextual menu) appears.

See also menus.
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contractions  As part of Apple’s informal voice, contractions are used and recommended 
throughout most documentation, interface text, and marketing copy. Keep localization in 
mind when deciding how or whether to use contractions.

• Use common contractions of be-verbs and auxiliary verbs with not (aren’t, isn’t, can’t, 
couldn’t, didn’t, doesn’t, hadn’t, haven’t, weren’t, won’t).

You don’t have access to the information.

The error shouldn’t occur again.

• Use common contractions of be-verbs and auxiliary verbs with personal pronouns 
(he’s, I’m, I’ve, it’s, she’ll, they’re, we’ve, you’re). It’s also OK to use here’s, let’s, that’s, 
there’s, and what’s.

Here’s a quick look at what’s new in this release.

We’re building a solar farm in China.

• Don’t form contractions from nouns or proper nouns.

Avoid: The computer’s not working.

Preferable: The computer isn’t working.

Avoid: Apple’s going to introduce a new computer today.

Preferable: Apple is going to introduce a new computer today.

• Avoid contractions of multipart verbs (could’ve), colloquialisms (workin’), and other 
contractions that are uncommon or awkward-sounding in written materials, or that may 
confuse nonnative English speakers (everybody’d, how’re, it’ll, many’s, when’s, where’ll, 
who’ve, why’s). Possible exceptions include text that’s meant to be spoken (such as a 
script) and direct quotes in running text.

• Don’t confuse it’s (the contraction for it is) with its (a possessive pronoun).

It’s important for the department to keep track of its computers.

See also possessives.

Control Center  Don’t precede with the.

Click an item in Control Center to see additional options.

control character (n.), control-character (adj.)  Note hyphenation of adjective.

Control-click (v.)  Equivalent to press the Control key while you click.

To open a document, Control-click the document icon and choose 
Open.

See also key, keys.

control key  Don’t use in a general sense; use modifier key. The name of the specific key is 
capitalized: Control key. See also modifier key.

Control key  It’s OK to abbreviate as Ctrl when space constraints don’t allow the use of the 
full term (as in column headings in tables). Don’t use CTRL.
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Control Strip  A set of system controls in the Touch Bar. Items are in (not on) the 
Control Strip. You expand or collapse the Control Strip (not show or hide it).

To change the volume, tap  in the Control Strip.

See also Touch Bar.

convert to  Not convert into.

cookies  Not cookie files. Use to refer to small text files a website may copy to a user’s 
computer to record information about the user or the computer.

To use some websites, you must set your web browser to  
accept cookies.

coprocessor  No hyphen.

copy  You copy a file to a disk, not on a disk or onto a disk.

copy-protect (v.), copy-protected (adj., pred. adj.), copy-protection (n.)  Hyphenate in 
all forms.

A copy-protected disk or file can’t be copied legally.

The disc is copy-protected.

copyright page  All documentation must have a copyright page or copyright notice.  
A copyright page includes a copyright notice and an Apple trademark list. A copyright 
notice includes the © symbol, the year the work was first published, the copyright owner 
(Apple Inc.), and the statement All rights reserved. Onscreen documents also require a 
copyright notice.

• Finding the correct copyright notice: The copyright page is a boilerplate element. 
Consult with your department editor to be sure you have the appropriate boilerplate.

• Apple trademarks: All Apple trademarks mentioned in the document must receive a 
credit line on the copyright page. See the Apple trademark list.

• Third-party trademarks: Certain third-party trademarks also must receive a credit line 
on the copyright page. See the “Special and Licensed Trademarks and/or Copyrights” 
section of the Apple trademark list.

See also trademarks (credit lines and symbols); trademarks (usage).

cord  Use only to describe a power cord or a phone cord. See also cable.

core  Short for execution core or processor core. See also dual-core (adj.).

Corporation, Corp.  Spell out or abbreviate according to the particular corporation’s 
preference.

corrupted  Avoid if possible. Use damaged instead.

country  Avoid using the term country when referring to a geographical area. Instead, use 
country or region or just region. 

Features may vary based on country or region.

Some features are not available in all countries or regions.

https://www.apple.com/legal/intellectual-property/trademark/appletmlist.html
https://www.apple.com/legal/intellectual-property/trademark/appletmlist.html
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CPU  Abbreviation for central processing unit. Avoid in user materials; use processor to 
refer to the chip and use computer or system to refer to the computer itself. For guidelines 
about spelling out abbreviations, see abbreviations and acronyms. See also computer; 
processor; system.

CR  Abbreviation for carriage return. Use only when you refer specifically to ASCII 
character $0D or its equivalent. Explain the term carriage return if your audience 
includes first-time computer users. For guidelines about spelling out abbreviations, see 
abbreviations and acronyms.

Use return character when you write about, for example, searches for return characters. 
Use Return key for the key users press.

crash  Don’t use; use quits unexpectedly, doesn’t respond, or stops responding. If you 
must use this word, put it in quotation marks and reassure the reader that the term crash 
doesn’t imply damage to hardware or software.

creator types  Use code font for creator type names, which must consist of exactly  
four characters (one of which may be a space) inside straight, single, code-font  
quotation marks.

'ttxt', 'MPS '

crosshair  Use to refer to this pointer:

cross-references  Guidelines for cross-references vary by department, document type, 
and delivery method. This section provides general guidelines, but always consult your 
department’s style guidelines if in doubt about which style to use, and be consistent within 
a document.

• Titles of books and other documents: In general, use title-style capitalization and italics; 
don’t use quotation marks unless italics aren’t available. Don’t capitalize or italicize 
phrases such as user guide unless they’re part of the title as it appears on the cover 
page of the document. Don’t include trademark symbols.

See the iPhone User Guide.

For detailed information about using Apple Watch, download the  
user guide.

Exception: In onscreen text, it’s acceptable to write the titles of user guides (and other 
books) in roman, with no quotation marks. Titles are often links—which are typically 
not italicized—so even if a title is not a link, you may want to make it match the style of 
other linked titles (roman, with no quotation marks).

For more information about adding contacts, see the Contacts User Guide.

iMac Essentials provides all the information you need to set up and start 
using your new iMac.
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• Titles of chapters or sections of a document: Authoring and output tools typically 
determine the format of links to chapters or sections within a document. For cross-
references that aren’t links, match the capitalization style of the chapter or section 
title, and enclose the title in quotation marks. If you refer to a chapter by number, don’t 
enclose the word Chapter or the chapter number in quotation marks.

For more information, see the “Edit with multicam clips” section of the 
Final Cut Pro User Guide.

See Chapter 1, “Ready, Set Up, Go,” on page 7.

See also capitalization.

crown  See Digital Crown.

Ctrl  Abbreviation for Control. Use the abbreviation only when space constraints don’t 
allow use of the full term (as in column headings in tables); otherwise, use Control, as in 
Control key or Control-S. Don’t use CTRL.

curly brackets  Don’t use curly brackets to describe these symbols: { }; use braces.

cursor  Don’t use in describing the macOS or iOS interface; use insertion point or pointer, 
depending on the context. The term cursor is appropriate when you describe the VoiceOver 
interface and may be appropriate when you describe other interfaces and in developer 
materials. See also insertion point; pointer.

custom installation  Not custom install. Users perform a custom installation; they don’t do 
a custom install. See also install; installation; normal installation.

D
DAC  Acronym for digital-to-analog converter. Note hyphenation in the spelled-out version. 
For guidelines about spelling out acronyms, see abbreviations and acronyms.

Dark Mode  Note capitalization.

You can use Dark Mode to darken the color scheme so the content 
you’re working on stands out.

Users can turn on or turn off Dark Mode and use Dark Mode. Don’t describe a computer or 
device as using Dark Mode or being in Dark Mode.

Correct: When Dark Mode is turned on, you can still use a light 
background in your emails.

Correct: If you’re using Dark Mode…

Incorrect: If your iPhone is using Dark Mode…

You can also refer to Dark Mode as the dark appearance. The alternative is the light 
appearance (not Light Mode).

Open System Preferences, click General, and then select the light or 
dark appearance.



53Apple Style Guide

Dashboard  Don’t precede Dashboard with the or your. See also widget.

dash (em)  Use the em dash (—) to set off a word or phrase that interrupts or changes the 
direction of a sentence or to set off a lengthy list that would otherwise make the syntax of 
a sentence confusing. Don’t overuse em dashes. If the text being set off doesn’t come at 
the end of the sentence, use an em dash both before it and after it.

See all your schedules—work, school, and social life—in one app.

To generate an em dash in a word-processing app, press Option-Shift-Hyphen. Close up 
the em dash with the word before it and the word after it.

dash (en)  The en dash (–) is shorter than an em dash and longer than a hyphen. Use the 
en dash as follows:

• Numbers in a range: Use an en dash between numbers that represent the endpoints of a 
continuous range.

bits 3–17, 2003–2005

• Compound adjectives: Use an en dash between the elements of a compound adjective 
when one of those elements is itself two words.

desktop interface–specific instructions

Grammy Award–winning producer

ex–Sun Studio tour guide

• Minus sign: Use an en dash as a minus sign (except in code font, where you use  
a hyphen).

–1, –65,535

To generate an en dash in a word-processing app, press Option-Hyphen. Close up the en 
dash with the word (or number) before it and the word (or number) after it.

See also hyphenation.

data  Singular or plural, depending on the context. When used as a collective noun, 
data takes a singular verb. When the meaning isn’t collective, use a plural verb. In user 
materials, avoid in favor of information if information makes sense in the context.

Collective and thus singular: Data is stored in a FileMaker Pro database.

Not collective and thus plural: Selected data are transferred immediately.

database (n., adj.)  Refers to the body of data manipulated by a database app.

data file  Two words.

date picker  Don’t use. See also picker.
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dates  Follow these guidelines for dates, unless your department uses international style 
(see Dates and times).

• Commas: Use a comma between the day of the month and the year.

January 16, 2021

When you use the full date, follow the year with a comma.

on January 16, 2021, at 10:00 a.m.

If you give only the month and year, don’t use commas.

in June 2021 at WWDC

• Cardinal and ordinal numbers: Use cardinal numbers (1, 2, 3) in dates that include the 
month. Use ordinal numbers (1st, 2nd, 3rd) in dates without the month. For ordinal 
numbers, use full-size letters, not superscript.

Correct: The conference was held on August 12.

Correct: The conference was held on the 12th.

Incorrect: The conference was held on the 12th.

• When to spell out: Spell out the names of days and months in text. Use numerals for the 
year except when it appears at the beginning of a sentence; spell out the year there or 
rewrite to avoid.

• Slashes in dates: Don’t use the form 3/5/17, because American usage is different from 
European usage.

daughter board  Don’t use; use expansion board.

daylight saving time  Not daylight savings time.

deactivate  See activate, deactivate.

deafblind, Deafblind  Use deafblind to refer generally to people who have a combination of 
vision and hearing loss, or to refer to a medical condition or diagnosis.

If you are deafblind, you can turn on Taptic Time in VoiceOver on  
Apple Watch to be notified of the time with a series of taps.

Capitalize Deafblind when referring to people who identify culturally as Deafblind 
(sometimes spelled DeafBlind).

Some people in the Deafblind community use a braille display 
connected to their Mac to read, write, and watch videos.

If you’re unsure of the correct way to refer to a specific person, you can ask them.

Don’t use deaf and dumb, mute, or deaf-mute.

See also blind, low vision; deaf or hard of hearing, Deaf; Writing about disability.
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deaf or hard of hearing, Deaf  Use deaf, hard of hearing, or deaf or hard of hearing to 
refer generally to people with hearing loss, or to refer to a medical condition or diagnosis.

Closed captioning is especially useful if you are deaf or hard of hearing.

Capitalize Deaf when referring to people who identify culturally as Deaf.

Many people in the Deaf community prefer to communicate using sign 
language.

If you’re unsure of the correct way to refer to a specific person, you can ask them.

Don’t use hearing impaired.

See also deafblind, Deafblind; Writing about disability.

dealer, dealership  Don’t use; use Apple Authorized Reseller. See also Apple Authorized 
Reseller.

deejay  Don’t use; use DJ. See also DJ.

default (n., adj.)  OK to use to describe the state of settings before the user changes them.

By default, iMovie inserts transitions between clips.

You can display the scopes below the video image rather than on the 
left side (the default).

See also preset (n., adj.).

degrees  OK to either spell out degrees or use the degree symbol (º), but be consistent. 
Hyphenate when the term precedes a noun: 160-degree viewing angle. The symbol is 
closed up with the number: 160º viewing angle, 32º F. To generate the degree symbol, 
press Option-K.

dehighlight, dehighlighted  Don’t use. Use deselect as a verb when appropriate; 
otherwise, reword. Use not highlighted as the adjective.

DEL character  Not DELETE character or rubout character. Refers specifically to ASCII 
character $7F.

Delete key  Not DEL key.

deploy  OK to use in server and developer materials to refer to placing configured 
computer systems, services, or software in a specific environment or making these items 
available for use in that environment.

In large organizations, collaboration services are usually deployed at 
both corporate and workgroup levels.

depress  Don’t use; use press.

deselect  OK to use when you mean cancel a selection. Not uncheck, unselect, unhighlight, 
or dehighlight. See also checkbox; radio button; unselected (adj.).
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desire  Don’t use. See also want.

desired  Try to avoid.

Correct: make your changes, select the folder

Incorrect: make the desired changes, select the desired folder

desktop (n., adj.)  Use to refer to the background area of the screen on a Mac.

desktop computer  Don’t use desktop as a noun to refer to the computer; use desktop 
computer, desktop system, or just computer or system. See also computer; system.

determinate progress bar  In developer materials, the progress bar that fills from left to 
right. In user materials, use progress indicator and describe what it looks like.

Developer materials: Use a determinate progress bar when you can tell 
the user how much of a process has been completed.

User materials: A progress indicator (a moving bar) shows the status of 
the download.

device  Use to refer generically to hardware that connects to a computer (communications 
device, input device, mobile device, peripheral device).

You can also use device:

• To refer to a category of hardware products: iOS device, iPadOS device, iOS and iPadOS 
devices, Android device

• To refer to more than one of a specific device (to avoid making a trademarked name 
plural)

Correct: If you have multiple iPad devices, you can…

Incorrect: If you have multiple iPads, you can…

• To refer to Mac computers in conjunction with iPhone, iPad, iPod touch, and other 
devices when no distinction is needed

iCloud keeps your documents updated across all your devices.

When you add a photo on your Mac, it appears on your other devices.

In user materials, when you write about a specific device (such as a Mac or Apple Watch), 
use that device’s name in most cases. In service documentation, if a device name is 
repeated frequently and it’s clear from the context what the device is, it’s OK to shorten 
to device, or to another acceptable short form—for example, computer instead of Mac, or 
watch instead of Apple Watch.

See also mobile device; product; unit.

diacritical mark  Not diacritic.

dial in, dial in to (v.), dial-in (adj.)  Note hyphenation of the adjective form.
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dialog  In user materials, use dialog for windows, like the one below, that request additional 
information from the user and are explicitly dismissed by clicking a button within the 
dialog—for example, OK, Cancel, or Print. Don’t use dialog box.

Dialogs include alerts, which contain error messages or warnings about potentially 
hazardous situations or actions. Although a dialog can be implemented as a sheet attached 
to a window, don’t use sheet in user materials. Examples: Open dialog, Print dialog, Save 
As dialog, Save Changes alert.

In developer materials, use panel rather than dialog in most contexts because dialogs are 
created with programming symbols such as NSOpenPanel. When, however, the dialog 
is seen by the developer as a user sees it, such as when giving instructions for using 
developer apps, use dialog. Note that entities that are panels programmatically can be 
windows rather than dialogs in user terminology—for example, the NSFontPanel class 
implements the Fonts window.

See also alert (n., adj.); pane; sheet; window.

dialog box  Don’t use; use dialog.

dialog message  Don’t use; use message.

dialogue  Use dialogue, not dialog, to refer to spoken words.

dial-up (adj.)  Don’t use dial up as a verb.

different from  Not different than. Make sure that the elements being compared are 
parallel nouns.

Correct: The Mac user interface is different from that of a Windows PC.

Incorrect: The Mac user interface is different than that of a Windows PC.

Incorrect: The Mac user interface is different from a Windows PC.

differently than  Use when comparing two parallel clauses. Don’t use different than, 
different from, or differently from for this purpose. But rewrite whenever possible to set up 
a construction in which different from is used to compare two parallel nouns.

Correct: She uses the computer differently than he does.

Preferable: Her use of the computer is different from his.

Incorrect: She uses the computer differently than him.
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digital  Don’t use a hyphen in compound adjectives beginning with digital: digital video 
editing, digital media apps. Don’t use digital apps or digital applications.

digital camcorder  See camcorder.

digital camera  Use to refer to a digital still camera. After the first mention, camera is fine.

You can connect a digital camera if both your computer and camera 
have built-in USB ports.

Digital Crown  Use the full term, not crown, to refer to the feature on Apple Watch. You 
turn the Digital Crown; you don’t rotate it.

Correct: Turn the Digital Crown to see all your messages.

Incorrect: Rotate the crown to see all your messages.

digital rights management  See DRM.

digital-to-analog converter  See DAC.

Digital Touch  A feature for adding effects (such as a kiss or a heartbeat) to messages in 
the Messages app for watchOS and iOS.

You can use Digital Touch to send your heartbeat to a friend.

To send a kiss, tap with two fingers.

You can refer to items users send as Digital Touch effects, or simply use the name of the 
effect—for example, heartbeat, kiss, or sketch (not doodle). See also tap (n., v.).

digital video (n., adj.)  No hyphen. See also DV.

digital video camera  See video camera.

digital video recorder  See DVR.

Digital Visual Interface  See DVI.

dimensions  In general, use by, not x, to show dimensions.

3.2 by 6.0 by 11.4 in. (8.1 by 15.2 by 28.9 cm)

8.5 by 11 inches, 8.5-by-11-inch paper

4 by 6 inches, 4-by-6-inch photo [acceptable: 4-by-6 photo,  
4 x 6 photo]

If you use x instead of by, use the x consistently throughout a document.

See also resolution; x.

DIMM  Acronym for dual inline memory module. For guidelines about spelling out 
acronyms, see abbreviations and acronyms.
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dimmed  Use dimmed, not hollow or grayed, to describe a shaded icon, menu item,  
button, or option in a dialog. Dimmed options can’t be selected. Dimmed menu items  
can’t be chosen.

Dimmed icons can represent disks whose contents are displayed in a window, disks that 
have been ejected, or files or folders in the window of a disk that has been ejected.

You don’t need to say dimmed (unavailable) because a dimmed object is understood  
to be unavailable.

direction keys  Don’t use; use arrow keys. See also arrow keys.

directory  The standard UNIX term for an organizational unit, or container, used to organize 
files and other directories into a hierarchical structure known as a file system. In developer 
materials, use directory; in other Apple materials, use folder. See also folder.

directory pathnames  See pathnames.

disability  OK to use to refer to a person with a disability.

Make sure your website or app is accessible to people with disabilities.

Avoid terms like differently abled, people with special needs, people with special abilities, 
and people of all abilities.

See also Writing about disability.

disable (v.), disabled (adj.)  Follow the guidelines below.

• Software: In user materials, don’t use disable to refer to turning off a feature or 
deselecting an option; use turn off or deselect.

You can turn off airplane mode using Control Center.

To hide an object’s caption, deselect the Caption checkbox.

Don’t use disabled to describe features that are turned off or unavailable; use turned 
off, unavailable, or inactive.

Make sure virus-protection software is turned off.

The Copy command is unavailable if there’s no text selected.

Active roles appear in color in the timeline; inactive roles appear in gray.

In developer materials, it’s OK to use disable to mean making something inactive, and 
disabled to describe items that have been made inactive.

You can disable and enable breakpoints in your code.

The app was disabled during testing.

• People: A disabled person (or disabled people) may be acceptable to people who 
consider their disability part of their identity. If you’re unsure how to refer to someone, 
you can ask them. See also disability; Writing about disability.

See also enable (v.), enabled (adj.); turn on, turn off.

disc  Use disc (or optical disc) when you refer to optical storage media (such as CDs  
and DVDs).

For magnetic storage media such as hard disks, use disk. See also disk.
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disclosure arrow  A button that reveals or hides options when clicked (not the disclosure 
button). It’s usually not necessary to mention that it’s closed (pointing to the right) or open 
(pointing down).

Correct: You can click the disclosure arrow to reveal more information.

Avoid: You can click the closed disclosure arrow (pointing to the right) 
to reveal more information.

The Info window contains disclosure arrows:

In developer materials, this control is referred to as a disclosure triangle.

See also disclosure button.

disclosure button  A button containing an arrow that expands a dialog or utility window to 
provide additional choices that are associated with a specific list-based selection control.

The arrow on the disclosure button points down in the closed position. When the user 
clicks a disclosure button, the window expands and the arrow points up. See also 
disclosure arrow.

disc titles  Use italics for the full title of a disc and capitalize it the way it appears on the 
label. The word CD or DVD isn’t typically part of the title.

disk  Use to refer to magnetic storage media such as hard disks. You can also use disk 
more broadly to include other types of computer storage media, such as solid-state drives 
and flash storage. For example, legacy terms such as startup disk, disk partition, disk 
image, and target disk mode are commonly used regardless of the type of storage.

You can often use a more general term, such as computer or storage space.

You can import media files stored on your computer.

You can delete files to free up storage space.

In user materials, don’t omit the article in phrases such as to a disk or on a disk.

Correct: You can copy the files to a disk.

Incorrect: You can copy the files to disk.

For optical storage media (such as CDs and DVDs), use disc.

See also volume (disk).
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disk drive  See drive.

disk image  Note the k in disk.

disk name  Use when you refer to the name that appears below a disk’s icon on the 
desktop; don’t use disk title for this purpose.

display (n.)  In most cases, use display, not monitor, to refer to the primary display 
connected to a desktop computer. Also use display to refer to the built-in display in a 
portable or all-in-one computer. Don’t use when you mean desktop or screen.

Correct: A window appears on the screen.

Incorrect: A window appears on the display.

Correct: Arrange your display so that the top of the screen is slightly 
below eye level.

On Apple Watch, use display to refer to the part of the watch that shows the screen, and 
that users press to interact with.

With the watch face showing, press the display.

Press the display while viewing a daily calendar.

See also monitor; screen.

display (v.)  Don’t use display when you mean appear.

Correct: The Print dialog appears.

Incorrect: The Print dialog displays.

See also appear.

display cable  Use instead of monitor cable or monitor power cord for Apple displays.

display device  Refers to a device connected to the computer that displays text or 
graphics. If possible, be more specific: LCD projector or TV.

display port  The port on a computer or graphics card used to plug in an Apple display. 
Don’t use monitor port.

display sleep  Don’t use. Pressing the Sleep/Wake button locks or unlocks iPhone, iPad, or 
iPod touch; it doesn’t put the device in display sleep. See also sleep. 

division sign  Not division symbol.

DJ  Use instead of deejay. The plural is DJs.

do  Don’t use in phrases such as do a clean installation. Use perform instead.

dock  A base in which to place a device. Use lowercase in general references: place iPad 
in the dock. Capitalize in product names: iPhone Lightning Dock, Apple Watch Magnetic 
Charging Dock. In user materials, don’t use dock as a verb; devices are in the dock, not 
docked. Don’t use dockable.
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Dock  The bar of icons located by default at the bottom of the screen (on a Mac) or at the 
bottom of the Home screen (on iPhone, iPad, or iPod touch). On Apple Watch, users view 
the Dock by pressing the side button.

Don’t use as a verb. Items are in the Dock, not on the Dock. Don’t say an item is docked.

Correct: To put a window in the Dock, click the minimize button.

Incorrect: To dock a window, click the minimize button.

Correct: Click the Mail icon in the Dock.

Incorrect: Click the Mail icon on the Dock.

In macOS, don’t assume that an item is in a user’s Dock; everything except the Finder and 
the Trash can be removed.

dock connector  The port on older iOS devices for connecting to a dock, a cable, or an 
adapter. Use lowercase in general references: an iPhone dock connector. Capitalize in 
product names: Apple Dock Connector to VGA Adapter.

document  In user materials, refers to a file the user creates and can open, edit, and 
print. A document is a particular type of file; don’t use document when the file could be of 
another type.

Correct: Time Machine backs up all your files to an external disk.

Incorrect: Time Machine backs up all your documents to an external disk.

See also file.

document titles  When you cite the full title of a document, follow the capitalization style 
used in the title. The article the isn’t usually part of the title, but for user materials a 
phrase such as User Guide often is. Consult your editor for titling guidelines specific to 
your department.

• Specific references to document titles: Always give the title exactly as it appears on the 
document’s cover page (but eliminate any trademark symbols). Don’t change an old title 
to comply with the current guidelines for naming documents.

For more information, see the iPad User Guide.

• Generic references to document titles: Don’t capitalize or use italics for generic 
references to documents.

See the user guide that came with your computer.

To connect your display, follow the instructions in the setup guide.

See also cross-references.

document window  Don’t use; use document or window, not both. In developer materials, 
document window is OK in reference to the predefined window type.
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Dolby formats  Note capitalization of the following audio and video formats:

Dolby Atmos surround sound
Dolby Digital 7.1 surround sound
Dolby Digital 5.1 surround sound
Dolby Vision

When referring to an audio format, include the descriptive term surround sound on  
first reference.

Correct: HomePod supports Dolby Atmos surround sound.

Incorrect: HomePod supports Dolby Atmos.

In subsequent references, it’s OK to omit the term surround sound in the format names if 
the context is clear.

When you set up a home theater on HomePod, you can enjoy surround 
sound in the following formats: Dolby Atmos, Dolby Digital 7.1, or  
Dolby Digital 5.1.

Do Not Disturb  Note capitalization.

To stop notifications, turn on Do Not Disturb.

When referring to the related feature Do Not Disturb While Driving, capitalize as shown.

Correct: To avoid being distracted in your car, turn on Do Not Disturb 
While Driving.

Incorrect: You can turn on “Do Not Disturb while driving” in  
Control Center.

dos and don’ts  Note apostrophe.

dot (n.)  Use to describe any of the following: 

• The characters that appear when a user types a password

• The color components of a pixel (also called subpixels)

There are usually three dots per pixel: red, green, and blue.

Don’t use bit when referring to the components of a pixel.

See also bit (n., adj.); bullet; pixel.

dots per inch  See dpi.

double  Hyphenate compound adjectives beginning with double.

double-precision, double-sided, double-wide

double-byte characters  Not 2-byte characters.
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double click (n.), double-click (v.), double-clicking (n., v.)  Note hyphenation.

Small children may have trouble with a double click.

Adults can double-click without difficulty.

You do this by double-clicking the icon.

On devices with a Home button, users double-click (not double-tap or double-press) the 
Home button.

To view your most recently used apps, double-click the Home button.

On Apple Watch, users double-click (not double-press) the Digital Crown and side button.

See also click.

double layer (n.), double-layer (adj.)  Hyphenate as an adjective, but not as a noun: 
double-layer disc; DVD + R DL (Double Layer). Use lowercase for general references.

You can burn up to 4 hours of video on a double-layer DVD.

See also DVD.

double tap (n.), double-tap (v.), double-tapping (n., v.)  Note hyphenation.

A simple double tap lets you zoom in.

Double-tap the photo to zoom in or out.

You can zoom in by double-tapping.

See also tap (n., v.).

down arrow  Use to refer to the small arrow that users click to decrease a value  
in a stepper.

Click the down arrow to decrease the text indent.

See also Down Arrow key; stepper.

Down Arrow key  When you refer to arrow keys generically, use lowercase, but capitalize 
and use the complete name when you refer to one or more arrow keys by name. See also 
arrow keys.

download (n., v.), downloadable (adj.)  Use only to refer to user-initiated downloads  
of content.

You can download music you’ve already purchased to all your devices.

Avoid using download to refer to what iCloud does; instead, use an alternative such as keep 
up to date, or say that content appears automatically.

Avoid: iCloud downloads your new photos to all your devices.

Preferable: iCloud keeps your photos up to date on all your devices.

See also iCloud.
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Downtime  Capitalize when referring to the feature or to the names of interface elements. 
Use lowercase in generic references.

You can use the Downtime feature to schedule time away from the 
screen for young family members.

During downtime, app icons are dimmed and an hourglass icon  
is shown.

dpi  Abbreviation for dots per inch (n.) and dot-per-inch (adj.). For guidelines about 
spelling out abbreviations, see abbreviations and acronyms.

The printer provides a resolution of 600 dots per inch (dpi); it can be 
upgraded to 1200 dpi.

The printer provides a 600-dot-per-inch (dpi) resolution; some printers 
offer 1200 dpi resolution.

drag  Refers to an action that can be performed on a desktop or portable computer,  
or on a device with a touchscreen. Usage is slightly different in each case; follow the 
guidelines below.

• On desktop computers and portable computers: Drag refers to the act of positioning 
the pointer, pressing and holding the mouse or trackpad, moving the mouse (or, on a 
trackpad, the user’s finger), and then releasing. If you’re writing for novice users, you 
might need to define drag on first mention.

Use drag to refer to actions users perform with objects onscreen. For example, a user 
can drag an onscreen item (such as a folder or file), drag a control (such as a slider),  
or drag across part of the screen—for example, to create a shape or select an area of  
a document to work with. Don’t use drag the mouse or drag the pointer.

Correct: Drag the Volume slider to change the volume.

Correct: Choose Tools > Annotate > Rectangle, and then drag to create 
a rectangle.

Incorrect: Drag the mouse to draw a rectangle.

Don’t use click and drag. Don’t use place, put, or move when you mean drag.

Correct: Drag your songs into the order you want.

Correct: Drag the icon to the Trash.

Incorrect: Click and drag the icon to the Trash.

Incorrect: Put the icon in the Trash.
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• On devices with touchscreens: Drag refers to the act of moving one finger across  
the screen.

Users can drag to scroll through items, drag controls, or drag to pan around items such 
as photos and webpages.

Drag up or down to scroll through your contacts.

Drag the slider to unlock iPhone.

To move around in a webpage, drag up, down, left, or right.

Don’t use tap and drag.

Correct: Drag to see a different part of the map.

Incorrect: Tap and drag to see a different part of the map.

Don’t say drag your finger.

Correct: Drag across the text.

Incorrect: Drag your finger across the text.

See also gestures; swipe (n., v.).

drag and drop (n., v.), drag-and-drop (adj.)  Note hyphens in the adjective.

With drag and drop, you can use a finger to move text and other items 
between apps.

Just drag and drop to add photos to your documents.

Using Photos, you can create digital photo albums with drag-and-drop 
simplicity.

Avoid using drag and drop as a compound verb followed by an object; dragging includes 
dropping the item into place.

Correct: Drag the file to the printer icon.

Incorrect: Drag and drop the file onto the printer icon.

drag handle  Don’t use; use handle. See also handle.

DRAM  Acronym for dynamic random-access memory. Pronounced “DEE-ram.” For 
guidelines about spelling out acronyms, see abbreviations and acronyms.

drawer  A window that slides out from a parent window when the user clicks a button or 
chooses a command.
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drive  Use to refer to a data storage device such as a hard drive (which holds magnetic 
disks), an optical drive (which holds optical discs), or a solid-state drive (which stores data 
using flash memory and has no moving parts). Don’t capitalize drive except in a product 
name such as SuperDrive or Fusion Drive.

It’s OK to use drive on its own after you first specify the type of drive.

If your Mac doesn’t have a built-in optical drive, you can use another 
computer’s drive.

Don’t use drive when you mean disk or disc.

Correct: You can partition the disk in Disk Utility.

Incorrect: You can partition the drive in Disk Utility.

See also disk; hard drive.

driver  Capitalize the word driver in a driver name only if it’s part of the name (for example, 
Sound Driver or Disk Driver). When you use the term driver generically, as in print driver, 
don’t capitalize. In user materials, avoid using driver; use software instead (printer software).

DRM  Abbreviation for digital rights management. For guidelines about spelling out 
abbreviations, see abbreviations and acronyms.

DRM-free (adj.)  Note hyphenation.

drop box  Two words.

drop-down menu  Don’t use; use menu.

drop zone  Two words.

dual  Hyphenate compound adjectives beginning with dual.

dual-band, dual-channel, dual-link

dual-core (adj.)  Refers to a processor with two execution cores or to a computer with a 
dual-core processor. Processors have dual cores, not a dual core. Related terms include 
dual-core processing, dual-core performance, and so on. See also dual-processor (adj.); 
Intel Core; Intel Xeon.

dual-display (adj.)  Refers to the connection of two displays to a computer, or to an 
external display connected to a portable computer or an all-in-one computer. Computers 
can have two displays or dual displays, not a dual display. See also extended desktop  
(n., adj.); video mirroring (n., adj.).

dual inline memory module  See DIMM.

dual-layer (adj.)  Don’t use. Use double-layer in reference to the SuperDrive and the DVDs 
it uses. See also double layer (n.), double-layer (adj.).

dual-processor (adj.)  Computers with two processors are dual-processor computers. 
They have dual processors, dual Intel Xeon processors, and so on. Don’t use a dual 
processor or DP. See also dual-core (adj.).

duckhead  Don’t use. When describing the wall-plug module that attaches to an Apple 
power adapter, use AC wall adapter.
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due to  Avoid; instead, use alternatives such as caused by or because of.

Avoid: The interference was due to a faulty cable.

Preferable: Your apps will open more quickly because of the additional 
memory.

dummy  Don’t use to refer to placeholder content. Use an alternative that conveys the 
correct meaning in context, such as placeholder, sample, test, stub, or boilerplate.

Correct: Use layout guides to replace the placeholder views you created.

Incorrect: Use layout guides to replace the dummy views you created.

DV  An industry-standard video format. Generally, use DV to refer to the format or to 
products that use the format. Don’t use DV to refer to the medium digital video. Related 
terms include DV format, DV standard, DV camera, DV camcorder.

DVD  An optical disc designed for high-capacity storage. Use disc, not disk, to refer to 
DVD media.

DVD drive  Avoid; use optical drive. See also SuperDrive.

DVI  Abbreviation for Digital Visual Interface, not Digital Video Interface. For guidelines 
about spelling out abbreviations, see abbreviations and acronyms.

DVR  Abbreviation for digital video recorder. Use to refer to a device, such as a portable 
media player or set-top box, that records digital video to file-based media such as a hard 
disk or an optical disc. Don’t use DVR when you mean camcorder. For guidelines about 
spelling out abbreviations, see abbreviations and acronyms. See also camcorder.

dynamic random-access memory  See DRAM.

E
e  Short for electronic. Hyphenate terms using the short form: e-commerce, e-learning. 
Exceptions include email and ebook. In titles that use title-style capitalization, capitalize as 
follows: The Growth of E-Commerce.

earbuds  One word.

earlier, later  Use to refer to versions of software; don’t use lower and higher or newer  
and older.

You can make and receive phone calls on your iPad or iPod touch 
(iOS 12 or later), Apple Watch (watchOS 4 or later), or Mac (OS X 10.11 
or later).

To use Group FaceTime, you must have macOS 10.14.1 or later installed.

To take an ECG, you must have Apple Watch Series 4 with watchOS 
5.1.2 or later.

See also latest; version number.

earphones  One word.

ebook (n.)  An electronic book. See also EPUB (adj.).
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editing  Don’t use a hyphen when you use editing in a compound adjective.

video editing app, audio editing system

edit menu  A type of menu in iOS that lets users perform actions (such as copy, paste, and 
select) on objects or text.

Don’t use edit menu in iOS materials; simply describe what users should tap in the menu.

Correct: Tap Select.

Incorrect: Tap Select in the edit menu.

See also menus.

education  Use lowercase in reference to education customers and products.

K–12 education, higher education, Apple education pricing, Apple 
education representative

Don’t use abbreviations such as ed, edu, or HED.

e.g.  Don’t use; use for example or such as. See also abbreviations and acronyms.

eject (trans. v.)  Don’t use as an intransitive verb.

Correct: The disk drive ejects the disk.

Correct: To eject the disk, drag its icon to the Trash.

Incorrect: The disk ejects.

Eject button  The button next to the name of a disk, a device, or another item listed in the 
sidebar of Finder windows or in other app windows. See also Media Eject key.

electromagnetic interference  See EMI.

ellipsis  A set of three dots indicating a continuation or, in a quotation, the omission of 
one or more words. Use the ellipsis character (Option-Semicolon) to prevent line breaks 
from occurring between the dots. For more information about using ellipses, refer to The 
Chicago Manual of Style.

If the name of a menu item or button ends with an ellipsis, don’t include the ellipsis in 
running text.

Correct: Choose File > New and click a template.

Incorrect: Choose File > New… and click a template.
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email (n., v., adj.)  One word.

Send an email to your manager.

Your manager wants you to email her.

You can set up email filters.

When referring to more than one email, use email if you’re using the word in a collective 
sense; use emails to refer to a specific group or type of emails.

You can filter incoming email.

Here are tips for how to avoid phishing emails.

Flag important emails to make them easier to find later.

You can use messages to refer to email if the context makes it clear you’re talking about 
email, not text messages.

email addresses  Email addresses use this format:

username@domain

For example, the address steve@icloud.com specifies a user named “steve” at the  
icloud.com domain.

• In text: Use plain text for email addresses in text.

• Line breaks: Avoid line breaks in an email address. If necessary, set the address on a 
separate line.

• Punctuation: If an email address ends a sentence, it’s OK to use a period.

See also internet addresses.

email alias  Use to refer to an alternate email address created by a user to mask the user’s 
main email address.

You can have up to three active email aliases.

You can also send email from an alias.

embed  Not imbed.

em dash  See dash (em).

Emergency SOS  The feature that makes an emergency call. Note capitalization. Use 
emergency call, not emergency SOS call, to refer to the type of call placed by this feature.

With Emergency SOS, you can quickly and easily call for help.

To make an emergency call, press and hold the side button, and then 
drag the Emergency SOS slider.

EMI  Abbreviation for electromagnetic interference. For guidelines about spelling out 
abbreviations, see abbreviations and acronyms.
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emoji  Lowercase; same form for singular and plural. Use to refer to small symbols  
(such as  ) that represent emotions, concepts, or common objects in email and other 
electronic communications.

For some emoji, such as those for people, you can click and hold the 
emoji to see variations.

If you don’t see the emoji keyboard, you can turn it on in Settings.

Use regular punctuation with emoji that appear in running text.

Use Clips to personalize your video with filters, animated graphics, and 
even emoji  .

It’s OK to omit punctuation in special cases, such as the Tips notification below.

See also emoticon.

emoticon  A representation of an emotion or a facial expression created with typographic 
characters or small symbols.

The emoticon :-) represents a smiley face.

In general, use emoji to refer to characters created using an emoji input method (such as 
the Touch Bar), even though some emoji are also emoticons.

To add an emoji, such as a smiley face, in your message, tap   and tap 
the emoji you want to use.

Use regular punctuation with emoticons that appear in running text.

With Enhanced Dictation, you can use voice commands for emoticons. 
To produce :-), say “smiley face.”

It’s OK to omit punctuation in special cases, such as when showing an example of a  
text message.

See also emoji.

enable (v.), enabled (adj.)  Avoid in user materials when you mean turn on. Turn on implies 
initiating an action or starting a process immediately; enable implies doing a task that 
makes subsequent actions possible.

Correct: Turn on Windows file sharing.

Incorrect: Enable Windows file sharing.
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Don’t use enabled when you mean selected (for example, when you refer to radio buttons 
or checkboxes) or available (when you refer to commands or buttons that are sometimes 
dimmed, but not in this case).

Correct: Make sure the Magnification checkbox is selected in  
Dock preferences.

Incorrect: Make sure the Magnification option is enabled in  
Dock preferences.

Correct: The Copy command isn’t available because no text is selected.

Incorrect: The Copy command isn’t enabled because no text is selected.

Don’t use enable when you mean give the ability to. You can usually rewrite a sentence  
to avoid it.

Correct: With iMovie, you can view, edit, and share movie projects.

Incorrect: iMovie enables you to view, edit, and share movie projects.

It’s OK to use enable to describe a task that makes other actions possible.

To use this website, you must enable cookies.

In developer materials, it’s OK to use enabled and disabled when you describe buttons, 
menu items, and the like.

See also allow; disable (v.), disabled (adj.); let.

en dash  See dash (en).

end user (n.), end-user (adj.)  Avoid in favor of user. See also user.

energy management software  No hyphen.

energy-saving (adj.)  Note hyphenation.

ENERGY STAR  Note capitalization.

enhanced definition (n.), enhanced-definition (adj.)  Note hyphenation of adjective:  
in enhanced definition, enhanced-definition TV.

ensure, insure  Use ensure to mean make sure or guarantee. Use insure to describe what 
an insurance company does.

Insure your car to ensure that it’s covered in an accident.

See also assure.

enter  Use enter, not type, to describe inputting text-based information by typing, copying 
and pasting, dragging, or some other method. Use type to describe pressing or tapping 
keys to produce characters on the screen. Use press, not type, to refer to pressing keys on 
the keyboard.

Enter your account information and tap Save.

The intelligent keyboard may suggest corrections as you type.

Press the Return key.

See also press; type (v.).
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Enter key  Note capitalization.

entitled  Don’t use; use titled, named, or called.

EPUB (adj.)  A file format for electronic books and other documents. Don’t use as a noun; 
to refer generically to an electronic book, use ebook.

Correct: You can import an EPUB file into a template.

Incorrect: You can import an EPUB into a template.

See also file types.

equal sign  Not equal’s sign, equals sign, or equal symbol.

error message  Don’t use except in developer materials. Instead, use message, alert, alert 
message, or alert sound. See also alert (n., adj.).

Escape key  See Esc key.

Esc key  Include the word Escape in parentheses on first occurrence.

First occurrence: Press the Esc (Escape) key.

Thereafter: Press Esc.

When you describe escape sequences, don’t use a hyphen between names of keys 
(because the user presses and releases the keys separately).

Esc 4, Esc F

et al.  Abbreviation for and others. Use only to list people (not things) too numerous  
to mention—for example, when referring to scholarly books or articles having four or  
more authors.

See M. B. Cooper et al., “Reader Preferences for Report Typefaces,…”

Avoid in user materials. See also abbreviations and acronyms.

etc.  Don’t use; use and so forth or and so on. See also abbreviations and acronyms.

Ethernet  A cable-based system for connecting computers and peripheral devices. OK to 
use Ethernet network or simply Ethernet, depending on the context. See also Fast Ethernet 
(100Base-T); Gigabit Ethernet (1000Base-T).

EU  No periods. OK to abbreviate or to spell out European Union as a noun. Use the 
abbreviation for the adjective form.

events, Events  Use lowercase in generic references to events. Capitalize when referring to 
the feature in an app such as iMovie, and to capitalized interface elements.

You can use events to group clips any way you like.

To sort events chronologically, choose View > Sort Events By > Oldest 
to Newest.

exclamation points  OK to use exclamation points occasionally in promotional text and 
dialogue. Avoid in documentation.

exit  In user materials, don’t use to refer to quitting an open app; use quit. See also 
interrupt; quit; stop.
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expansion board  Not daughter board or piggyback board.

ExpressCard  An industry-standard expansion card technology.

extended desktop (n., adj.)  A dual-display mode in which different elements are placed 
on each display, such as images on one screen and tools on the other.

external display  Use only to refer to displays connected to portable computers or to 
computers with a built-in display. For modular computers or unknown configurations, use 
additional display. You can also use external monitor. See also display (n.); monitor.

F
F1, F2, F3…  Function keys on a keyboard. Capitalize the F and use plain (not italic) style 
and arabic numerals. No space between letter and numeral.

Face ID  A face recognition technology used for authentication in some iOS and  
iPadOS devices.

FaceTime  Don’t use as a verb.

failover  One word.

fall detection  An Apple Watch feature. Use lowercase unless referring to an element in  
the interface.

family controls  Don’t use; use parental controls.

family pack  Use lowercase in general references: a family pack. Capitalize in product 
names.

Family Sharing  The iCloud feature. Don’t use iCloud Family Sharing.

The person who sets up the family group is the family organizer; users added to the family 
group are family members.

On first occurrence, refer to the family that’s set up in Family Sharing preferences as the 
family group. Thereafter you can use simply the family, as long as the context makes it 
clear you’re referring to Family Sharing (not to an actual family).

The family organizer sets up Family Sharing and invites people to join 
the family group.

Family members’ purchases are available to the rest of the family.

See also Ask to Buy.

FAQ  Abbreviation for frequently asked questions. FAQ is singular; use the article an. 
Use FAQs to refer to more than one set of frequently asked questions. Use title-style 
capitalization if the full term precedes a noun: the Frequently Asked Questions document. 
For guidelines about spelling out abbreviations, see abbreviations and acronyms.
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Fast Ethernet (100Base-T)  A standard that allows data transmission rates of up to  
100 megabits per second. See also Ethernet; Gigabit Ethernet (1000Base-T).

fast-forward (n., v., adj.)  Note hyphen.

Favorites  Capitalize only when referring to the Favorites feature or to an onscreen element.

With Favorites, you can make a call with a single tap.

To make a contact a favorite…

To add someone to your Favorites list...

fax (n., v., adj.)  Short for facsimile. Use lowercase; fax isn’t an acronym or an 
abbreviation.

FB-DIMM  Short for fully buffered DIMM. Precede FB-DIMM with an, not a. See also  
DIMM; memory.

female  Don’t use to describe a type of connector. Use socket, port, or another term 
appropriate to the context.

Correct: Insert the plug into the socket to ensure a reliable connection.

Incorrect: Insert the male endpoint into the female endpoint to ensure a 
reliable connection.

See also connector; male; mate.

fewer, less  Use fewer for countable items; use less for quantity or bulk.

The fewer devices in your network system, the less cable you need.

Fiber Gigabit Ethernet  Gigabit Ethernet using fiber optic cable. See also Gigabit Ethernet 
(1000Base-T).

fiber optics (n.), fiber optic (adj.)  The adjective isn’t hyphenated (fiber optic cable).

Fibre Channel  A high-speed serial data transmission technology.

field  Use to refer to the boxes (in windows and dialogs, for example) in which users enter 
information. It’s not necessary to specify text field or number field, but if a field has a 
name, try to use it. For example:

Enter the video timecode in the Current Timecode field.

Fill in the required fields, and then click Checkout.

For novice users, text box or number box may be more appropriate. These are OK too, but 
try to be consistent within a document.
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figure captions  Use of figure captions varies by department. Consult your department 
guidelines to determine whether to use them.

• Number and title: Most figure captions include both a figure number and a figure title. 
Unnumbered figures aren’t included in a list of figures and tables. A figure with a 
number must also have a title; a figure with a title generally has a number.

• Title length: Figure titles should be short and to the point; a line and a half should be 
considered the absolute maximum.

• Capitalization: Use sentence-style capitalization for figure titles. Don’t end a title with 
punctuation, even if the figure title is a complete sentence. Use articles in captions 
whenever appropriate.

Correct: The Apple menu

Correct: AirPort Express connected to a printer

Incorrect: AirPort Express Connected to a Printer

• In-text references: Each numbered figure should have an in-text reference to point 
the reader to the figure at the appropriate point. You can use various styles for in-text 
references, depending on the needs of the sentence:

(See Figure 6-2.)

Choose Mail > Mail Preferences (see Figure 6-2).

the Page Setup dialog (Figure 3-13) appears…

the Page Setup dialog, shown in Figure 3-13, appears…

Figure 3-1 shows…

You can use more than one style in a project, but don’t use different styles for what’s 
essentially the same purpose. For example, don’t use both the first and second styles or 
both the third and fourth styles within a project.

figure label  Use to refer to text that accompanies a figure but isn’t connected to the figure 
with a leader line. (Text with a leader line is a callout.) See also callouts.

figures  Line art, photographs, and screenshots are all considered figures. You should 
use figures when their presence will enhance the reader’s understanding or illustrate a 
procedure or point that isn’t evident from the text alone.

file  Refers to any entity stored on a disk, regardless of whether the user can open, edit, or 
print it. See also document.

file format  Refers to a standard that defines a file’s structure and its method of storing 
data. It’s OK to shorten to format if the meaning is clear. In user documentation, don’t use 
to refer to a specific kind of file, such as a JPEG file; use file type.

Images stored using the raw file type have a variety of formats, defined 
by different camera manufacturers.

In documentation for video apps, it’s customary to use format to refer to the type of media.

You can create multicam clips using media with different formats and 
frame rates.

You can set the output format of the shared movie (video and audio, or 
just audio).
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It’s also customary to use format when referring to encoding methods.

The MPEG-2 format encodes MPEG-2 stream files for SD DVD and  
Blu-ray authoring.

See also file types.

file locations  See pathnames.

FileMaker  Note capitalization.

filename  One word.

You can find a document by typing its filename in the search field.

When referring to specific filenames, match the capitalization shown in the interface. In 
user materials, filenames should appear in regular text font; in developer materials, it’s OK 
to use code font.

User materials: Name the file Paperdoc.

Developer materials: The folder contains the CurrencyConverter.
nib file.

filename extensions  When referring to filename extensions, use lowercase and include  
the “dot.”

A filename extension, such as .txt, appears at the end of some 
filenames.

You can use files with the .ics or .jpg extension.

You can shorten filename extension to extension if the meaning is clear, but don’t use  
file extension.

If an article is needed before a filename extension, use the. If the doesn’t work in a 
particular case, assume that dot is pronounced and use a, not an: a .aif extension.

Don’t use filename extensions to refer to file types.

Correct: The image is saved as a JPEG file.

Incorrect: The image is saved as a .jpeg file.

See also file format; file types.

Files app  An app on iPhone, iPad, and iPod touch used to access files stored in iCloud 
Drive or on external devices or servers. In iOS 10 or earlier, the app was called the  
iCloud Drive app.

file server  In user materials, use only when you explain what a file server is (a computer 
that’s dedicated to holding files shared by users on a network). Use shared disk to refer to 
a file server icon on the desktop. See also shared disk.

file sharing (n.), file-sharing (adj.)  Note hyphenation of adjective. Use lowercase unless 
you’re referring to a specific onscreen element that’s capitalized.

Turn on file sharing.

Click the File Sharing icon.

file system (n.), file-system (adj.)  Note hyphenation of adjective.
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File Transfer Protocol  See FTP.

file types  Abbreviations should be in all caps; filename extensions should be in lowercase. 
In most cases, you don’t need to spell out on first occurrence. Use to refer to a specific 
kind of file, such as a JPEG file or a PDF file. Don’t use file format (a file’s structure and 
method of storing data) when you mean file type.

Correct: PNG is a file type popular for web images.

Incorrect: PNG is a file format popular for web images.

When possible, use just file.

The photo is exported as a JPEG file.

For better playback performance, Final Cut Pro transcodes all MP3 
audio files to MOV audio files.

The following table shows the abbreviations and extensions for some common file types.

Abbreviation Extension

AIFF .aif

CAF .caf

DMG .dmg

GIF .gif

JPEG .jpg

MP3 .mp3

PDF .pdf

RTF .rtf

TIFF .tif

WAV, WAVE .wav

See also file format; filename extensions.

Finder  Use the with Finder (exception to the rule to not use the with app names).

firewall  One word.

FireWire  A high-speed industry-standard technology (IEEE 1394) developed by Apple for 
connecting peripheral devices to personal computers.

Products are FireWire equipped, not FireWire enabled. A FireWire cable is described 
according to its connector type, such as a 4-pin-to-6-pin FireWire cable.

firmware  One word.

first person  Don’t use the first-person pronouns we, us, or I; rewrite in terms of the reader 
or the product.

fixed-point (adj.)  Note hyphenation.
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fixed-width (adj.)  Preferred term to describe fonts, such as Courier, in which each 
character takes up the same amount of space on the line. Synonymous with monospaced.

flash  A type of memory or storage with no moving parts. Related terms include flash drive, 
flash memory, and flash storage.

flashing  Don’t use to describe the insertion point; use blinking for this purpose.

flat-blade screwdriver  Note hyphenation.

flat-panel (adj.)  Note hyphenation.

flick (n., v.)  Use only in developer documentation. In user materials, use swipe. See also 
drag; gestures; swipe (n., v.).

floating-point (adj.)  Note hyphenation.

flowchart  One word.

Fn key  Capitalize when you refer to the Fn key on many keyboards. On first occurrence, 
you can say the Fn (Function) key; thereafter, use the Fn key.

folder  An organizational unit, or container, used to organize files and other folders into a 
hierarchical structure known as a file system. In developer materials, folders are usually 
referred to as directories.

Capitalize folder names according to how they’re named and how they appear on the 
screen. Capitalize the word Folder only if it appears in the folder name.

Burn Folder [The word Folder appears in the folder name on the screen.]

Applications folder [The word folder doesn’t appear on the screen.]

Use a user’s [folder name] folder or your [folder name] folder to refer to folders in an 
individual user’s home folder (for example, a user’s Library folder or your Library folder). 
Use the [folder name] folder to refer to folders shared by all users of a computer (for 
example, the Library folder). If there’s risk of confusion about whether the folder you’re 
referring to belongs to a specific user or is shared by all users, you can describe its location: 
the Library folder in your home folder, the Library folder at the top level of the disk.

See also directory; pathnames.

font  In digital typography, a design for a set of characters (for example, Helvetica). Don’t 
use font family, typeface, or face.

You can change the title’s font using the Text inspector.

See also font size; font style.

font size  Not type size. When the meaning is clear, it’s OK to use just size.

font style  Not typestyle or typeface attribute. Refers to one or more attributes such as 
boldface, underline, italic, shadow, and so on. When the meaning is clear, it’s OK to use 
just style.

Fonts window  The systemwide window for selecting fonts, styles, sizes, and other  
text features.
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foot  Note hyphenation when used as an adjective: 3-foot height, 3-foot-high table, but is 
3 feet high. The abbreviation is the same in the singular and the plural. Don’t abbreviate in 
text. Don’t use the symbol ´ unless space limitations prevent the use of foot or ft.

footnotes  See tables.

force click (v.)  Use to describe the act of pressing a Force Touch trackpad until you feel a 
deeper click.

Force click a file’s icon to see a quick preview of the file.

See also click and hold; Force Touch.

force quit  In user materials, it’s preferable to say force an app to quit.

Acceptable: If an app doesn’t respond, you can force quit it.

Preferable: If an app doesn’t respond, you can force it to quit.

Force Touch  A technology used in trackpads and Apple Watch that senses how hard the 
user presses the trackpad or display. A trackpad that uses Force Touch technology is called 
a Force Touch trackpad. Don’t use Force Touch as a verb; use force click or press harder 
(on a trackpad), or press or firmly press (on Apple Watch). See also force click (v.); press.

format (n.)  Refers to the arrangement and appearance of text, graphics, and other 
elements (such as footers) on a page. See also file format.

format (v.)  When you refer to disks, format and initialize mean the same thing.

form factor  Avoid; use design, enclosure, or another term.

Forward button  Use to refer to a button—usually in a toolbar or navigation bar—that lets 
users move forward to the next screen or webpage.

See also right arrow.

forward compatibility  Not future compatibility or upward compatibility.

forward-compatible (adj.)  Note hyphenation.

Forward Delete key  A key that deletes the character to the right of the insertion point.

• Apple keyboards: On the Apple Keyboard with Numeric Keypad, this key is labeled 
delete, and it also has a right-pointing arrow with an x in it. OK to abbreviate as Fwd Del 
if space is tight. Apple keyboards without a numeric keypad don’t have this key.

• Windows keyboards: On Windows keyboards, the equivalent to the Forward Delete key is 
the Delete key; the key that’s equivalent to the Apple Delete key is the Backspace key.
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fps  Abbreviation for frames per second. Include a space between the number and fps:  
24 fps. For guidelines about spelling out abbreviations, see abbreviations and acronyms.

fractions  In user materials, spell out fractions whose denominator is 10 or lower except in 
specification lists, technical appendixes, or tables. For the spelled-out forms, hyphenate 
the fractions: one-tenth, one-fifth, three-fourths.

This app uses one-fifth of available memory.

The other app uses only 1/20 of available memory.

When you express a noninteger greater than 1 in fractional form, use a mixed numeral 
rather than an improper fraction.

Correct: 1 1/6

Incorrect: 7/6

frame buffer  Two words.

frame rate  Two words.

frames per second  See fps.

free  Don’t use to refer to available memory or storage space; use available.

FreeBSD  Note spelling.

freeze  Use to refer to the behavior of a pointer on the screen. Avoid using freeze as  
a noun or to refer to something the computer does. Instead, use a phrase such as  
not responding.

Correct: If the pointer freezes, or if the computer stops responding to 
the mouse, trackpad, or keyboard, follow these instructions.

Incorrect: If the computer freezes, follow these instructions.

Incorrect: If you experience a freeze, follow these instructions.

freeze frame (n.), freeze-frame (adj.)  Note hyphenation of adjective.

You can add a freeze-frame clip to your movie to temporarily stop the 
action onscreen.

frequently asked questions  See FAQ.

front end (n.), front-end (adj.)  Note hyphenation of adjective.

front, frontmost  The active window is the front or frontmost window. See also active;  
in front.

front panel (n.), front-panel (adj.)  Note hyphenation of adjective.



82Apple Style Guide

FTP  Abbreviation for File Transfer Protocol. Avoid as a verb; use transfer files instead. The 
UNIX command ftp is all lowercase. In the term anonymous FTP, the a is lowercase. For 
guidelines about spelling out abbreviations, see abbreviations and acronyms.

Correct: You can use FTP software to transfer files from a remote 
computer to your computer.

Correct: You use the ftp command to transfer files from a remote 
computer to your computer.

Incorrect: You can FTP files from a remote computer to your computer.

full  Use a hyphen in compound adjectives beginning with full.

full-duplex, full-featured, full-height, full-page, full-screen, full-size

Don’t use a hyphen with fully.

fully buffered, fully charged, fully loaded

full-screen (adj.), full screen (pred. adj.)  Note hyphenation of adjective: full-screen 
controls, view full screen. OK to use full-screen window to refer to a window that’s in full-
screen view: This action has no effect on a full-screen window.

functionality  In user materials, avoid if you can use a word such as features instead.

Avoid: Some functionality is not available in certain regions.

Preferable: Some features are not available in certain regions.

Function key  See Fn key.

function keys  The keys on a keyboard labeled F1, F2, F3, and so on. Note that function  
is lowercase.

Fusion Drive  A storage technology consisting of flash storage combined with a high-
capacity hard drive. See also drive.

future tense  Whenever possible, use present, not future, tense. Don’t switch 
unnecessarily from present to future tense when present tense is sufficient to express a 
sequence of steps or events.

• Conditional constructions: Use present tense for conditional constructions such as  
the following:

Correct: If the noWait parameter is true, play from the disk stops 
immediately, and program control returns to the caller.

Incorrect: If the noWait parameter is true, play from the disk will stop 
immediately, and program control will return to the caller.

• Future events: Future tense is sometimes appropriate—for example, when a product 
described isn’t yet available.

Apple will give users a peek at the new app by releasing a public beta.

Next year students at Clareton High School will use EPUB textbooks in 
their math classes.

Fwd Del key  See Forward Delete key.
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G
gallery view  In Finder windows, a way to display and select items as horizontally scrolling 
thumbnails. In the Notes app, a way to display notes in a grid of thumbnails.

Gallery View button  In Finder windows, the rightmost button in the View control.

Also a button in the Notes app for displaying notes as thumbnails.

GB (n., adj.)  Abbreviation for gigabyte. GB equals 10003 bytes in the context of file size or 
storage capacity, and 10243 bytes in the context of computer memory. For guidelines about 
spelling out abbreviations, see abbreviations and acronyms.

• Noun: In the noun form, use a space between the numeral and the abbreviation. Use the 
preposition of before the unit that the value quantifies.

20 GB of memory

320 GB of storage capacity

• Adjective: Don’t hyphenate the adjective form.

a 1 GB SO-DIMM

a 320 GB hard drive

Gbit (n., adj.)  Abbreviation for gigabit. For guidelines about spelling out abbreviations, see 
abbreviations and acronyms.

• Noun: In the noun form, use a space between the numeral and the abbreviation. Use the 
preposition of before the unit that the value quantifies.

10 Gbit of memory

• Adjective: Don’t hyphenate the adjective form.

10 Gbit memory

Gbit/s  Standard international abbreviation for gigabits per second. See also Names and 
unit symbols for units of measure and abbreviations and acronyms.

GB/s  Abbreviation for gigabytes per second. For guidelines about spelling out 
abbreviations, see abbreviations and acronyms. 

gender  See Gender identity; pronouns.

generation  Refers to products that were released at a particular time or that share a 
common design or features. Hyphenate compound adjectives that include the word 
generation: fourth-generation iPad, second-generation processor, previous-generation 
Mac mini. When the generation follows the name, use the numeral: iPad (4th generation). 
Avoid variations that shorten generation, such as seventh-gen and 7G. See also iPad; iPod.

Genius  An Apple Music feature that plays songs that go well together. Genius can be used 
alone (don’t precede with the) or in terms such as the following:

Genius feature, Genius Mix, Genius Playlist, Genius recommendations
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gestures  Don’t refer to touchscreen and trackpad gestures as finger gestures; use  
simply gestures.

When you write instructions that include gestures, in general, don’t include the word finger.

Correct: Swipe left or right.

Incorrect: Swipe your finger left or right.

However, you can refer to fingers if the gesture involves multiple fingers or is complex.

Triple-tap with two fingers.

Touch and hold the object with one finger, and use another finger to 
swipe in the direction you want the object to move.

You can also refer to fingers to provide greater detail when you first define or describe a 
gesture; subsequent occurrences can omit finger.

Defining reference: Pinch two fingers together or apart to zoom out or in.

Other occurrences: Pinch to zoom in on the page.

When describing the act of scrolling through documents and other items, it’s often 
preferable to simply use scroll instead of specific gestures such as drag or swipe.  
See also scroll.

Here’s a list of gestures and their definitions:

• Tap: Quickly touch and release to select a control or item; equivalent to clicking on a Mac.

Tap the song you want to play.

• Drag: Move one finger across the screen or trackpad to scroll through items, drag items 
or controls, or pan around items.

Drag to scroll through your list of songs.

Drag the slider to adjust the brightness.

Drag to see other parts of the map.

• Swipe: Quickly slide one or more fingers across the screen or trackpad to reveal 
controls or to scroll through documents, lists, or groups of items. Implies a less 
controlled motion than dragging.

Swipe over the note and tap Delete.

Swipe left or right to move between dates.

• Pinch: Move two fingers together or apart to zoom out or in.

Pinch to zoom in on the page.



85Apple Style Guide

• Rotate: Use two fingers to rotate images and other items.

Rotate to change the photo’s orientation.

• Touch and hold: Touch the screen or trackpad and hold until something happens (for 
example, the view is magnified, an item becomes editable, or a control appears).

Touch and hold a book, and then drag it to a new position  
on the bookshelf.

Touch and hold a location on the map.

See also drag; pinch (v.); rotate; swipe (n., v.); tap (n., v.); touch and hold.

GHz (n., adj.)  Abbreviation for gigahertz. For guidelines about spelling out abbreviations, 
see abbreviations and acronyms.

• Noun: Use a space between the numeral and the abbreviation.

at a rate of 3.0 GHz

• Adjective: Don’t hyphenate.

a 3.0 GHz processor

GIF  Acronym for Graphics Interchange Format, a bitmapped graphics file format that 
includes data compression. For guidelines about spelling out acronyms, see abbreviations 
and acronyms. See also file format.

gigabit  See Gbit (n., adj.).

Gigabit Ethernet (1000Base-T)  A standard that allows data transmission rates of up 
to 1 gigabit per second (1000 megabits per second). See also Ethernet; Fast Ethernet 
(100Base-T); Fiber Gigabit Ethernet.

gigabits per second  See Gbit/s.

gigabyte  See GB (n., adj.).

gigabytes per second  See GB/s.

gigahertz  See GHz (n., adj.).

glyph  In typography, a distinct visual representation of a character. OK to use when 
referring to the appearance of characters (such as for a particular font) or to explain the 
term in an app’s UI. Otherwise, use character.

In Font Book, you can print a grid with all the glyphs (characters and 
symbols) in a font. To set the glyph size for printing, drag the Glyph 
Size slider.

Use the Keyboard Viewer to see where characters for other languages 
are located on your keyboard.

See also character; font.

GPU  Abbreviation for graphics processing unit. For guidelines about spelling out 
abbreviations, see abbreviations and acronyms. See also graphics card.

Grab  Capitalize when referring to the Grab app. Don’t use as a verb.
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grab point  In iOS, one of a set of movable points around a text selection.

grandfathered, grandfathered in  Don’t use; use an alternative that’s appropriate to the 
context, such as legacy, exempt, or preexisting. Or reword the sentence using you can 
keep, allowed to remain, or similar wording.

Correct: You can keep your plan if you purchased it before  
January 1, 2021.

Incorrect: Your plan is grandfathered in if you purchased it before 
January 1, 2021.

graphical (adj.)  Use to refer to visual art or information.

You can provide a graphical representation, such as a chart or diagram.

See also graphic, graphics (adj.).

graphical user interface  See interface.

graphic, graphics (n.)  Use to refer to one or more computer-generated images used  
for illustration.

Click the graphic you want to add.

Graphics help break up dense text.

Use Motion to build fluid 3D motion graphics for show intros, 
commercials, or title sequences.

See also graphic, graphics (adj.).

graphic, graphics (adj.)  Use graphic to refer to the field of visual communication.

Apple is known for its innovative graphic design.

Use graphics to refer to software or hardware used to process graphics.

You can use advanced graphics software on the Mac.

Several models include integrated graphics processing units.

See also graphic, graphics (n.).

graphics card  Use for the card that controls display of the computer interface on the 
primary display. Not video card. See also GPU.

Graphics Interchange Format  See GIF.

graphics processing unit  See GPU.

gray  Not grey.

grayed  Don’t use; use dimmed.
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grayscale (n., adj.)  One word.

greater-than sign  Use greater-than sign, not greater-than symbol, to describe the > 
symbol. You can also use right angle bracket if appropriate in the context. See also  
angle brackets.

grey  Don’t use; use gray.

grille  Note spelling: grille pitch, speaker grille.

grounded outlet  Not three-prong outlet.

grow box  Don’t use; use resize control.

GUI  Acronym for graphical user interface. Don’t use. Instead, use interface (in user 
materials) or UI (in developer materials).

Guides  Capitalize when referring to Guides offered in the Maps app by Apple and its partners.

You can save Guides, and they’re updated automatically when new 
locations are added.

Use lowercase when referring to guides users create in the Maps app.

You can organize places into your own guides and share them  
with friends.

H
H.264  A video compression standard (or video codec). Also known as MPEG-4 Part 10 and 
AVC (or Advanced Video Coding).

half  Use a hyphen in compound adjectives beginning with half.

half-duplex, half-height, half-hour, half-length

handheld (adj.)  One word.

handle  Use to refer to a small control on the edge of an object that can be dragged to 
move or change the object.

Don’t use drag handle. In apps that have more than one type of handle, you may need 
to describe or name handles (for example, white handle, outer handle, corner handle, 
selection handle, fade handle, trim handle).

Correct: Drag the outer handle away from the center circle.

Correct: To set the direction of the effect, drag the rotation handle.

Incorrect: A drag handle appears on the motion path.

See also grab point.
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hands-free (adj.)  Note hyphenation.

hands-on (adj.)  Note hyphenation.

handicapped  Don’t use to refer to people with disabilities. See also Writing about disability.

hang  Don’t use as a description of the computer’s behavior in response to a system error; 
use a phrase such as not responding.

Correct: If the computer doesn’t respond to input from the mouse, 
trackpad, or keyboard, a system error may have occurred.

Incorrect: If the computer hangs, a system error may have occurred.

See also freeze.

haptic (adj.), haptics (n.)  Refers to technology that uses touch (for example, a tap)  
to give users feedback. In user materials, define haptics on first use.

You can adjust the strength of the wrist taps—or haptics—Apple Watch 
uses for notifications.

Avoid using haptic or haptics when you can reword to describe what the user feels.

Preferable: You feel a tap when your message is sent.

Avoid: You receive a haptic alert when your message is sent.

See also tap (n., v.); Taptic Engine.

Haptic Touch  A technology used in some devices that provides additional features when 
the user touches and holds an item on the screen. See also 3D Touch; Force Touch.

hard copy  Avoid; use a term such as printout, print version, or printed document.

hardcover  One word.

hard disk (n., adj.)  Use to refer to a magnetic disk.

The files are stored on the server’s hard disk.

When referring broadly to computer storage media, which can include solid-state drives 
and flash storage, use just disk or a more general term such as storage device.

You can use Disk Utility to manage internal disks and external  
storage devices.

See also hard drive; storage device.

hard drive  Use to refer to the mechanism that holds a magnetic disk and accesses its 
contents.

You can back up your Mac using an external hard drive.

It’s also OK to use the more formal term hard disk drive, especially in contexts where it’s 
important to be precise.

When referring broadly to computer storage media, which can include other types of 
storage such as solid-state drives and flash storage, use storage device.

You can connect an external storage device to your computer.

See also drive; hard disk (n., adj.).
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hard of hearing  See deaf or hard of hearing, Deaf.

HD (n., adj.)  Abbreviation for high definition (n.) and high-definition (adj.). For guidelines 
about spelling out abbreviations, see abbreviations and acronyms.

HDMI  Abbreviation for High-Definition Multimedia Interface. Related terms include HDMI 
port, HDMI input, HDMI output, HDMI cable, HDMI to HDMI cable, and HDMI to DVI cable. 
For guidelines about spelling out abbreviations, see abbreviations and acronyms. See also 
video input, video input/output, video output (n., adj.).

HDR (n., adj.)  Abbreviation for high dynamic range (n.) and high-dynamic-range (adj.). A 
video or still-image format that allows additional levels of brightness per color component.

See also SDR (n., adj.).

HDV  A format for recording and playback of high-definition video on standard DV cassette 
tapes using a form of MPEG-2 compression. Don’t use HDV to refer in general to high-
definition video. Related terms include the following:

HDV format, HDV standard, HDV video, HDV camera, HDV camcorder

headphone (adj.)  Related terms include headphone jack and headphone port.

heads-up display  See HUD.

hearing impaired  Don’t use. See also deaf or hard of hearing, Deaf; impairment; Writing 
about disability.

heat sink  Two words.

help  Don’t use when referring to documentation that has user guide in its title—even if the 
user guide can be opened from the Help menu.

To view the Safari User Guide, choose Help > Safari Help.

In developer materials, it’s OK to use help and help book when referring to documentation 
delivered in Help Viewer on Mac.

To display help in Help Viewer, you must create and register a help book.

Help button  A button that opens Help Viewer. The standard Help button has a question 
mark graphic.

help tag  Use to refer to the instructional text that appears when the pointer hovers over an 
interface element. Exception: In content for developers, use tooltip instead.

hexadecimal  In user materials, don’t use hex as a short form. In developer materials, hex 
is OK, but spell out hexadecimal on first occurrence. Use a preceding 0x to designate a 
hexadecimal number.



90Apple Style Guide

hexagonal-head screw  Not hex-head screw.

HFS Plus  Not HFS+. The technical name for a file system used to format a disk for use 
with macOS. (HFS stands for hierarchical file system.) Avoid in user materials; use Mac OS 
Extended format instead. See also Mac OS Extended format.

HFS Plus (Journaled)  Not HFS+ (Journaled). Avoid in user materials; use Mac OS 
Extended (Journaled) format instead. See also Mac OS Extended (Journaled) format.

high  Use a hyphen in compound adjectives beginning with high.

high-bandwidth, high-definition, high-level, high-quality, high-
resolution

high bit (n.), high-bit (adj.)  Not hi bit or hi-bit. High bit is an acceptable short form for 
the noun high-order bit.

high definition (n.), high-definition (adj.)  See HD (n., adj.).

high dynamic range (n.), high-dynamic-range (adj.)  See HDR (n., adj.).

highlight (v.)  Don’t use when you mean select.

Correct: Select the text you want to change.

Incorrect: Highlight the text you want to change.

Don’t use as an intransitive verb.

Correct: As you type in the search field, matching icons are highlighted 
in the window below. 

Incorrect: As you type in the search field, matching icons highlight in 
the window below.

See also highlighted (adj.); highlighting (n.); select (v.).

highlighted (adj.)  Not hilighted. Don’t use inverted except in developer materials.  
When explaining highlighting, use a highlighted icon changes color or a highlighted icon  
is filled in.

Correct: When you click the icon, it becomes highlighted.

Incorrect: When you click the icon, it highlights.

Don’t use unhighlighted or dehighlighted for an item that isn’t highlighted; use not 
highlighted.

highlighting (n.)  Don’t use in user materials. OK to use in developer materials.

When an app displays a selection range, it marks the range with 
highlighting.

high-order bit (n.)  Not hi bit or hi-bit. High bit is an acceptable short form.

high resolution (n.), high-resolution (adj.)  Not hi-res. The short form high-res (n., adj.) is 
OK in developer materials or when space constraints don’t allow use of the full phrase (as 
in column headings in tables).
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Hindi  Don’t use when you refer to the writing system used to represent Hindi and several 
other Asian languages; use Devanagari.

hi-res  Don’t use; use high resolution (n.) or high-resolution (adj.). See also high resolution 
(n.), high-resolution (adj.).

hit (n.)  Don’t use when talking about search results. OK to use to refer to webpage visits.

Correct: Search results appear below.

Incorrect: Search hits appear below.

Acceptable: This website gets many hits per day.

Preferable: This website gets many visits per day.

hit (v.)  Don’t use to instruct users to press a key or touch a screen; use press or tap 
instead. See also press; tap (n., v.).

hold down  Don’t use to describe the act of pressing the mouse or trackpad, a key on the 
keyboard, or a mechanical button until an action or result occurs. Use press and hold. See 
also press and hold.

Home button  The physical button on some iOS and iPadOS devices that returns the user 
to the Home Screen. For devices with a Home button, use press to mean pressing the 
Home button once; use double-click or triple-click to mean pressing it more than once.

home folder, home directory  In macOS, a home folder is a folder for a user’s personal use.

Your home folder provides a secure place to keep your documents.

In developer materials, use home directory.

See also directory; folder; pathnames.

homepage  Use to refer to a webpage that serves as the directory or entry point  
to a website. Don’t use landing page or portal. Don’t use homepage to refer to an  
entire website.

Correct: The Apple homepage has links to product information, 
including purchasing options.

Correct: Visit the Apple website for more information about  
Apple products.

Incorrect: You can purchase products on the Apple homepage.

HomePod  In general references, don’t use an article with HomePod. When referring to the 
user’s particular HomePod, it’s OK to use your.

If you need to refer to more than one HomePod, you can use HomePod speakers.

If you have two HomePod speakers in the same room, you can set them 
up as a stereo pair.
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Home Screen  The main screen on iPhone, iPad, iPod touch, or Apple TV, and one of the 
two main screens on Apple Watch (the other is the watch face).

The Home Screen contains icons representing the apps on the device. On some devices, 
users can organize apps on multiple Home Screens.

The Home Screen on Apple TV provides easy access to apps and 
settings.

The dots above the Dock show how many Home Screens you have and 
which one you’re viewing.

home theater (n., adj.)  Note spelling: your home theater, a home theater system.

hostname  One word.

hotspot, hot spot  Use hotspot to refer to a place where users can connect to a public 
wireless network. Use hot spot to refer to the VoiceOver feature or to refer to an area of a 
graphics object, or a section of text, that users can click to activate a function.

You can connect to the internet from public hotspots.

You can use VoiceOver hot spots to mark up to ten items that you want 
to return to later.

A hot spot in a virtual museum scene could link to another room in 
the museum, or the hot spot could allow you to manipulate one of the 
objects in the museum.

hover (v.)  Avoid using hover over to describe the act of holding the pointer over an 
onscreen element until something occurs. Use hold the pointer over or move the pointer  
to instead.

Correct: Hold the pointer over an address, and then click the arrow  
that appears.

Correct: Move the pointer to the right of Auto-Play, click the pop-up 
menu, and then choose an option.

Avoid: Hover over a participant’s name, and then click the More button.

Don’t use hover the pointer over.

See also Hover Text.

Hover Text  Note capitalization. It’s OK to use Hover Text to refer to the accessibility 
feature, but when writing instructions or describing how to use the feature, use alternatives 
like hold the pointer over.

Hover Text makes it easier to view text on the screen.

To use Hover Text, press the Control key and hold the pointer over any text.

See also hover (v.).
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HTML  Abbreviation for Hypertext Markup Language. Use lowercase when the abbreviation 
is part of a URL. For guidelines about spelling out abbreviations, see abbreviations and 
acronyms. 

A file can be in HTML or an HTML file, but it isn’t in HTML format (because HTML isn’t  
a format).

If you know HTML, you can create webpages.

You can find the file at this address: http://www.books.com/classics.html.

See also internet addresses; URL.

HTTP  Abbreviation for Hypertext Transfer Protocol. Use lowercase when the abbreviation 
is part of a URL. For guidelines about spelling out abbreviations, see abbreviations and 
acronyms. See also HTML; internet addresses; URL.

HUD  Acronym for heads-up display, a window for making adjustments and selecting 
options in some apps. Precede HUD with a, not an. Avoid unless the term appears in  
the user interface. For guidelines about spelling out acronyms, see abbreviations  
and acronyms.

humor  Humor can enhance documentation by adding to a reader’s enjoyment and by 
helping to lighten the tone. Humor usually works best in examples, where it’s less likely to 
distract the reader.

Be careful that your humor is in good taste—one reader’s joke can be another reader’s 
insult—and keep in mind that humor may not translate well in localized text.

See also Writing inclusively.

hypertext link  Don’t use; use link. See also link (n.).

Hypertext Markup Language  See HTML.

Hypertext Transfer Protocol  See HTTP.

hyphenation  In general, hyphenate two words that precede and modify a noun as a unit. 
Follow this rule especially when:

• Confusion might result if the hyphen were omitted, as in parameter-list pointer or  
read-only memory.

• The second word is a past or present participle, as in binary-coded decimal or  
color-matching algorithm.

• The two modifiers are a number or a single letter and a noun or a participle, as in 32-bit 
color or D-shaped connector.
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Follow these guidelines for specific cases:

• Units of measure: When you use a spelled-out unit of measure in a compound adjective, 
hyphenate the compound (27-inch screen). When you use an abbreviation or a metric 
unit of measure, including KB, MB, mm, and so on, don’t hyphenate (500 GB hard disk).

• Location compounds: Hyphenate compounds such as lower-left corner, top-right portion.

• Adverbs: Don’t hyphenate compounds with very or with adverbs that end in -ly.

very high speed

recently completed project

• Keyboard shortcuts using combination keystrokes: Use hyphens to signify that the 
first key or keys should be held down while the last key is pressed. (Don’t use hyphens 
if each key should be pressed and released separately.) Make sure you explain this 
convention on first use.

Control-Shift-N

Esc N

See also dash (en).

I
I-beam  Refers to this pointer:

iBooks  Use iBooks to refer to versions of the Apple ebook app released before iOS 12 and 
macOS Mojave. Use Apple Books for versions of the app released with iOS 12 or later and 
macOS Mojave or later. See also Apple Books.

iCloud  Capitalize the C in iCloud in all references to iCloud or the iCloud website  
(iCloud.com). Don’t capitalize the C in email addresses or when giving the URL for  
a particular domain of the iCloud website (icloud.com/calendar).

To sign up for iCloud, go to iCloud.com.

Enter the recipient’s email address (for example, j.appleseed@icloud.com).

In user materials, avoid referring to iCloud as a service; simply call it iCloud. In addition, 
avoid referring to iCloud features (such as iCloud Mail, iCloud Calendar, or Find My) as 
services or web apps; refer to them as features, or simply discuss each feature by its name.
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• In or on: Use in to refer to where content is stored (in iCloud, in iCloud Drive); use on to 
refer to where users can access content (on iCloud.com).

You can store files in iCloud Drive and access them from any device or 
on iCloud.com.

You can say content is in the cloud if the context makes it clear you’re referring  
to iCloud.

With iCloud, you can store all of your content in the cloud and access it 
wherever you go.

• Signing in: To access iCloud features, users sign in with their Apple ID. Don’t use  
sign in to iCloud.

Correct: Your music library is available on all your devices where you’re 
signed in with the same Apple ID.

Incorrect: Your music library is available on all your devices where 
you’re signed in to iCloud.

Exception: Users sign in to or sign out of the iCloud.com website.

Avoid using the term iCloud account.

Correct: If you use iCloud, you can share a reminder list with other 
iCloud users.

Incorrect: If you have an iCloud account, you can share a reminder list 
with other iCloud users.

See also Apple ID.

• What iCloud does: Avoid saying that iCloud syncs content (sync refers to copying 
information directly between two devices). Instead, use alternatives such as keeps up 
to date, updates automatically, and appears automatically. It’s OK to occasionally use 
phrases like iCloud keeps your data in sync.

iCloud keeps your contacts up to date across all your devices.

Music you purchase from the iTunes Store appears automatically on 
your devices.

Avoid using upload or download to refer to the way iCloud keeps content up to date. 
However, you can use upload or download to refer to a one-time transfer of content.

You can download a document from Pages for iCloud to your Mac.

When you turn on iCloud Photos, your photos are uploaded to iCloud.

• iCloud storage: Users upgrade their iCloud storage; they don’t purchase storage or 
increase their storage quota. Don’t use iCloud storage to refer to iCloud (you can store 
your documents in iCloud, not you can store your documents in iCloud storage).

See also iCloud Drive; iCloud Photos; Shared Albums.



96Apple Style Guide

iCloud Drive  An iCloud feature that allows users to store documents in iCloud and access 
them from multiple computers and devices. Documents are stored in iCloud Drive, or saved 
or moved to iCloud Drive.

When you turn on iCloud Drive, documents you’ve already stored in 
iCloud are moved to iCloud Drive.

iPhone, iPad, and iPod touch users access files in iCloud Drive using the Files app. (In 
iOS 10 or earlier, the app was called the iCloud Drive app.)

iCloud Photo Library  Don’t use; use iCloud Photos. See also iCloud Photos.

iCloud Photos  An iCloud feature that stores users’ photos in iCloud and keeps them up to 
date on every device with iCloud Photos turned on. Don’t use iCloud Photo Library, iCloud 
photo library, or your iCloud Photos. You turn on or turn off iCloud Photos. Photos are 
stored in iCloud, not backed up to iCloud Photos. See also iCloud.

iCloud Photo Sharing  Don’t use; use Shared Albums. See also Shared Albums.

iCloud Tabs button  Use to refer to the button users can add to the Safari toolbar.

icon  An onscreen graphic that represents another item, such as a file in a Finder window 
or an album in Photos.

• Icons that don’t act like buttons: If an element in the user interface looks like an icon 
(is a graphic but isn’t enclosed in a rectangular border) and doesn’t act like a button 
(doesn’t initiate an action when clicked or tapped), always call it an icon.
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• Icons that act like buttons: If an element in the user interface looks like an icon (is 
a graphic but isn’t enclosed in a rectangular border) but acts like a button (causes 
something to happen when clicked or tapped), call it a button.

You can also simply refer to it by what it looks like (use lowercase):

Exception: Sometimes app icons act like buttons—for example, icons in the macOS 
Dock or on the iOS Home Screen—but they’re still referred to as icons (Click the System 
Preferences icon in the Dock).

• Unnamed icons: If an icon doesn’t have a label or an established name, describe its 
appearance or function. Use lowercase. If you include an inline graphic of the icon, 
don’t enclose it in parentheses.

The speaker icon  appears next to the song that’s playing.

If an item has a display icon  next to it, it’s a video.

See also button.

icon view  A way to display and select items by viewing them as icons—for example, the 
icon view in Finder windows.

You can view items in Finder windows as icons, in a list, in columns, or 
in gallery view.

Icon View button  The leftmost button in the View control in Finder windows.

i.e.  Don’t use; use that is. See also abbreviations and acronyms.

IEEE  Abbreviation for Institute of Electrical and Electronics Engineers. For guidelines about 
spelling out abbreviations, see abbreviations and acronyms.

if necessary  Avoid in user materials. Instead, describe the circumstance in which the 
action would be necessary.

Correct: If file sharing isn’t on, turn it on.

Incorrect: If necessary, turn on file sharing.

Correct: If the file size is larger than the maximum your mail app allows, 
compress the file.

Incorrect: If necessary, compress the file.
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if, whether  Use if to indicate a condition. Use whether when two outcomes are possible.

If you can mentally introduce the words or not in a clause, use whether rather than if.

Correct: When you start editing a locked file, the app asks whether you 
want to unlock it.

Incorrect: When you start editing a locked file, the app asks if you want 
to unlock it.

Although using if specifies a condition, it can also introduce ambiguity. For instance, Let 
her know if he sets up the user account may mean either Let her know whether he sets up 
the user account or If he sets up the user account, let her know. Ensure that the condition’s 
meaning is clear.

IM  Abbreviation for instant message. Don’t use; use message. See also message.

iMac  The names of iMac models can be used with or without an article.

The iMac makes it easy to set up wireless networking.

iMac is powerful enough for a design studio, production house,  
or science lab.

image  See photo; still image (n.), still-image (adj.).

IMAP  Acronym for Internet Message Access Protocol. Pronounced “eye-map.” For 
guidelines about spelling out acronyms, see abbreviations and acronyms.

imbed  Don’t use; use embed.

iMessage  Apple’s secure messaging service for sending and receiving messages in the 
Messages app. Use only to refer to the service. Users send a message or messages, not an 
iMessage or iMessages.

Correct: You can send messages using iMessage.

Correct: You can turn on iMessage in Messages settings.

Incorrect: If you get an iMessage that looks like spam, you can report it 
to Apple.

See also message.

iMovie  Don’t use iMovie when you mean movie or project.

Correct: You can share your movie on YouTube.

Incorrect: You can share your iMovie on YouTube.

See also movie.

impairment  In general, use disability instead of impairment, or refer to the specific 
disability (blind or low vision, deaf or hard of hearing).

iPhone has many built-in features for people with disabilities.

Switch Control allows users with motor challenges to control devices 
with head or body movements.

See also blind, low vision; deaf or hard of hearing, Deaf; hearing impaired; visually 
impaired; Writing about disability.
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Important  Use an Important notice to alert the reader to significant potential trouble  
spots that don’t cause bodily injury, damage, or loss of data. (Those situations require  
a Warning notice.)

Use Important notices and other notices sparingly; they lose effectiveness if they appear 
too often. Avoid using an Important notice immediately before or after a note, Warning 
notice, or another Important notice, or immediately after a text heading.

See also Note; Warning.

in-app purchase  Note lowercase and hyphenation.

inbox  Capitalize only when referring to an onscreen label; otherwise, use lowercase.

To see the items in your inbox, click Inbox.

inch (in.)  Note hyphenation when used as an adjective: 2-inch height, 1-inch-thin design, 
but is 1 inch thin. Use inch, not inches, for measurements of 1 inch or less: 0.76 inch thin. 
The abbreviation is the same in the singular and the plural. Don’t abbreviate inch in text. 
Don’t use the symbol ˝ unless space limitations prevent the use of inch or in.

inclusive language  See Writing inclusively.

Incorporated, Inc.  Spell out or abbreviate according to the particular corporation’s 
preference.

incrementer  Don’t use to refer to a control that has up and down arrows, or left and right 
arrows, to increase or decrease a value. In user materials, use up arrow, down arrow, 
right arrow, left arrow, or arrows, as appropriate. For example, Click one of the arrows to 
increase or decrease the volume. If it’s necessary to refer to the control itself, use stepper. 
See also stepper.

indeterminate progress bar  In developer materials, the progress bar that has a spinning 
striped cylinder. In user materials, use progress indicator and describe what it looks like.

Developer materials: Use an indeterminate progress bar when the 
duration of a process can’t be determined.

User materials: A progress indicator (a spinning striped cylinder) lets 
you know that a process is taking place.

See also asynchronous progress indicator.

index  Use to refer to the vertical column of letters at the right side of a list in iOS apps. 

indexes  Not indices, unless you mean mathematical indices.

indicator  See progress indicator.

indicator light  Not LED.

industry standard (n.), industry-standard (adj.)  Note hyphenation of adjective: the 
industry standard, an industry-standard video format.

information  Use instead of data in user materials if it makes sense in the context. See  
also data.



100Apple Style Guide

information card  In the Maps app, use to refer to an overlay that provides information 
about a location.

Info window  Not Get Info window or Info box.

infrared  No hyphen.

in front  Use to explain the term active (the active window is in front of other windows); 
subsequently, use active. You can also use to describe windows that “float” on top of 
active windows. See also active; front, frontmost.

initialize  When you refer to disks, initialize and format mean the same thing.

inkjet  One word.

inline  One word.

in order to  Don’t use unless absolutely necessary; use just to.

input (n., adj.)  Avoid using as a verb; instead, use enter or type, depending on the 
context.

Input menu  A menu on the right side of the macOS menu bar that displays information 
about the input language selected in Keyboard preferences and opens keyboard, emoji, 
and symbols viewers. Depending on the settings in Keyboard preferences, the menu icon is 
a flag ( , for example) or a window with a Command key symbol . 

input/output  See I/O.

insertion point  Use to describe the point at which the user types or inserts data.

The vertical blinking bar marks the insertion point.

See also cursor; pointer.

inside  Not inside of.
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inspector  A window that enables users to view the attributes of a document or a  
selected item, and often to modify those attributes. You can refer to the inspector or  
the inspector window.

You can format most elements of your document using the inspector.

You can open multiple inspector windows to work with different aspects 
of your document.

• Capitalization: Capitalize Inspector when it’s a button name or in a menu command.

Click the Inspector button in the toolbar.

Choose Tools > Inspector.

Otherwise, spell with a lowercase i.

Correct: You can add a hyperlink using the inspector.

Incorrect: You can add a hyperlink using the Inspector.

• Panes: When referring to a pane of an inspector, use the [pane name] inspector.

Use the Table inspector to change the row height.

To change the appearance of links, use the Link inspector.

You can also use the [pane name] pane of the inspector (for example, the Table pane of 
the inspector) to introduce the concept of multiple panes in an inspector.

• Inspector buttons: Inspectors with multiple panes typically have buttons that enable 
users to switch between panes. The name of the button should match the name of the 
pane it opens.

Click the Text button to open the Text inspector.

install  You install items on a disk, not onto a disk. Don’t use install as a noun.

installation  Don’t use install when you mean installation.

Correct: Click Download to start the installation process.

Incorrect: Click Download to start the install process.

installer, Installer  Capitalize when you refer to a specific installer app, but not when you 
refer to installers in general.

The iWork Installer app asks you to specify where to install the software.

You can install some apps by dragging them to the Applications folder; 
other apps require an installer.

Instant Hotspot  See Personal Hotspot, Instant Hotspot.

instant message  Don’t use; use message. See also message.

Institute of Electrical and Electronics Engineers  See IEEE.

insure  See ensure, insure.

Integrated Services Digital Network  See ISDN.
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Intel  Use Intel to refer to Intel Corporation or to its processors and other technologies. 
Always use as an adjective except as the company name. Related terms include Intel 
processors, Intel-based Mac computers, Intel-based iMac, Mac with Intel processor, and  
so on. Don’t use terms such as Intel Mac. See also Intel Core; Intel Xeon.

Intel Core  Intel Core refers both to Intel’s Core microarchitecture and to a family of Intel 
processors. Intel Core processors used in Mac computers include the Intel Core m3,  
Intel Core m5, Intel Core i5, and Intel Core i7. You can also use Intel processors, Intel Core 
processors, quad-core Intel Core i5, and so on.

Generally, precede the names with an article. Note the en dash in phrases such as Intel 
Core i5–based Mac. Don’t use terms such as Intel Core Mac. See also dual-core (adj.);  
Intel Xeon.

Intel Xeon  Processors used in Mac computers include the Quad-Core Intel Xeon and 
6-Core Intel Xeon. You can shorten the name to Intel Xeon or Xeon. Use an en dash in 
phrases such as Intel Xeon–based Mac. Don’t use terms such as Intel Xeon Mac. See also 
dual-core (adj.); Intel Core.

interface  OK to use in user materials. Don’t use user interface in user materials.

interface card  Refers to a type of peripheral card that implements an interface to  
other devices.

internal disk drive  Use either internal disk drive or built-in disk drive.

internet, Internet  Use lowercase whether you’re referring to the internet (used by the 
World Wide Web) or an internet (a generic network, or internetwork). Capitalize only in 
proper names, such as Internet Protocol.

Connect your iPhone to the internet by using an available Wi-Fi or 
cellular network.

On Mac, a DNS server converts internet names to IP addresses.

An internet is two or more computer networks that are connected using 
network routers.

See also intranet; web.

internet addresses  An internet address (also called a URL, or Uniform Resource Locator) 
specifies an address on the web or other internet sites, such as FTP sites.

• Use plain text for an internet address. (Developer materials use code font.)

• If the address ends a sentence, use a period.

If you need to break an internet address (for example, in print publications), it’s preferable to:

• Break after a colon (:), a double slash (//), or a slash (/)

www.apple.com/legal/
rfexposure

• Break before any other punctuation mark or symbol

www.energystar
.gov
www.apple.com/batteries/service
-and-recycling

See also URL.
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Internet Message Access Protocol  See IMAP.

Internet Protocol  See IP.

internet service provider  See ISP.

interrupt  OK to use as a noun in developer materials. See also exit; force quit; quit; stop.

into, in to  Use in to when in is part of the verb. Use into to imply motion to the inside  
of something.

Correct: Log in to the computer.

Incorrect: Log into the computer.

Correct: Insert the CD into the optical drive.

See also onto, on to; plug in (v.), plug into (v.).

intranet  A private network, usually owned by a corporation or an institution (your 
company’s intranet). See also internet, Internet.

inverted  Don’t use when you mean highlighted.

invite (v.), invitation (n.)  Don’t use invite as a noun in place of invitation.

invoice  A document issued by a seller to a buyer listing the goods or services supplied and 
stating the sum of money due. If payment hasn’t been made, use invoice and not receipt. 
See also receipt. 

I/O  Abbreviation for input/output. For guidelines about spelling out abbreviations, see 
abbreviations and acronyms.

iOS  The operating system for iPhone, iPod touch, and older iPad models. Use without  
an article.

iOS is the world’s most advanced mobile operating system.

More than a million apps are available for iOS.

iOS 13 introduces new ways to help you protect your privacy.

Some apps have versions that work on multiple platforms. To distinguish between versions 
of an app, use [app name] for [platform].

Learn about the new features of Pages for iOS and iPadOS.

You can add tracks to a song in GarageBand for Mac.

If the context makes it clear which version of an app you’re referring to, you can simply use 
its name.

See also iOS device; iPadOS.
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iOS device  Use to refer generically to mobile devices that use iOS. Avoid using mobile 
device when referring to iOS devices (mobile device could refer to devices made by  
other companies).

You can set up a new iOS device using information from your  
previous device.

In some cases, it’s better to use device names instead of iOS device:

• When it’s important to be specific (for example, to clarify which devices a particular app 
or accessory is compatible with)

You can install iOS 13 on iPhone 6s and later and iPod touch (7th 
generation).

• In any context where it’s friendlier—or clearer—to use the device names

Acceptable: Learn how to back up your iOS or iPadOS device. 

Preferable: Learn how to back up your iPhone, iPad, and iPod touch.

If you list devices by name, list them in the same order throughout a document—for 
example, always iPhone, iPad, and iPod touch. (The order you use might vary depending on 
the product.)

Don’t use iOS device to refer to devices that use iPadOS.

See also iOS; iPadOS; iPadOS device.

IP  Abbreviation for Internet Protocol. For guidelines about spelling out abbreviations,  
see abbreviations and acronyms.

iPad  In general references, don’t use an article with iPad. When referring to the user’s 
particular iPad, it’s OK to use your. The capacity (and generation, if necessary) can be listed 
before or after the name. Use the numeral when the generation comes after the model 
name. Don’t shorten generation to gen or G; for example, fourth-gen iPad or iPad 3G.

If you have iPad mini 3 or later…

The 2 TB iPad Pro offers the most storage capacity.

iPad mini 5 (64 GB and 256 GB) is available for purchase.

The seventh-generation iPad was announced in September 2019.

iPad (7th generation) features a Retina display and the fast  
A10 Fusion chip.

iPadOS  The operating system for newer iPad models. Use without an article.

iPadOS includes features that make your iPad more secure than ever.

Learn about developing apps for iPadOS.

iPadOS 13 provides powerful new multitasking features.
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Some apps have versions that work on multiple platforms. To distinguish between versions 
of an app, use [app name] for [platform].

Learn about the new features of Pages for iOS and iPadOS.

You can add tracks to a song in GarageBand for Mac.

If the context makes it clear which version of an app you’re referring to, you can simply use 
its name.

See also iOS; iOS device.

iPadOS device  Use to refer generically to mobile devices that use iPadOS. Avoid using 
mobile device when referring to iPadOS devices (mobile device could refer to devices 
made by other companies).

Use the Finder to share files between your computer and iPadOS 
device.

You can stream movies from iPadOS devices to Apple TV.

You can simply use iPad instead of iPadOS device if you know that all the devices you’re 
discussing use iPadOS, or if it’s friendlier—or clearer—to use device names.

Acceptable: Learn how to back up your iOS or iPadOS device.

Preferable: Learn how to back up your iPad, iPhone, or iPod touch.

If you list devices by name, list them in the same order throughout a document—for 
example, always iPad, iPhone, and iPod touch. (The order you use might vary depending on 
the product.)

See also iOS; iOS device; iPadOS.

iPhone  In general references, don’t use an article with iPhone. When referring to the 
user’s particular iPhone, it’s OK to use your. The capacity can be listed before or after  
the name.

iPhone supports the most popular email standards.

If you experience problems with your iPhone…

iPhone 12 (64 GB, 128 GB, and 256 GB) includes…

The 64 GB iPhone 12 mini features the A14 processor.

Don’t refer to iPhone as phone for short; always use iPhone or the specific model name 
(iPhone 11, iPhone 12 Pro Max, and so on).

Correct: Tap Level, and then hold iPhone against an object, such as a 
picture frame.

Incorrect: Tap Level, and then hold the phone against an object, such as 
a picture frame.
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When writing the names of iPhone XR, iPhone XS, and iPhone XS Max, use small caps for 
the R and S if your tools let you. If your tools don’t offer small caps, use uppercase R and 
S. Don’t use lowercase.

Preferable: iPhone XR, iPhone XS, iPhone XS Max

Acceptable (in case of tools limitations): iPhone XR, iPhone XS, 
iPhone XS Max

Incorrect: iPhone Xr, iPhone Xs, iPhone Xs Max

The letter X in the model name is pronounced “ten” (for example, “iPhone ten-ess”).

iPod  The current iPod model is iPod touch. (Previous models include iPod classic, 
iPod nano, and iPod shuffle.) Always include iPod in the name; don’t shorten to touch 
alone.

In general references, don’t use an article with iPod touch. When referring to the user’s 
particular iPod touch, it’s OK to use your. The capacity and generation can be listed before 
or after the name: 128 GB iPod touch, iPod touch (128 GB), sixth-generation iPod touch, 
iPod touch (6th generation). Use the numeral when the generation comes after the model 
name. Don’t shorten generation to gen or G; for example, seventh-gen iPod touch or 
iPod touch 7G.

The sixth-generation iPod touch features the Apple A8 chip.

If you experience problems with your iPod touch (7th generation)…

Don’t capitalize touch even in title-style headings: iPod touch, not iPod Touch.

IPsec  Abbreviation for Internet Protocol Security.

IrDA  Abbreviation for Infrared Data Association. For guidelines about spelling out 
abbreviations, see abbreviations and acronyms.

ISDN  Abbreviation for Integrated Services Digital Network. For guidelines about spelling 
out abbreviations, see abbreviations and acronyms.

ISP  Abbreviation for internet service provider; not ISP provider. For guidelines about 
spelling out abbreviations, see abbreviations and acronyms.

italics (n.), italic (adj.)  The noun form is plural.

Use italics to emphasize a word or phrase.

Use italic text to emphasize a word or phrase.

Follow these guidelines for using italics:

• References to document titles: Italicize the entire title.

See the iPhone User Guide.

• Letters as letters, words as words, and phrases as phrases: Italicize.

the i, the o’s

the word restart

the phrase Welcome to iOS 10

But: type Q, press Command-S
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• Emphasis: Use italics to emphasize a word or phrase, but don’t overdo this use  
of italics.

Make sure that the power cable is plugged in and that power is available 
at the outlet.

• Placeholder names: Italicize.

Choose File > Add Files to [app name].

• Terms that stand for or define other terms: Use italics, not quotation marks, for terms 
after stands for, labeled, named, termed, the term, and so on. If the term is an onscreen 
element, however, use plain text for elements whose names are capitalized title style; use 
plain text in quotation marks for elements whose names are capitalized sentence style.

INIT stands for initialize.

A folder named New Folder appears.

Select the checkbox labeled “Keep lines together.”

• Text the user types: Don’t use italics to represent what the user actually types; use 
quotation marks or code font, depending on your department’s style guidelines.

For example, type “dog” in the search field to find photos of dogs.

In the Title field, type Exchange Rate per $1.

• Variables: In code and other technical notation, italicize artificial terms that are to be 
replaced by a value or symbol.

Replace volumeName with a name of up to 12 characters.

See also placeholder names; titles of works; variables.

it’s, its  Don’t confuse it’s (the contraction for it is) with its (a possessive pronoun):  
It’s important for the department to keep track of its computers. See also contractions; 
possessives.

iTunes Gift Card  OK to shorten to card or gift card after the first reference.

iTunes Store  Not iTunes Music Store or iTunes App Store. Music, movies, and other 
features are available in, on, or from the iTunes Store.

Find your favorites in the iTunes Store.

Buy your favorites from the iTunes Store.

After the first reference to the iTunes Store, you can use the full name or simply the store.

iTunes U  An Apple service that schools and other institutions can use to provide free 
educational content on Apple devices.
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J
jack  A small, round, 1-pin socket used in audio and video connections. Don’t use 
connector to refer to a jack. See also connector; port; slot; socket.

jargon  Avoid jargon whenever possible. Define technical terminology on first occurrence.

JavaScript  A scripting language commonly used to add interactive features to webpages.

jiggle  Use jiggle, not wiggle, to describe the movement of app icons on a screen (such as 
the Home Screen of an iPhone) when they’re being rearranged or deleted.

Joint Photographic Experts Group  See JPEG.

JPEG  Acronym for Joint Photographic Experts Group (pronounced “JAY-peg”). JPEG 
usually refers to the image compression standard that this group developed for color and 
grayscale images. It’s not necessary to spell out JPEG on first occurrence.

junk mail (n., adj.)  Use to refer to unwanted mail that users have somehow opted to 
receive (for example, ads from websites where they’ve shopped). In the Mail app and 
iCloud Mail, junk mail refers to all unwanted mail, including unsolicited mail from unknown 
senders (also known as spam).

It’s OK to shorten junk mail to junk when describing how to filter unwanted mail.

To filter junk mail, choose Mail > Preferences, click Junk Mail, and then 
select “Enable junk mail filtering.”

You can mark unwanted mail as junk.

See also spam.

justification  Don’t use to refer to the alignment of text to the right or left margin;  
use alignment. Text that’s aligned on both the right and the left margins is justified.  
See also alignment.

K
K  Don’t use; use KB.

K–12  Note en dash (Option-Hyphen): K–12 education.

KB (n., adj.)  Abbreviation for kilobyte. KB equals 1000 bytes in the context of file size or 
storage capacity, and 1024 bytes in the context of computer memory. For guidelines about 
spelling out abbreviations, see abbreviations and acronyms.

• Noun: In the noun form, use a space between the numeral and the abbreviation. The 
preposition of is necessary before the unit that the value quantifies.

800 KB of memory

• Adjective: Don’t hyphenate the adjective form.

a 687 KB file
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kbit (n., adj.)  Abbreviation for kilobit. For guidelines about spelling out abbreviations, see 
abbreviations and acronyms.

• Noun: In the noun form, use a space between the numeral and the abbreviation. The 
preposition of is necessary before the unit that the value quantifies.

256 kbit of memory

• Adjective: Don’t hyphenate the adjective form.

256 kbit device

kbit/s  Standard international abbreviation for kilobits per second. See also Names and unit 
symbols for units of measure and abbreviations and acronyms.

KB/s  Abbreviation for kilobytes per second. For guidelines about spelling out 
abbreviations, see abbreviations and acronyms.

Kbyte  Don’t use; use KB. See also KB (n., adj.).

Kerberos  A network authentication protocol.

keyboard equivalent  Don’t use; use keyboard shortcut.

keyboard focus  The location where your actions take effect when you use the keyboard. 
When you use VoiceOver, the keyboard focus can be different from where the VoiceOver 
cursor is focused.

keyboard icon  Not script symbol or script icon. Refers to the small icon associated with 
each keyboard layout. These icons are used in the Input menu and the Input Sources pane 
of Keyboard preferences.

keyboard shortcut  Use instead of keyboard equivalent. See also key, keys.

keychain, Keychain Access  A keychain stores certificates and passwords for servers, 
internet resources, and apps. Users create keychains by using the Keychain Access app.

key-down (adj.)  Note hyphenation.

key, keys  You press a key on a keyboard or tap a key on a touchscreen; you type a 
character, word, or phrase.

In general, don’t use articles and the word key in references to keys. Ease the user into this 
construction by using the and key the first time you mention a keystroke.

First occurrence: Press the Control key.

Thereafter: Press Control.

• Modifier keys: Capitalize the names of modifier keys.

Control key, Option key, Shift key, Command key, Esc key

• Punctuation keys and nonalphanumeric keys: When a punctuation key or 
nonalphanumeric key is used in a combination keystroke, or as a modifier for the word 
key, capitalize the key name. (However, use lowercase for punctuation marks and 
nonalphanumeric symbols in other contexts.)

Option-Shift-Hyphen

Press the Hyphen key.

Type a hyphen.



110Apple Style Guide

Placing the punctuation mark or symbol in parentheses after the spelled-out key name 
is optional, but be consistent within a document.

Shift-Command-Tilde (~)

• Keyboard shortcuts using combination keystrokes: In combination keystrokes, use 
hyphens to signify that the user should hold down the first key or keys while pressing 
the last key. Don’t use a hyphen if each key should be pressed and released separately. 
Be sure to explain this convention on first use.

Control-Shift-N

Esc N

Capitalize but don’t italicize or use code font for letters used as key names.

Command-C

Command-X

If there’s more than one modifier key, use this order: Fn (function), Control, Option, 
Shift, Command. When a keyboard shortcut includes a mouse or trackpad action, use 
lowercase for the mouse or trackpad action.

Option-click

Option-swipe with three fingers

• Two-word key names: When referring to more than one key, use the full name of  
each key.

Correct: the Right Arrow or Left Arrow key

Incorrect: the Right or Left Arrow key

• Keys labeled with two characters: When a key with two characters is used in a keyboard 
shortcut, identify the key by the lower of the two characters, unless the Shift key is part 
of the shortcut. If the Shift key is part of the keyboard shortcut, identify the key by the 
upper of the two characters.

Correct: For more information, press Shift-Command-Question Mark.

Incorrect: For more information, press Shift-Command-Slash.

When the Shift key and a key with two characters are in a combination keystroke, 
always show the Shift key as part of the keyboard shortcut (don’t show only the upper 
of the two characters and assume that the user will know to press the Shift key).

Correct: To increase the Loupe diameter, press Option-Shift-Plus Sign.

Incorrect: To increase the Loupe diameter, press Option-Plus Sign.

If one of the characters on the key provides a mnemonic for the action of the command, 
you can identify the key by that character.

To remove keyword presets 1 through 8, press Option-Shift-1, Option-
Shift-2, and so on.
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• Key graphics: With graphic representations of combination keystrokes (in tables, for 
example), use the plus sign (+) instead of a hyphen between keys.

• Escape and Function: Spell out the key names Escape and Function (the Fn key on 
portable computers and wireless keyboards) when you introduce them. In subsequent 
references, it’s OK to abbreviate them as Esc and Fn.

First occurrence: Press the Esc (Escape) key.

Thereafter: Press Esc.

Don’t abbreviate any other key names, except when space is very tight (in table 
headings, for example).

See also specific key names.

keypad  Use keypad or numeric keypad, not numeric keyboard.

keypress  One word.

keystroke  One word.

key-up (adj.)  Note hyphenation.

keyword  Refers to a special word that identifies a particular type of statement or command, 
such as int or while. Follow the capitalization style of the programming language involved.

The term keyword also refers to assigned identifiers in apps such as Photos.

Use keywords to make your photo albums easy to search.

kHz (n., adj.)  Abbreviation for kilohertz. For guidelines about spelling out abbreviations, 
see abbreviations and acronyms.

• Noun: In the noun form, use a space between the numeral and the abbreviation.

at a rate of 44.1 kHz

• Adjective: Don’t hyphenate the adjective form.

a 44.1 kHz rate

kill  Don’t use to refer to stopping an app or process. Use an alternative that conveys  
the correct meaning in context, such as force quit, force exit, terminate, end, stop, halt,  
or cancel.

Correct: Cancel all background tasks.

Incorrect: Kill all background tasks.

If the term kill is used in code you’re documenting and the code can’t be changed, show 
a code sample to make it clear what users need to enter, but use alternative terms in the 
documentation.

The kSecCodeStatusKill flag indicates that the code should be 
terminated if it is ever invalidated.
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kilobit  See kbit (n., adj.).

kilobits per second  See kbit/s.

kilobyte  See KB (n., adj.).

kilobytes per second  See KB/s.

kilohertz  See kHz (n., adj.).

Korea  Don’t use. Specify South Korea or North Korea.

L
L2 cache, L3 cache  See level 2 cache, level 3 cache.

label  See figure label. See also button; capitalization.

labeled, labeling  Not labelled, labelling.

LAN  Acronym for local area network. For guidelines about spelling out acronyms, see 
abbreviations and acronyms.

laptop computer  Avoid in favor of notebook computer, which is preferred, or portable 
computer. See also notebook computer; portable computer.

later  See earlier, later.

latest  Don’t use to refer to a specific software update. Instead, use only the version 
number (or a date, in technical support documents), or use or later to indicate a range  
of updates. It’s OK to use latest if you’re generally instructing users to keep their software 
up to date.

Correct: To use this feature, you must have iPadOS 13.2 or later installed.

Correct: For the best results, make sure you’re using the latest version 
of iPadOS.

See also earlier, later; version number.

launch  Avoid in user materials when you mean to open an app. OK to use in developer 
materials.

Launchpad  Don’t precede Launchpad with the or your.

LCD  Abbreviation for liquid crystal display. For guidelines about spelling out abbreviations, 
see abbreviations and acronyms.

LCI  Abbreviation for liquid contact indicator. Spell out on first occurrence. In subsequent 
references, it’s OK to say LCI or the indicator.

LED  Don’t use in user materials unless you have a specific reason (to distinguish from 
LCD, for example). Use light or indicator light.
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left arrow  Use to refer to a button that looks like a left arrow and lets users navigate 
horizontally through content, such as a category of TV shows in the Apple TV app.

Don’t call it the left arrow button or the left-pointing arrow.

Click the left arrow to view more episodes.

Don’t use when you mean Back button.

See also Back button; Left Arrow key.

Left Arrow key  When you refer to arrow keys generically, use lowercase, but capitalize  
and use the complete name when you refer to one or more arrow keys by name. See also 
arrow keys.

left-hand  Avoid except in reference to left-hand (verso) pages; use just left whenever 
possible.

leftmost  No hyphen.

left side  Not left-hand side.

less, fewer  Use less for quantity or bulk; use fewer for countable items.

The fewer devices in your network system, the less cable you need.

less-than sign  Use less-than sign, not less-than symbol, to describe the < symbol. You 
can also use left angle bracket if appropriate in the context. See also angle brackets.

let  Don’t overuse the phrase lets you in instructions; try to restructure the sentence to 
focus on what the user does.

Avoid: The Up Next button lets you see which songs will play next.

Preferable: Click the Up Next button to see which songs will play next.

It’s OK to use lets you in content that focuses on describing features and their capabilities.

Family Sharing lets you share Apple purchases and subscriptions  
with family.

See also allow; disable (v.), disabled (adj.); enable (v.), enabled (adj.).

letterboxing (n.), letterbox (v., adj.), letterboxed (adj.)  Refers to the black bars placed 
above and below widescreen video to preserve the wide aspect ratio when the video is 
presented in a format with a narrower aspect ratio.

Letterboxing allows the full 16:9 video image to be displayed on  
a standard 4:3 display.

You can letterbox widescreen footage to display it on a standard  
4:3 display.

You can crop the video image to remove the letterbox area (the black 
bars above and below the widescreen image).

See also aspect ratio; pillarboxing (n.), pillarbox (v., adj.), pillarboxed (adj.).
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letters as letters  Italicize a letter when it’s used as a letter.

• Plural: Avoid using the plural; if you must, use an apostrophe and an s to form the plural, 
but don’t italicize the apostrophe or the s.

o’s, p’s, s’s

• Fonts: When you discuss fonts and character formation, using italics for letters as 
letters may be misleading—for example, when you discuss a particular character in 
plain style. In such cases, use quotation marks.

The letter “å” can be converted to “a.”

• Key names: Don’t italicize a letter when you use it as the name of a key.

Press Command-Q.

See also italics (n.), italic (adj.); words as words.

level 2 cache, level 3 cache  Can be abbreviated as L2 cache or L3 cache. Don’t use 
secondary cache or second-level cache when you mean L2 cache.

library  Use lowercase in general references: your music library, the photo library. 
Capitalize the names of interface elements: click Library.

lid  Use this, not clamshell, to refer to the lid of a notebook computer or device case (such 
as an AirPods case).

like (suffix)  Close up words ending with like unless the word is a proper name or a 
compound term, or the resulting word is difficult to read.

businesslike, Ethernet-like, typewriter-like

like, love  Users can like or love an item. Items can have likes, but not loves; instead, refer 
to loved items as items you’ve loved or loved items. Users can dislike a liked or loved item. 
Don't capitalize like or love unless you’re referring to a button in the user interface (for 
example, the Loved button).

Telling Apple Music what you love and dislike improves future 
recommendations.

In News, when you like a topic or channel, related stories appear more 
often in For You.

You can create a Smart Playlist of your loved songs and albums.

To avoid ambiguity, you can also say mark an item as liked, an item is marked as loved,  
or similar.

The album subscriber marked the photo of the Grand Canyon as liked.

limited warranty  Note lowercase.

line breaks  Don’t break a line between Chapter or Appendix and its number or letter; 
between Figure or Table and its number; between slot or port and its number; or between a 
product name and its number. Don’t break a line within an email address or a URL.

line feed (n.), line-feed (adj.)  Note hyphenation of adjective.
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link (n.)  A user clicks a link to go to another page or to perform an action. Avoid using 
follow a link; use click a link instead.

Correct: Click a link on the homepage to go to another page.

Incorrect: Follow the link to the page of your choice.

link (v.)  OK to use when you describe the act of creating a link on a webpage, but don’t 
use link to describe connecting to a webpage.

Correct: When creating a webpage, be sure to link to other interesting 
webpages.

Incorrect: Click the map to link to other pages on the site.

liquid contact indicator  See LCI.

lists (bulleted)  Use a bulleted list when you want to stress the parallelism of a number 
of options, elements, rules, or instructions that need not be presented or performed in a 
particular order.

• Introductory punctuation: Precede all lists with colons, whether the sentence before the 
colon is a complete thought or a partial thought (exception to The Chicago Manual of 
Style). See also colons.

• Capitalization: All list items should start with a capital letter unless the word is a 
product name that begins with a lowercase letter or, in developer materials, is a 
computer literal that begins with a lowercase letter.

• Punctuation within a list: List items that are fragments or that complete the thought 
started by the main clause should not end with a period; list items that are complete 
sentences should end with a period.

• Parallelism: Within a single list, all bulleted items should be parallel.

• A regular sentence broken into a list: This type of list emphasizes the parts of a series. 
The syntax of the sentence is unbroken.

Using the Clock app, you can:

• Check on the time anywhere in the world

• Set an alarm

• Time an event

• Set a timer

• A simple list: The main clause is an independent clause and each bulleted item is a 
sentence fragment.

The kernel environment has five major components:

• Mach

• BSD

• Device drivers and I/OKit

• Networking

• File systems
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• A complex list: The main clause is an independent clause and each bulleted item is a 
complete sentence.

Follow these guidelines for password systems:

• Allow passwords to contain both alphabetic and numeric characters.

• Allow passwords to be as long as is practical.

• Provide a way for the user to verify the password when it’s entered 
or changed.

lists (numbered)  Use a numbered list when you want to stress the sequential nature of 
steps, rules, or instructions. In numbered task lists (steps), each item should be a complete 
sentence. Use sentence-style capitalization for each item and end each item with closing 
punctuation.

Reduce an image’s file size:

1. Choose Tools > Adjust Size.

2. Select “Resample image.”

3. Enter a smaller value in the Resolution field.

list view  A way to display items in a list, with one or more columns of data—for example, 
the list view in Finder windows.

List View button  The button second from the left in the View control in Finder windows.

lithium-ion (adj.)  It’s OK to abbreviate as Li-ion if space is limited. See also batteries.

live link  Don’t use to refer to hypertext links on webpages; use hypertext link or just link.

Live Photos  The feature name. You can also use Live Photos or Live Photo to refer to the 
photos themselves.

Live Photos is turned on by default.

With some models of iPhone, you can take Live Photos.

You can use a Live Photo as the wallpaper for your Lock Screen.

You play or view a Live Photo. Avoid referring to any part of a Live Photo as video. Instead, 
you can use wording such as the moments before and after the photo.

Avoid: If you set a Live Photo as your watch face, the video plays when 
you raise your wrist.

Preferable: If you set a Live Photo as your watch face, it plays when you 
raise your wrist.

Avoid: A Live Photo captures a still image, along with a few moments of 
video before and after it was taken.

Preferable: A Live Photo captures a still image, along with the moments 
just before and after it was taken.
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In instances where a Live Photo might not play, avoid describing the Live Photo as playable 
or not playable; instead, use alternatives such as you see only the still image.

If you drag a Live Photo to a conversation in Messages, only the still 
photo appears.

livestream (n., v.), livestreaming (n.)  Use to refer to media content that’s streamed in  
real time.

Watch the livestream of this year’s Worldwide Developers Conference, 
or stream it on demand on Apple Podcasts.

Apple livestreams the Worldwide Developers Conference each year.

Livestreaming will begin at 10:00 a.m. Pacific daylight time.

If the context makes it clear you’re discussing content that’s streamed in real time, you can 
just use stream.

You can stream lectures to your students and answer their questions in 
real time.

When discussing HTTP Live Streaming, the Apple technology for streaming live content, 
always capitalize Live Streaming and don’t hyphenate (even if a noun immediately follows).

Get HTTP Live Streaming tools from Apple.

Discuss HTTP Live Streaming with Apple engineers and other developers.

See also stream (n., v.), streaming (n., adj.).

lo-bit  Don’t use; use low bit (n.), low-order bit (n.), or low-bit (adj.).

local area network  See LAN.

localizable  Don’t use.

Correct: An app that follows the human interface guidelines should be 
easy to localize.

Incorrect: An app that follows the human interface guidelines should be 
easily localizable.

localization (n., adj.)  Many Apple publications and user materials written in English go 
through the localization process, which involves revision and translation for non-English-
speaking users.

• Idiomatic language: To make the localization process easier, avoid idiomatic phrases 
such as these:

nitty-gritty details

start from scratch

piggy-backing

• Examples and graphics: Avoid examples and graphics that show events or activities 
specific to a particular nation or culture.

• Conciseness: Remember that text length may expand after translation, so keep 
paragraphs short and tight.

See also International style overview; Writing inclusively.
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localize (v.)  Takes the preposition for, not to.

Correct: Whether you localize your app for the French language or for 
French Canada, make sure you test its interface.

Incorrect: Whether you localize your app to the French language or to 
French Canada, make sure you test its interface.

Location Services  The feature name. Singular.

Correct: Make sure Location Services is turned on.

Incorrect: Make sure Location Services are turned on.

lock  Users lock files, apps, or devices; they write-protect their disks. Disks are  
copy-protected by the manufacturer.

Lock Screen  Note capitalization.

logical operators  Don’t use as verbs.

Correct: Using OR to combine x and y produces the result TRUE if either 
one is true or if both are true.

Incorrect: ORing x and y produces the result TRUE if either one is true 
or if both are true.

Correct: The directive uses the logical operator AND to compare the 
accumulator contents with the contents of memory specified by the 
operand.

Incorrect: The directive logically ANDs the accumulator contents with 
the contents of memory specified by the operand.

logic board  Not motherboard, mother board, main board, or main circuit board. You can 
refer to a board as the main logic board if there’s a secondary logic board on the device; 
otherwise, use just logic board.

login items  Apps or files that open automatically when the user logs in. In user materials, 
it’s preferable to use descriptive language (for example, items that open automatically). 
The pane in the Users & Groups pane of System Preferences is named Login Items.

login (n., adj.), log in (v.)  Use to refer to the procedure for starting use of a Mac system 
account. Use log in to, not log into.

Correct: You must log in as an administrator.

Correct: If you turn on automatic login for yourself, your account opens 
when the computer starts up.

Incorrect: You must log into the computer.
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Users log in to a file server (not log on to); users log out of a file server (not log off, log off 
of, or log out from).

Correct: You must log out of the server.

Incorrect: You must log out from the server.

Incorrect: You must log off the server.

Use login window to refer to the window that appears when a new user logs in to macOS.

See also sign-in (n., adj.), sign in (v.).

log on, log off  Don’t use; use log in and log out. See also login (n., adj.), log in (v.).

long press (n.), long-press (adj.)  In developer materials, you can use long press when 
discussing the gesture recognizer that detects when a user touches and holds an  
onscreen item.

To detect a long press, use a long-press gesture recognizer 
(UILongPressGestureRecognizer).

Don’t use long press in user materials. Instead, use press and hold to refer to the act of 
pressing a mechanical button until an action or result occurs; use touch and hold to refer  
to the act of touching a touchscreen and leaving the finger motionless until an action or 
result occurs.

See also press and hold; touch and hold.

look and feel (n.)  No hyphens.

Look Around  The Maps feature that lets users get a street-level view of a location.

lookup (n., adj.), look up (v.)  One word except as a verb.

lo-res  Don’t use; use low resolution (n.) or low-resolution (adj.). See also low resolution (n.), 
low-resolution (adj.).

love  See like, love.

low bit (n.), low-bit (adj.)  Note hyphenation of adjective. Not lo bit or lo-bit. Low bit is an 
acceptable short form of the noun low-order bit.

lowercase (n., adj.)  When you use lowercase in conjunction with uppercase as a noun (or 
to modify a noun), use uppercase and lowercase (both words spelled out, in that order).

low-order bit (n.)  Not lo bit or lo-bit. Low bit is an acceptable short form.

Low Power Mode  A mode on some iOS and iPadOS devices. See also Power Reserve mode.

low resolution (n.), low-resolution (adj.)  Not lo-res. The short form low-res (adj.) is  
OK when space constraints don’t allow use of the full phrase (such as in column headings 
in tables).

low vision  See blind, low vision.
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M
M1 chip  See Apple M1 chip.

Mac  Use Mac to refer to Mac computers and related products (Mac software, Mac apps).

• Articles: Mac is usually preceded by an article or possessive adjective (a Mac, your Mac). 
It’s OK to omit the article in phrases such as for Mac and PC or for Mac, iOS, and iPadOS.

• Plurals and possessives: Because Mac is a trademark, don’t use it in the plural or 
possessive form.

Correct: Mac computers; Mac models; your Mac computer’s screen

Incorrect: Macs; your Mac’s screen

• Generic references: Don’t refer to a Mac computer as a machine, CPU, or PC; 
acceptable alternatives are computer or personal computer.

The following examples show ways to list Mac computers together with other types  
of products:

your Mac, iPad, iPhone, or iPod touch; a Mac, iOS, or iPadOS device; 
your Mac or mobile device; your Mac or PC; Mac computers and PCs

See also device; trademarks (usage).

Macao  Use this spelling, not Macau.

Mac App Store  Apps for the Mac are available in, on, or from the Mac App Store. Precede 
the name with an article in text. Don’t abbreviate as MAS.

Find the item you want on the Mac App Store.

To download macOS Sierra from the Mac App Store, open the App Store 
app on your computer.

After the first reference to the Mac App Store, you can use the full name or simply  
the store. To prevent confusion, avoid using the store if you’re referring to both the  
Mac App Store and the App Store for iOS devices.

See also App Store.

MacBook  The names of MacBook models can be used with or without an article. 

You can install additional memory in the MacBook Pro.

MacBook Air is designed for quick and easy setup.

Mac Catalyst  A feature of Xcode that developers can use to bring iPad apps to Mac as 
native Mac apps. Don’t use Catalyst alone. Developers bring apps to Mac, not to macOS.

Bring your iPad app to Mac with Mac Catalyst.

Don’t use Mac Catalyst as an adjective. For example, don’t describe an app as a Mac 
Catalyst app; say a Mac app created using Mac Catalyst, or similar. Apps don’t run in  
Mac Catalyst; apps are built with Mac Catalyst.

Correct: Mac apps built with Mac Catalyst can use AppKit APIs marked 
as available.

Incorrect: Mac apps running in Mac Catalyst can use AppKit APIs 
marked as available.
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machine  Don’t use when you mean computer.

machine language (n.), machine-language (adj.)  Note hyphenation of adjective.

Macintosh  See Mac.

Mac mini  The name can be used with or without an article.

You can connect digital devices to the Mac mini.

Mac mini delivers unprecedented power in a small package.

Don’t use Mac Mini, even in title-style headings.

Correct: Setting Up Your Mac mini

Incorrect: Setting Up Your Mac Mini

Mac operating systems  In general, use macOS to refer to the Mac operating system.

To reinstall macOS, you must be connected to the internet.

macOS includes apps you’ll use every day.

Don’t use Mac OS to refer generically to the operating system.

Correct: To determine which version of the Mac operating system  
you have…

Incorrect: To determine which version of the Mac OS you have…

Features are in macOS, not on macOS.

Correct: In macOS,  you can…

Incorrect: On macOS, you can…

Mac operating systems have a version name and a version number. If you include both the 
name and the number, place the name first. Don’t place the name in quotation marks, and 
don’t include the word version or the letter v.

To refer to specific versions of the Mac operating system, follow these guidelines, 
depending on the version number:

• 10.12 or later: Use macOS. To refer to a specific version of macOS, you can use its 
name, its version number, or both. Always include macOS.

macOS Sierra
macOS 10.12
macOS Sierra 10.12

• 10.8 through 10.11: Use OS X. To refer to a specific version of OS X, you can use its 
name, its version number, or both. Always include OS X.

OS X El Capitan
OS X 10.11
OS X El Capitan 10.11

• 10.0 through 10.7: Use Mac OS X. Include the version number only.

Correct: Mac OS X 10.7

Incorrect: Mac OS X Lion 10.7
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When referring to a range of OS versions that includes both macOS and earlier versions, 
use the name (or version number) of the earliest version followed by or later.

Correct: To use Handoff, you must have OS X Yosemite 10.10 or later installed.

Incorrect: To use Handoff, you must have macOS Yosemite 10.10 or later 
installed. [Version 10.10 was called OS X, not macOS.]

Exception: If a range of versions includes both macOS and earlier versions, developer 
publications refer to all included versions as macOS.

macOS  See Mac operating systems.

Mac OS  See Mac operating systems.

Mac OS Extended format  A file system used to format a disk for use with macOS. It’s OK 
to define the format parenthetically as HFS Plus on first occurrence (but don’t use HFS+). 
See also HFS Plus.

Mac OS Extended (Journaled) format  A file system used to format a disk for use 
with macOS. It’s OK to define the format parenthetically as Journaled HFS Plus on first 
occurrence, but don’t use HFS+ (Journaled). See also HFS Plus (Journaled).

macOS Server  Use to describe Apple’s server software beginning with macOS 10.12. Use 
only to refer to the software; don’t use to refer to a computer with macOS Server installed. 
Call the computer the server or the server with macOS Server installed.

Correct: You can give users access to the server.

Incorrect: Create a password to make your macOS Server more secure.

When discussing administrative tasks users can do in the Server app, use the Server app. 
When discussing the features or behavior of the server software as a whole, refer to it as 
macOS Server.

macOS Server sends alerts about important server events.

Use the Server app to change which alerts you receive.

When referring to software versions, don’t include the word version or the letter v. In 
developer materials, don’t use version names such as Snow Leopard; use version numbers 
only. To refer to specific versions of the software, follow these guidelines:

• macOS Server (for macOS 10.12 or later): Each version is a separate add-on that may 
work with multiple versions of macOS, so don’t include an operating system name (for 
example, Sierra) when referring to macOS Server; include only a version number.

macOS Server 5.2

• OS X Server (for OS X 10.8 through 10.11): Each version is a separate add-on that may 
work with multiple versions of OS X, so don’t include an operating system name (for 
example, Mavericks) when referring to OS X Server; include only a version number.

OS X Server 5.1

• Mac OS X Server (Mac OS X 10.7 or earlier): You can use the operating system name 
and the version number on first occurrence. Thereafter, it’s OK to use [version name] 
Server. Don’t place the name in quotation marks.

Mac OS X Lion Server 10.7 

Lion Server
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Mac OS X  See Mac operating systems.

Mac OS X Server  See macOS Server.

Mac Pro  Use an article before the name.

Correct: The Mac Pro features four full-length expansion slots.

Incorrect: Mac Pro features four full-length expansion slots.

Mail  Capitalize when referring to the app name: You can use Mail to send and receive 
email. See also iCloud.

mailbox  One word.

mailbox list  The list of mailboxes in the Mail app.

main logic board  See logic board.

main memory  Not central memory.

male  Don’t use to describe a type of connector. Use plug or connector; if you use 
connector, describe the connector by its shape, icon, or other identifying feature.

Correct: Insert the plug into the socket to ensure a reliable connection.

Incorrect: Insert the male endpoint into the female endpoint to ensure a 
reliable connection.

See also connector; female; mate.

Managed Apple ID  Note capitalization. Use to refer to an account created by a business or 
educational institution to allow users to sign in to their devices and access Apple services.

man-in-the-middle attack  Don’t use. Depending on the context, use intermediary attack 
or machine-in-the-middle attack.

manual  Use manual to refer generically to print or PDF documentation that comes with a 
computer or another product. You can also use user manual, user’s manual, or user guide, 
depending on the manual title. 

See the manual that came with your camcorder.

See your user guide for instructions.

• Electronic delivery: If a manual is delivered electronically (for example, as a PDF file 
available from www.apple.com/support), don’t call the manual an electronic manual; 
simply describe it for the user.

The manual is available as a PDF file at www.apple.com/support.

• Cross-references: To refer to documentation that may be either printed or electronic, 
use documentation.

See the documentation that came with your computer.

See also document titles; user guide, user manual.
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master  The term master can have oppressive associations, even when used in a 
technological context. For this reason, avoid using master when referring to the following:

• The default branch of a source repository. Instead, use main branch.

• A system, device, or setting that controls another or that others are subordinate to. 
Instead, use alternatives such as primary, main, global, manager, or host.

• An object or file that serves as a source or basis for others. Instead, use alternatives 
such as source, original, reference, or main.

If none of these alternatives work, you might be able to replace master with another 
term that makes sense in a particular context. For example, you could call objects in the 
background of a document background objects instead of master objects.

See also master branch; master-detail (adj.); master/slave.

master branch  Don’t use to refer to the default branch of a source repository; use  
main branch.

master-detail (adj.)  Don’t use; use list-detail or navigation-detail.

In a navigation-detail interface, the navigation interface displays a 
collection of objects, and the detail interface shows an editor for the 
selected object.

master/slave  Don’t use to describe the relationship between two devices or processes. 
Instead, use an alternative that’s appropriate to the context, such as primary/secondary, 
primary/replica, main/secondary, host/client, or active/standby.

Correct: Anything written on the primary device is given to the 
secondary device as input.

Incorrect: Anything written on the master device is given to the slave 
device as input.

Correct: In a multipeer session, there is no explicit separation of devices 
into host and client roles.

Incorrect: In a multipeer session, there is no explicit separation of 
devices into master and slave roles.

Don’t use alternatives that retain the term master (such as master/helper) or use the term 
worker (such as master/worker).

If the terms master and slave are used in code you’re documenting and the code can’t be 
changed, show a code sample to make it clear what users need to enter, but use alternative 
terms in the documentation.

The primary view controller (MasterViewController) shows the 
available views and controls.

mate  Don’t use to refer to connecting hardware. Use connect.

Correct: Securely connect the cable connectors.

Incorrect: Securely mate the cable connectors.

See also connect.
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maximize  Use to refer to making a window as big as possible without going full screen. 
Don’t use to refer to clicking a window that’s been minimized into the Dock; use make active.

Correct: To maximize a window, Option-click the green button.

Incorrect: To maximize a window, click its icon in the Dock.

Correct: To make a minimized window active, click its icon in the Dock.

See also minimize (v.), minimized (adj.).

maximize button  The rightmost (green) button of the three window controls at the left  
of the title bar. Users click this button to go full screen, or Option-click it to maximize  
the window.

See also maximize.

may, can  See can, might, may.

MB (n., adj.)  Abbreviation for megabyte. MB equals 10002 bytes in the context of file size 
or storage capacity, and 10242 bytes in the context of computer memory. For guidelines 
about spelling out abbreviations, see abbreviations and acronyms.

• Noun: In the noun form, use a space between the numeral and the abbreviation. The 
preposition of is necessary before the unit that the value quantifies.

20 MB of memory

500 MB of storage capacity

• Adjective: Don’t hyphenate the adjective form.

a 3 MB L2 cache

a 4 MB file

Mbit (n., adj.)  Abbreviation for megabit. For guidelines about spelling out abbreviations, 
see abbreviations and acronyms.

• Noun: In the noun form, use a space between the numeral and the abbreviation. The 
preposition of is necessary before the unit that the value quantifies.

10 Mbit of memory

• Adjective: Don’t hyphenate the adjective form.

10 Mbit memory

Mbit/s  Standard international abbreviation for megabits per second. See also Names and 
unit symbols for units of measure and abbreviations and acronyms. 

MB/s  Abbreviation for megabytes per second. For guidelines about spelling out 
abbreviations, see abbreviations and acronyms. 

measurement  See Units of measure overview.
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media, medium  When you describe a method of storing or delivering information, use the 
singular medium or the plural media.

The characteristics of the video storage medium determine playback 
and recording capabilities. [singular]

The guide is presented in both print and electronic media. [plural]

When you discuss video, audio, and still-image content, however, you can use media as a 
singular term to describe a collection of content (for example, a set of video clips).

Your imported media appears as clips in one or more events.

Media Eject key  Note capitalization.

Medical ID  Use with a or your.

In an emergency, you can check someone’s iPhone for a Medical ID.

You can quickly set up your Medical ID in the Health app.

mega (prefix)  Close up words beginning with mega.

megabit, megabyte, megahertz, megapixel, megawatt, megawide

megabit  See Mbit (n., adj.).

megabits per second  See Mbit/s.

megabyte  See MB (n., adj.).

megabytes per second  See MB/s.

megahertz  See MHz (n., adj.).

Memoji  Personalized Animoji that users can create to represent themselves in some apps. 
Use Memoji for both singular and plural.

Add features to a Memoji to bring your character to life.

Create more Memoji to match different moods.

See also Animoji; emoji.

Memories  Capitalize when referring to the feature in Photos. Use lowercase when referring 
to memories that Photos creates.

Use Memories to rediscover favorite photos in your library.

Photos scans your library to create a collection of memories.

memory  A general term for the part of a computer that holds data and instructions for 
use by processors. Memory can refer to random-access memory (RAM), read-only memory 
(ROM), virtual memory, swap files, and portable storage devices (such as flash drives and 
memory sticks), among others.

Use Activity Monitor to see the amount of system memory being used 
on your Mac.

macOS automatically allocates memory and adjusts its contents as needed.

Don’t use memory to refer to storage capacity; use a term such as storage space instead. 
See also storage.
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memory address, memory location  OK to use just address or location for brevity. Don’t 
use commas in addresses, even in numbers of five digits or more.

menu bar  The bar at the top of the Mac screen. The menu bar contains menus for the 
active app (File menu, Edit menu, and so on) and menus for system status icons (icons on 
the right, also called menu bar icons, menu bar status icons, or menu bar items). If you 
need to refer to the menu type, use pull-down menu, not pop-up menu.

Menu button  A physical button on the Siri Remote (called the Apple TV Remote in 
countries or regions where Siri isn’t available for use with Apple TV) and the Apple Remote. 
See also Apple Remote; Apple TV Remote; Siri Remote.

menu names  Note capitalization: Edit menu, File menu, and so on.

menus  Anything that can be chosen in a menu is a menu item; some menu items are also 
menu commands (or simply commands). A menu item is in a menu, not on or under a menu; 
a menu contains items.

In user materials, you can use item or option to refer to menu items that aren’t commands, 
such as names of fonts in a pop-up menu. However, when possible, use a more specific 
term (for example, if a menu contains a choice of colors, say choose a color).

To specify how numbers in a spreadsheet are rounded, click the 
Accuracy pop-up menu, and then choose an option.

To change the size of icon text, click the “Text size” pop-up menu, and 
then choose a size.

• Pull-down menus: A pull-down menu is a menu in the menu bar. When you give 
instructions for choosing an item from a pull-down menu, use the style shown here.

Choose [menu] > [item] > [submenu item].

Choose Edit > Find > Find Next.

Choose File > Save As.

Don’t use an angle bracket when you’re simply identifying which menu contains the item.

Correct: the Page Setup command in the File menu

Incorrect: the File > Page Setup command

Don’t refer to pull-down menus as pop-up menus. In general, refer to them as menus; 
however, if you need to distinguish them from other types of menus, it’s OK to call them 
pull-down menus.

• Pop-up menus: A pop-up menu is a menu in a dialog or window, labeled with up and 
down arrows (or just a down arrow). For pop-up menus, use the style Click the X pop-up 
menu, and then choose Y.

Click the Connection Speed pop-up menu, and then choose Intranet LAN.

Click the Format pop-up menu, and then choose a format.

If the pop-up menu doesn’t have a name, simply call it the pop-up menu.

Click the pop-up menu, and then choose Numeric.
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• Shortcut menus: A shortcut menu is a menu that appears when a user presses the 
Control key and clicks an item on the screen. For shortcut menus, use the style  
shown here.

Control-click the image, and then choose Copy Image from the  
shortcut menu.

If the shortcut menu has submenus, you can use the style shown above, or you can use 
the angle bracket style.

Control-click the images, choose Align Objects from the shortcut menu, 
and then choose Left from the submenu.

Control-click the images, and then choose Align Objects > Left from the 
shortcut menu.

In user materials, don’t refer to a shortcut menu as a contextual menu. However, you 
can refer to the menu parenthetically as a contextual menu on first reference for users 
who may be more familiar with that term.

A shortcut menu (also called a contextual menu) appears.

• Checkmarks in menus: For menu items that are turned on or off by showing or hiding a 
checkmark, use the following language:

To show the library, choose Window > Library so that a checkmark 
appears next to Library.

To hide the library, choose Window > Library so that the checkmark 
disappears.

See also choose; command names; submenus.

message  An electronic communication containing information sent by a computer or 
mobile device. If the context isn’t clear, you can add an adjective to indicate the type of 
message (audio message, email message, MMS message, SMS message, text message, 
video message).

Send a message to your friend.

The Messages app automatically chooses the type of group message  
to send.

Avoid using message as a verb. Instead, use send a message to.

Correct: Send a message to your family.

Incorrect: Message your family.

See also chat (n., v., adj.); text message.

message list  The list of messages in the viewer window in Mail.

metadata  One word.

MHz (n., adj.)  Abbreviation for megahertz. In both the noun and adjective form, use a 
space between the numeral and the abbreviation (don’t hyphenate the adjective form).

at a rate of 800 MHz

an 800 MHz processor

See also abbreviations and acronyms.



129Apple Style Guide

mic (n.)  OK to use as the short form of microphone. Don’t use as a verb; use mike.

After you connect the microphone to the speaker, you might have to 
adjust the mic.

See also mike, miked, miking (v., adj.).

mice  Try to avoid, but if you must use the plural of mouse, it’s OK to use mice or mouse 
devices. See also mouse.

microarchitecture  One word.

micro-DVI  A video output port for connecting external displays and TVs.

microphone  OK to use mic for short. See also mike, miked, miking (v., adj.).

Microsoft Windows  OK to use Windows. Computers that use Microsoft Windows can be 
called Windows-based computers, Windows computers, Windows-based PCs, or Windows 
PCs. See also PC.

MIDI  Acronym for Musical Instrument Digital Interface. For guidelines about spelling out 
acronyms, see abbreviations and acronyms.

mike, miked, miking (v., adj.)  Don’t use mike as a noun; use microphone or mic.

You can change the volume of each miked instrument.

There are three commonly used stereo miking variants used  
in recording.

See also mic (n.).

millimeter (mm)  OK to abbreviate. Note hyphenation when the spelled-out version is used 
as an adjective: 2.4 millimeters, 2.4 mm, 2.4-millimeter slot, 2.4 mm slot.

For film sizes, close up the numeral and the abbreviation: 16mm film.

million instructions per second  See MIPS.

MIME  Acronym for Multipurpose Internet Mail Extension, commonly used to distinguish an 
email format from plain text format. It’s not necessary to spell out on first occurrence. Use 
as an adjective (a MIME file, MIME format).

mini (prefix)  Close up except before a vowel, a proper noun, or an abbreviation.

minicircular connector, minitower

mini-application, mini-DVI, mini-VGA

MiniDV  A digital video format.

mini-DVI  A video output port for connecting external displays and TVs.

minimize (v.), minimized (adj.)  OK to use to describe windows in the Dock.

To put a document in the Dock, click the minimize button.

Document windows in the Dock are minimized.
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minimize button  The middle (yellow) button of the three window controls at the left of the 
title bar. Users click this button to put a window in the Dock (minimize the window).

See also minimize (v.), minimized (adj.).

minus sign  Use minus sign, not minus symbol, to describe this symbol: –. Use an en dash 
(generated by pressing Option-Hyphen) for a minus sign (except in code font, where a 
hyphen is used).

MIPS  Acronym for million instructions per second. Don’t drop the s when you refer 
to a single unit: 1 MIPS, not 1 MIP. For guidelines about spelling out acronyms, see 
abbreviations and acronyms.

mixed-directional (adj.)  Use to refer to a combination of left-to-right and right-to-left text 
within a single line (French and Arabic on one line, for example). See also  
bidirectional (adj.).

M-JPEG  Pronounced “em-jay-peg.” The M stands for motion, and the form Motion-JPEG is 
sometimes used. M-JPEG extends the JPEG standard to video. Not the same as MPEG.

mobile device  OK to use to refer to handheld computing devices such as iPhone, iPad, 
and iPod touch, or to phones and tablets in general.

Numbers is the most innovative spreadsheet app available for a mobile 
device.

When possible, however, use the name of a specific device, or describe the category of 
device: iOS device, iPadOS device. 

See also device.

mobile phone  Use instead of cell phone or cellular phone. Don’t use simply as a synonym 
for iPhone.

mode  In user materials, avoid mode when you refer to software features.

Correct: When you’re using the paintbrush…

Incorrect: When you’re in paintbrush mode…

Correct: Use full-screen view to play your presentation.

Incorrect: Use full-screen mode to play your presentation.

It’s OK to use mode in user materials when you’re discussing hardware—for example, to 
refer to a state that a computer or device is in (such as camera mode, sleep mode, safe 
mode, or target disk mode). However, don’t overuse mode; it can often be omitted with no 
change in meaning.

In developer materials, in references to software, you enter or leave a mode; you don’t turn 
on or turn off a mode.
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model  Don’t use when you can use computer.

Correct: How you use this feature depends on which model of Mac 
computer you have.

Correct: The setup guide that came with your computer provides 
instructions.

Incorrect: The setup guide that came with your model provides 
instructions.

modifier key  Use instead of control key in the generic sense for a key that affects the 
action of other keys, such as the Control, Option, Shift, Command, and Esc keys.

monitor  In general, don’t use to refer to the primary display connected to the user’s 
computer; use display. You can use monitor to refer generically to different kinds of  
display devices that may be connected to a user’s computer (such as a CRT monitor  
or an NTSC monitor).

Connect the display to your Mac Pro.

If you want to show your movie on an external monitor, first connect the 
monitor to your computer.

monitor cable  Not video cable or monitor cord. Use when you refer to cables for displays 
other than Apple displays; otherwise, use display cable. (Use display power cord or monitor 
power cord for the cord that goes from the display or monitor to the power source.) See 
also display cable.

monitor depth  Avoid; use color depth.

monitor port  Not video port. Use to refer to the port to which a monitor is connected. 
Don’t use monitor port to refer to the port to which an Apple display is connected. See also 
display port.

monospaced (adj.)  Not monospace. Fixed-width is the preferred term to describe fonts 
(such as Courier) in which each character takes up the same amount of space.

most recent  See earlier, later; latest; version number.

motherboard  Don’t use; use main logic board or main board.

mount (v.)  In user materials, avoid when referring to making a disk or disk image available; 
use alternatives such as open, make available, or connect to, or describe what the user 
must do to make the disk available.

Avoid: To see the contents of a disk image, you must mount the  
disk image.

Preferable: To see the contents of a disk image, you must open the  
disk image by double-clicking it.

Avoid: Use the Recent Items command to mount servers you’ve  
recently used.

Preferable: Use the Recent Items command to connect to servers 
you’ve recently used.
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In server materials or materials for more technical users, it’s OK to use mount.

To mount the disk again, select it in Disk Utility and click Mount.

Use this function to mount one or more server volumes.

Don’t use mount as an intransitive verb.

Correct: Mount the volume.

Incorrect: The volume mounts.

See also unmount (v.); unmounted (adj.).

mounted (adj.)  In user materials, avoid when referring to a disk or disk image that’s 
available; use alternatives such as available, on your desktop, or in a Finder window. (Note 
that users can choose whether to display disk icons on their desktops, so be careful when 
using on your desktop as an alternative for mounted.)

Avoid: All mounted disks are listed in the sidebar of the Finder window.

Preferable: All available disks are listed in the sidebar of the Finder 
window.

In server materials or materials written for more technical users, it’s OK to use mounted.

You can’t rename a mounted Xsan volume using the Finder.

See also unmount (v.); unmounted (adj.).

mouse  Avoid referring to the mouse when possible. Switch emphasis to the actions on the 
screen, such as clicking, dragging, selecting, or choosing. See also choose; click; drag; 
press; select (v.).

Avoid using the plural form of mouse. If you must use the plural, use either mouse devices 
or mice.

Apple offers several types of mouse devices.

mouse-down event  Note hyphenation.

Mouse Keys  Capitalize when you refer to the feature that can be set in the Accessibility 
pane of System Preferences.

mousepad  One word.

mouse scaling (n.), mouse-scaling (adj.)  Note hyphenation of adjective.

mouse-up event  Note hyphenation.

movie  In general, use to describe commercially produced films or the end product a user 
creates in a video editing app such as iMovie or Final Cut Pro.

You can buy or rent movies in the Apple TV app.

You can publish your completed movie to a website such as YouTube.

See also iMovie; video.
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MP3  Short for MPEG Audio Layer 3, an audio compression technology. The plural is MP3s. 
Don’t use MP3 to refer to audio files in general; some files use AAC or other formats.

MPEG  Acronym for Moving Picture Experts Group, a working group of the International 
Standards Organization (ISO). The acronym is pronounced “em-peg.” It’s not necessary to 
spell out on first occurrence.

MPEG usually refers to the family of digital video compression standards that the group 
developed. There are three major versions: MPEG-1, MPEG-2, and MPEG-4. MPEG-4 is 
based on the QuickTime file format and defines standards for video and audio streaming.

There’s no MPEG-3. Note that MP3 is short for MPEG Audio Layer 3, not MPEG-3.

MPEG Audio Layer 3  See MP3.

multi (prefix)  Close up except before i.

multiplayer, multiprocessor, multitasking, multithreading, multiuser

multi-item

multicore  Use to refer to processors that have more than one core.

multiple scan (adj.)  No hyphen.

multiplication sign  Not multiplication symbol.

multiprocessing, multiprocessor  A multiprocessor computer has multiple processors, not 
multiprocessors.

Multipurpose Internet Mail Extension  See MIME. 

Multi-Touch  Refers to the Apple touchscreen interface. Related terms include Multi-Touch 
display, Multi-Touch interface, Multi-Touch technology, Multi-Touch trackpad, and  
Multi-Touch gestures.

Music  See Apple Music.

Musical Instrument Digital Interface  See MIDI.

Mute key  Note capitalization.

My Photo Stream  The iCloud feature. You turn on or turn off My Photo Stream.

Don’t use the term photo stream generically to refer to the photos in My Photo Stream; 
always use the full feature name.

Correct: You can see the photos in My Photo Stream on all your devices.

Incorrect: You can see the photos in your photo stream on all your devices.

Use My Photo Stream album to refer to the album where photos are stored on a device  
or in an app.

When My Photo Stream is turned on, you can see your most recent 
photos in the My Photo Stream album.

See also iCloud Photos.
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N
name server  Two words.

narrowband  One word.

native  In user materials, avoid using native to describe apps; instead, describe the apps as 
being designed to work with specific hardware or software.

For best performance, use an app designed for use on Intel-based  
Mac computers.

network  Computers are on, not in, a network.

network time server  Note lowercase.

new  In most documents, avoid describing a product or feature as new because the text 
will quickly become out of date. When appropriate, state the version of software in which a 
feature was introduced.

Correct: Auto Unlock, introduced with macOS Sierra 10.12…

Incorrect: The new Auto Unlock feature…

News  See Apple News.

newsgroup  One word.

nickel-metal-hydride  Abbreviated NiMH. See also batteries.

non (prefix)  Close up except before a proper noun, a proper adjective, an abbreviation, or 
an acronym, or when the resulting word would be difficult to read.

noncompliant, nondestructive, nonstandard

non-Apple, non-Mac, non-USB

See also prefixes.

nonsexist language  See Writing inclusively.

nonstartup disk  Avoid when possible. Instead, use a disk that doesn’t contain system 
software or another appropriate phrase.

normal installation  Not normal install. Users perform a normal installation; they don’t do a 
normal install. See also custom installation.

normal user  See standard user.

Note  Use the Note tag for information that’s relevant to a topic but that may not apply to 
all readers. You can also use a note for a bit of information that’s tangential to a topic.

Use notes and other notices sparingly. They lose their effectiveness if they appear too 
often. Don’t use a Note tag immediately before or after a Warning notice, an Important 
notice, or another note, or immediately after a text heading.

See also Important; Warning.
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notebook computer  The preferred generic term for Apple portable computers. It’s OK 
to use notebook alone occasionally if the meaning is clear. You can also use portable 
computer, but when you refer to a specific model (such as MacBook Air or MacBook Pro), 
it’s best to use the model name.

See also laptop computer; portable computer.

Notification Center  Don’t precede with the.

To open Notification Center, click the date and time in the menu bar.

number  If space is limited, abbreviate as no. See also number sign.

numbers  Spell out the following numbers:

• Cardinal numbers from one through nine. Use a numeral, no matter how small, to 
express numbers as numbers and as units of measure.

You can use your purchases on up to five computers.

For example, if you have four new messages, the number  appears on 
the app icon.

• Ordinal numbers from zero through nine.

You can install drives in the second, third, and fourth drive bays.

• Numbers that appear at the beginning of a sentence. (Try to rephrase to avoid starting a 
sentence with a number.)

Correct: Two hundred fifty functions are available in the Function 
Browser.

Preferable: The Function Browser gives you access to 250 functions.

• A number that appears next to another number, if it helps readability.

There are sixteen 32-bit registers.

Use numerals:

• To refer to numbers as numbers.

The numeral  occurs eight times.

• To refer to a specific address, bit, byte, chapter, field, key, pin, sector, slot, or track, or 
when expressing amounts of memory.

Open the ejectors on slots 1, 2, and 3.

8-pin minicircular connector

Your Mac Pro comes with a minimum of 16 GB of memory.

• To form ordinal numbers larger than nine (add st, nd, rd, or th to the numeral as 
appropriate).

• For numbers of the same category within a paragraph, if any number is larger than nine.

We have 25 computers and 4 printers on the network. [Computers and 
printers are the same category.]

There are two kinds of 32-bit registers. [Kinds of registers and bits are 
different categories.]



136Apple Style Guide

• For units of measure, including units of time, no matter how small the number is. For a 
list of units of measure, see Names and unit symbols for units of measure.

Set the timer for 3 minutes.

Beats 1 is a worldwide radio station that’s available 24 hours a day,  
7 days a week.

You can’t set paragraph margins of less than 1 inch.

If you increase the clip’s speed to 200 percent, Final Cut Pro removes 
frames and the clip plays back in only 2.5 seconds.

• To express an approximation.

Cocoa includes definitions for more than 250 additional classes.

Follow these additional guidelines for numbers:

• Ranges of numbers: Use an en dash between numbers that represent the endpoints of a 
continuous range: bits 3–17. Use the full concluding number in a range of numbers.

Correct: 2013–2019

Incorrect: 2013–19

• Commas: Use a comma to set off numbers of five digits or more. (If your editor has 
asked you to follow international style, see Decimals.)

1024

65,536

Don’t use a comma in memory addresses or in numbers representing microprocessors.

$FFFF FFFF

68020 microprocessor

• Plural: Form the plural of a number by adding an s.

1s and 5s

the ’90s

• Software version numbers: When you refer to software version numbers, use later and 
earlier. For example, macOS 10.13 or later. See also version number.

• Code values in text: Use numerals for numeric values in text except for zero in the same 
sentence as nonzero.

ord(blue) returns 0.

The function fseek returns nonzero for improper seeks; otherwise, it 
returns zero.

• Large numbers: For very large numbers that are a power of 2, you can use the exponential 
form to avoid a long string of digits—for example, 232. Numbers larger than 65,536 (216) 
are good candidates for showing in exponential form. If there are numbers larger and 
smaller than 65,536 in the same discussion, show the smaller numbers both ways.

x must be between 1024 (210) and 232.

See also fractions.
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number sign  Use to describe this character: #. Don’t use pound sign or number symbol. 
Avoid using the number sign to specify an item in a numbered series.

You can frequently omit number or the number sign from a sentence and still make the 
meaning clear.

See document 58677 for more information.

Use part 661-2262 to repair the computer.

numeric (adj.)  Not numerical, except when you refer specifically to numerical order. 
(Exception to American Heritage.) See also numerics (n., adj.).

numeric keypad  Can be shortened to keypad. Don’t use numerical keypad or numeric 
keyboard.

numerics (n., adj.)  As a noun, numerics takes a singular verb. Use numerics (not numeric) 
as an adjective in relation to the science of numerics: numerics capabilities, numerics 
environment.

NVIDIA  Note spelling.

O
offline  Use to describe a device or account that’s not connected to the internet or a 
network. Be sure the context makes it clear what offline means.

If your email account is offline (not connected to the internet), you can’t 
send or receive mail.

In informal contexts, it’s OK to describe people as being offline, but use a more specific 
term if necessary for clarity.

Acceptable: If you want to go offline for a while, turn on Do Not Disturb.

Acceptable: You can read your saved articles at any time—even when 
you’re offline.

Preferable: You can read your saved articles at any time—even when 
you’re not connected to the internet.

See also online.

offscreen (adj., adv.)  One word.

offsite  One word.

OK  Not okay.

onboard (adj., v.), on board (pred. adj.)  In computing, onboard (short for on the board) 
refers to components attached to a circuit board or logic board. Use built in (as in built-in 
graphics card) or internal unless you need to make clear that a component is attached to a 
board.

In internal communications, it’s OK to use onboard as a verb: Onboard your new employee. 
Use two words when on board is an adjective following a verb: Make sure your employee is 
on board. Don’t use onboard as a verb in user materials.
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once  Don’t use when you mean after.

Correct: After you turn on the computer…

Incorrect: Once you turn on the computer…

one-click (adj.)  OK to use to refer to actions or functions that are very simple.

From one-click fixes to detailed editing, there are a number of tools 
available in Photos.

Don’t use 1-Click.

online  One word. Use to describe content or services that are available on the internet or 
a network.

Some books contain online content, which is stored on the web, not in 
the book file.

Safari keeps your information secure when you shop online.

In informal contexts, it’s OK to describe people as being online, but in most cases use a 
more specific term (for example, signed in or connected to the internet).

Acceptable: Follow these tips to keep your kids safe when  
they’re online.

Correct: To use Siri, you must have an internet connection.

Incorrect: To use Siri, you must be online.

You can refer to devices as online if the context makes it clear what that means.

Correct: You can locate your Mac if it’s online—awake and connected to 
a Wi-Fi network.

Incorrect: You can locate your Mac if it’s online.

See also offline.

on/off switch  Not on/off button.

onscreen (adj., adv.)  One word.

onsite  One word.

on-the-go playlist  Note hyphens.

onto, on to  Use on to when on is part of the verb.

Correct: Hang on to the handles.

Correct: Lift the printer onto the table.

Incorrect: Lift the printer on to the table.

See also into, in to.

open  Users open icons, folders, documents, and apps. See also close.

opening display  Not splash screen. Opening display, startup display, and startup screen 
are all OK.

open source (n., adj.)  No hyphen.
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operating system (n.), operating-system (adj.)  Note hyphenation of adjective. See also 
iOS; Mac operating systems; tvOS; watchOS.

optical disc  CDs and DVDs are optical discs. OK to use optical disc, optical media, or the 
type of CD or DVD. See also CD; DVD.

optical drive  Use instead of CD drive or DVD drive to refer generally to drives that read 
from and write to (burn) optical discs (CDs and DVDs). Exception: Refer specifically to 
SuperDrive when appropriate. See also SuperDrive.

optionally  Avoid in user materials. Instead, describe the reason the user would perform 
the action. If it’s important to emphasize that the action is optional, you can say If you  
want to…

Correct: If you want to set a disk quota, enter the number and specify 
megabytes (MB) or gigabytes (GB).

Incorrect: Optionally, enter a disk quota and specify megabytes (MB) or 
gigabytes (GB).

Correct: To set a trust level, enter the command in Terminal.

Incorrect: Optionally, set the trust level by entering the command  
in Terminal.

Option-click (v.)  Equivalent to press the Option key while you click.

To add a Bezier point, Option-click the path.

See also key, keys.

Option-drag (v.)  Equivalent to press and hold the Option key while you drag.

To copy a bookmark, Option-drag it.

See also key, keys.

Option key  To refer to the action of pressing the Option key while performing a mouse or 
trackpad action, use Option-click or Option-drag. See also Alt key.

option names  For options and other onscreen elements of two or more words whose 
names are capitalized using sentence style, use quotation marks in text to avoid misreading.

Select the checkbox labeled “Keep lines together.”

OS X  See Mac operating systems.

OS X Server  See macOS Server.

outbox  One word.

outline font  Not outlined font.

output (n., adj.)  Avoid as a verb; use write to, display on, print on, or print to.

outside  Not outside of.

over  Don’t use when you mean more than.

Correct: You can add more than 1000 songs.

Incorrect: You can add over 1000 songs.
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P
page  See homepage; webpage.

pair, paired  You pair a device with another device, not to.

To use Apple Watch, pair it with iPhone.

Use paired iPhone, not companion iPhone, to refer to the iPhone that an Apple Watch is 
paired with. Use paired Apple Watch to refer to an Apple Watch that has been paired with 
an iPhone.

PAL  Acronym for Phase Alternating Line, a European color video standard. For guidelines 
about spelling out acronyms, see abbreviations and acronyms.

pane  In user materials, use pane (not panel) to refer to an area within a window or dialog 
that can be changed by clicking a button: the Input pane of Sound preferences.

In many cases, you can avoid using pane by describing how to get to a particular onscreen 
item: Open System Preferences, click Sound, and then click Input. It’s OK to refer to a pane 
within a pane.

See also tab.

panel  Don’t use in user materials; use dialog, window, or pane.

In developer materials, use panel in most contexts because Panel appears in the 
names of programming symbols—for example, SFChooseIdentityPanel and 
SFCertificatePanel. When, however, the panel is seen by the developer as a user  
sees it—such as when giving instructions for using developer apps—use the appropriate 
user term.

See also dialog; pane; window.

parental controls  Don’t use family controls.

parenthesis (sing.), parentheses (pl.)  Note different spelling of singular and plural. See 
also punctuation.

parts  Most documents don’t need to be divided into parts; division into chapters is usually 
sufficient. A good candidate for division into parts is a document that describes two or 
more separate products or a document that’s so long that division into parts is necessary 
to make the organization clearer to the reader.

• Part titles: Documents are divided into parts when each part deals with a distinct topic. 
Part titles indicate that difference in subject matter.

• Part numbers: Roman numerals are usually used for part numbers, but your 
department’s design style may specify arabic numerals.

• Chapter numbering: In a document with parts, chapter numbering continues 
uninterrupted from part to part.

• Cross-references: In references to specific parts of a document, italicize the document 
title but not the word Part, the part number, or the part title. Enclose the part title in 
quotation marks.

passcode  See code, passcode.
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passive voice  Avoid when possible and use active voice. Passive voice is sometimes 
appropriate and necessary—for example, when using the active voice would require either 
a highly convoluted sentence structure or excessive anthropomorphism—but rewrite to 
avoid passive voice if you can.

In tutorials, a passive construction might be appropriate to avoid miscuing the reader—that 
is, when you describe an action that the user isn’t supposed to try yet.

Explanation screen: An icon is selected by clicking it.

User-try screen: You try it. Click the icon.

passkey  Avoid in user materials. Use code, passcode, or password, depending on the 
context. See also code, passcode; password.

passphrase  Avoid in user materials. Use passcode or password, depending on the context. 
See also code, passcode; password.

password  Use to refer to a sequence of characters a user enters to gain access to a 
protected resource. Don’t use when you mean code or passcode. See also code, passcode.

pasteboard  Don’t use in user materials when you mean Clipboard. OK to use in developer 
materials that discuss the NSPasteboard class, but point out that users view the contents 
of the pasteboard in the Clipboard.

pathnames  Follow these guidelines to specify the path to a location in the file system:

• Absolute path: An absolute path describes the location of an item starting at the top 
level, or root, of the user’s file system. In user materials, describe such paths in  
plain English.

Open TextEdit, located in the Applications folder at the top level of  
the computer.

Fonts for all users are stored in the Fonts folder in the Library folder at 
the top level of the internal disk.

For more technical audiences (for example, users who are accustomed to the pathname 
conventions used in operating systems such as macOS and UNIX), you can use slashes 
(including a leading slash) to indicate an absolute path. (In developer materials, 
pathnames are in code font.)

Fonts for all users are stored in /Library/Fonts/.

You can also use slashes in user materials if the path goes more than two folders deep 
from the top level of the file system.

Place the file in the /System/Library/Keychains/ folder.

• Relative path: If there’s no leading slash, the path is a relative path—that is, relative to 
some location other than the root folder.

Make sure the file is in Library/Application Support.
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• Home folder: In user materials, use your to indicate that the item being described is in 
the user’s home folder. Use plain English (no slashes) to describe folders that are just 
one or two levels deep.

Your files are saved in your Documents folder.

Your fonts are located in the Fonts folder in your Library folder.

If the folders go more than two levels deep, you can use slashes to avoid awkward 
construction and wordiness. (Don’t use a leading slash, because that would indicate 
that the starting point is at the top level of the startup disk, not the user’s home folder.)

Copy the file to Library/Application Support/Address Book/ in your  
home folder.

For more technical audiences, you can use a tilde (~) to specify a path within the user’s 
home folder.

The files are saved in ~/Documents.

Copy the file to ~/Library/Application Support/Address Book.

You can also use an absolute path with the word username in italics.

Each user’s files are saved in /Users/username/Documents.

• Terminating slash: A terminating slash indicates that the final element of the path is a 
folder rather than a file. You can choose whether or not to use a terminating slash, but 
be consistent within a document.

You can find the files you’ve downloaded in ~/Library/Mail Downloads/.

See also code font; home folder, home directory.

PB (n., adj.)  Abbreviation for petabyte. PB equals 10005 bytes in the context of file size or 
storage capacity, and 10245 bytes in the context of computer memory. For guidelines about 
spelling out abbreviations, see abbreviations and acronyms. 

• Noun: In the noun form, use a space between the numeral and the abbreviation. The 
preposition of is necessary before the unit that the value quantifies.

1.6 PB of memory

1 PB of data

• Adjective: Don’t hyphenate the adjective form.

1.6 PB RAM module

4 PB multiserver system

PC  Avoid PC when you refer to Apple personal computers. Use personal computer or 
computer. It’s OK to use PC, Windows-based PC, or Windows PC to refer to non-Apple 
personal computers.

QuickTime is available for both Mac computers and Windows-based PCs.

You can share Mac files with a PC on a wireless network.

See also Microsoft Windows.
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P-code  Stands for pseudocode.

PDF  Abbreviation for Portable Document Format. Not necessary to spell out on first 
occurrence. Use to refer to a PDF file.

You can add effects to PDFs in Preview.

Open the PDF files that you want to combine.

See also file types.

pencil  See Apple Pencil.

percent  Always preceded by a numeral, no matter how small the value.

1 percent

• Percent symbol: It’s OK to use the percent symbol (%) instead of the word percent in 
technical appendixes, specification lists, and tables, or when the word must appear so 
many times in a text passage that its use becomes cumbersome.

• Nonspecific quantities: When you describe a nonspecific quantity, use percentage, as in 
a small percentage of the population.

periods  See ellipsis.

peripheral  A device that can be connected to a computer. Peripheral devices include 
printers, scanners, disk drives, modems, displays, and keyboards. OK to use peripheral 
device, peripheral, or device. The adjective is singular: peripheral manufacturer, peripheral 
connections.

peripheral card  Not accessory card. When appropriate, use the more specific term 
interface card.

Personal Hotspot, Instant Hotspot  Personal Hotspot refers to sharing the internet 
connection of an iOS or iPadOS device with other devices or computers. Capitalize when 
referring to either the feature or a hotspot created by a user.

When Personal Hotspot is on, other devices can connect to your 
Personal Hotspot using Wi-Fi.

Instant Hotspot refers to sharing a device’s Personal Hotspot with other devices where the 
user is signed in with the same Apple ID. In general, use Instant Hotspot only as a feature 
name—don’t use to refer to an individual hotspot.

Correct: With Instant Hotspot, you can quickly connect to your Personal 
Hotspot without entering a password.

Incorrect: You can quickly connect to your Instant Hotspot without 
entering a password.

petabyte  See PB (n., adj.).

Phillips screw, Phillips screwdriver  Note spelling. Not Phillips-head screw or Phillips-
head screwdriver.

phone numbers  See telephone numbers.



144Apple Style Guide

photo  The primary term for photographic images. Don’t use photograph.

You can use Photos to view, edit, and share your photos.

You can also refer to photos as images (especially when discussing a photo’s appearance 
or content), pictures, or shots.

You can crop a photo to remove parts of the image.

The image appears darker where the adjustment is applied.

Taking a picture using a flash can result in red pupils in people’s eyes.

Create a slideshow to showcase your best shots.

See also snapshot.

Photo Stream  Don’t use. See also My Photo Stream.

picker  Don’t use the term picker in user materials to describe how to select a color or a 
date. Instead, describe what users must do, describing the part of the interface where a 
task is done, if it’s helpful.

Correct: Select a color in the Colors window.

Correct: The left side of the color well shows colors that match the 
theme; the color wheel opens the Colors window, where you can choose 
any color.

Correct: To set a date, tap + or – for the unit (month, day, hour, and so 
on) you want to change.

Incorrect: Select a color in the color picker.

See also Colors window; color well.

picture  OK to use as a synonym for photo and in standard phrases such as desktop 
picture and profile picture. See also photo.

Picture in Picture (n., adj.), picture-in-picture (adj.)  Use Picture in Picture to refer to the 
feature that lets users view a movie in one portion of the screen while doing other tasks.

To stop playing a movie using Picture in Picture, click .

You can drag the Picture in Picture window to any corner of the screen.

In general references to the capability of playing a smaller video within a larger area, you 
can use picture-in-picture.

Select the clip you want to use as a picture-in-picture clip.

In documents where you use Picture in Picture or picture-in-picture frequently, you can 
use the abbreviation PiP after the first occurrence.
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pillarboxing (n.), pillarbox (v., adj.), pillarboxed (adj.)  Refers to the black bars placed 
at the sides of video to preserve the original aspect ratio when the video is presented in a 
format with a wider aspect ratio.

Pillarboxing allows 4:3 video to be displayed in a widescreen format.

You can pillarbox video with a 4:3 aspect ratio to display it in a 
widescreen format.

You can crop the video image to remove the pillarbox area (the black 
bars at the sides of the image).

See also aspect ratio; letterboxing (n.), letterbox (v., adj.), letterboxed (adj.).

pin (n., v.)  Use the noun pin to refer to an item that marks a location on a map.

Use the verb pin to refer to saving an item for later use—such as pinning a website to  
the tab bar in Safari, pinning a location in Maps, or pinning a Siri search result to 
Notification Center.

PIN  Acronym for personal identification number. When discussing iOS or iPadOS devices, 
use only to refer to the PIN used to unlock a SIM card. See also code, passcode.

pinch (v.)  Refers to the act of placing two fingers on a touchscreen or trackpad and then 
moving them closer together or farther apart.

Pinch the photo to zoom in or out.

In most cases you can use just pinch, but if you need to describe the motion in more detail, 
you can use pinch open to describe moving the fingers apart and pinch closed for moving 
the fingers together. (Note that developer materials use pinch close.)

See also gestures.

Pinned Sites  Capitalize when referring to the feature in Safari; use lowercase when 
referring generically to sites the user pinned.

With Pinned Sites, you can keep your favorite websites handy.

Your pinned sites appear at the left end of the tab bar.

Avoid referring to pinned sites as pinned tabs unless you need to refer to the tab itself.

To unpin a site, drag the pinned tab to the right side of the tab bar.

pixel  Short for picture element, the basic element of a digital image or display. A pixel is 
made of dots (also called subpixels). There are usually three dots per pixel: a red, a green, 
and a blue.

Width is measured in square pixels.

Express pixels using numerals.

640 x 360 pixels

See also bit (n., adj.); dot (n.).
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placeholder names  When referring to interface text that varies depending on the context, 
use italic, lowercase text enclosed in brackets (don’t italicize the brackets).

Choose File > [filename].

Choose File > Export To > [submenu item].

Select the “Show last [numeral] photos” checkbox.

Don’t use brackets with placeholders in pathnames and filenames.

Users/username/Library/

The file is saved as filename.apmetadata.

See also pathnames; variables.

playback (n., adj.), play back (v.)  One word except as a verb.

player  Don’t use the with the full name of a product whose name includes Player, unless 
the product name is used as an adjective modifying a noun.

Correct: Use QuickTime Player to view the movie.

Correct: Open the QuickTime Player app.

Incorrect: Open the QuickTime Player.

playhead  One word.

playlist  Use lowercase in general references: Create a playlist. Capitalize in feature names: 
Genius Playlist, Smart Playlist.

please  Avoid using please in instructional text and cross-references.

Correct: Follow the steps below.

Incorrect: Please follow the steps below.

Correct: For more information, see “Store Settings” on page 96.

Incorrect: For more information, please see “Store Settings” on page 96.

plug  Not male connector. See also connector.

plug and play (v., pred. adj.), plug-and-play (adj.)  Note hyphenation of adjective.

plug-in (n.)  Always hyphenate, unless you’re quoting text (such as a product name or 
interface text) that doesn’t contain a hyphen.

Use plug-ins to extend the capabilities of Safari.

In text that uses title-style capitalization, use lowercase for the i in Plug-in (exception to 
the rule that you capitalize the second word in a hyphenated compound).

Installing and Removing Plug-ins

plug in (v.), plug into (v.)  Use when you refer to the specific act of plugging a connector 
into a port or an outlet. For example, a power cord plugs into an electrical outlet; you can 
plug a USB connector into a USB port. See also connect; connector; into, in to.
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plurals  Follow these guidelines for plurals:

• Acronyms and abbreviations: To form the plural of an acronym or an abbreviation, add 
an s but no apostrophe.

CDs, DVDs

• Adjectives: Don’t add an s to an adjective unless necessary. For example, it’s electronic 
circuit but electronics engineer. Other words that fall into this class of adjectives are 
graphic and graphics, communication and communications, numeric and numerics.

• Letters and symbols: To form the plural of a letter or symbol, add an apostrophe and an s.

p’s, +’s

• Numbers: Form the plural of numbers by adding an s.

1s, 1930s

• Nouns: Don’t use (s) to indicate that a noun can be either singular or plural. To refer to 
both the singular and plural forms, spell them out; if possible, rewrite to avoid either 
construction.

Acceptable: initializing your disk or disks

Preferable: initializing disks

Incorrect: initializing your disk(s)

• Trademarked product names: Form the plural of trademarked product names by adding 
the plural generic noun to the singular product name.

Correct: Mac computers, MacBook Pro computers, iMac computers

Incorrect: Macs, MacBook Pros, iMacs

If a product name includes a generic noun as well as a trademarked adjective, form the 
plural as you would with any noun.

AirPort Cards, AppleCare Service Parts Kits

• Words as words: Form the plural of a word italicized to show that it’s used as a word by 
adding an apostrophe and an s. Don’t italicize the apostrophe or the s.

He had too many and’s in the sentence.

plus sign  Not plus symbol.

p.m.  Note periods: 6:30 p.m. Use a space before the abbreviation.

podcast, podcasting (n., v., adj.)  A podcast is a free show, similar to a radio or TV show, 
that users can download and play. You can refer to podcasts using either podcast or show. 
A podcast consists of one or more episodes; a podcast with multiple episodes is called  
a series.

Search for any podcast by name.

Discover the most popular shows using Top Charts.

When you subscribe to a podcast, you get new episodes as  
they’re released.

Use italics to refer to the title of a podcast; use quotation marks for the titles of episodes.
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point (n., adj.)  Use only when writing about font sizes. Don’t use as a synonym for dot or 
to describe a place or spot on the screen. Express points using numerals.

Body text should be at least 12 points.

point (v.)  When you describe the desktop interface, avoid using point as a verb. Instead, 
use move the pointer to or similar wording.

Avoid: Point to an item to see a description of what you can do with it.

Preferable: Hold the pointer over an item to see a description of what 
you can do with it.

pointer  In most cases, you can refer to the arrow pointer as simply the pointer. Don’t  
use cursor.

The Finder and some apps have different kinds of pointers depending on what the user is 
doing (for example, the crosshair pointer or the I-beam pointer).

Use a specific name for a pointer only if you need to distinguish between different types of 
pointers—for example, in tasks where the pointer changes to a different shape.

Drag the crosshair pointer over the area you want to capture.

See also cursor; insertion point.

point of presence  See POP.

POP  Acronym for point of presence (access point to the internet) and Post Office Protocol. 
When used as an acronym for Post Office Protocol, POP must modify a noun (as in POP 
server or POP ID). For guidelines about spelling out acronyms, see abbreviations and 
acronyms.

popover  Don’t use in user materials; instead, simply describe what the user must select 
or do. If necessary, you can use in the list that appears or similar wording. Don’t call it a 
dialog or window.

Correct: Tap Print.

Incorrect: Tap Print in the popover.

Correct: Scroll to the bottom of the list of messages and tap Load  
More Messages.

Incorrect: Scroll to the bottom of the popover and tap Load More 
Messages.

pop-up (n., adj.)  When referring to ads or unsolicited notices that open from a browser 
window, it’s preferred to use pop-up as an adjective (pop-up ads, pop-up window). 
However, in headings and other places where space is a consideration, or in content where 
you have to use the term repeatedly, it’s OK to use pop-up as a short form of the noun.

You can prevent websites from displaying pop-ups.

Don’t use pop-up to refer to a pop-up menu; always use pop-up menu.
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pop-up menu  See menus.

port  Use to refer to a location for passing data in and out of a computer or device. Don’t 
use connector to refer to a port. See also connector; jack; slot; socket.

portable computer  An alternative to notebook computer. Avoid using portable as a noun, 
except in informal contexts. The terms notebook computer and notebook are generally 
preferred for Apple portable computers. See also laptop computer; notebook computer.

Portable Document Format  See PDF.

possessives  Follow these guidelines for possessives:

• Singular nouns: Form the possessive of a singular noun, including one that ends in s, by 
adding an apostrophe and an s.

the device’s dock connector

the boss’s husband

• Plural nouns: Form the possessive of a plural noun that ends in s by adding an 
apostrophe. Form the possessive of a plural noun that doesn’t end in s by adding an 
apostrophe and an s.

the students’ curriculum

children’s requirements

• Proper nouns or names: Form the possessive of a singular proper noun or proper name, 
including one that ends in s, by adding an apostrophe and an s. Form the possessive of 
a plural proper noun or proper name by adding an apostrophe.

Susan Torres’s biography [singular]

the Joneses’ computer [plural]

• Product names: Rewrite to avoid forming a possessive of any product name, trademarked 
or not (for example, don’t use Keynote’s slides). See also trademarks (usage).

post (prefix)  Close up except before a proper noun or a date.

postgraduate, postmortem, posttest

post-WWDC event, post-2017

Exception: post-production

post (v.)  OK to use post to or post on when referring to publishing something on the 
internet or another network.

Post Office Protocol  See POP.

pound sign  Don’t use; use number sign for this character: #. See also number sign.

power adapter  Lowercase except in product names: 60W MagSafe Power Adapter. Avoid 
AC adapter.

power button  The button on a computer or display used to turn the computer or display 
on or off. See also power switch.

power cord  Not power cable.
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power-down (n., adj.), power down (v.)  Don’t use in user materials; use turn off or shut 
down. See also shutdown (n., adj.), shut down (v.); turn on, turn off.

Power Nap  Not PowerNap.

power off (v.)  Don’t use in user materials; use shut down or turn off.  See also shutdown 
(n., adj.), shut down (v.); turn on, turn off.

power on (v.)  Don’t use in user materials; use turn on.  See also turn on, turn off.

power-on light  Note hyphenation.

power port  Note lowercase.

Power Reserve mode  A mode on Apple Watch. See also Low Power Mode.

power switch  OK to use when you’re not sure what kind of power control a device has. 
See also power button.

power-up (n., adj.), power up (v.)  Don’t use in user materials; use turn on or start up.

PRAM  Acronym for parameter random-access memory. Pronounced “PEA-ram.” For 
guidelines about spelling out acronyms, see abbreviations and acronyms.

pre (prefix)  Close up except before a proper noun or a date.

preinstalled, preexisting, preproduction

pre-WWDC event, pre-2019

Exception: pre-order

predictive text  Use to refer to the iOS and macOS feature that predicts the next 
word users will type and offers suggested words or emoji. Use typing suggestions or 
suggestions to refer to what users see and select on the screen (in iOS) or in the Touch Bar 
(in macOS).

preface  Depending on your department’s guidelines, you may use a preface to tell the 
reader about the document, to describe conventions such as special notation (for example, 
code font), and to outline what the reader will find where. Discussion of the product 
itself usually belongs in the document text, not in the preface, although it’s sometimes 
appropriate to include introductory information about the product in the preface.

A preface should have a title, such as “About This Guide” or “Introduction.” When you refer 
to a document’s preface, use the full preface title.

See the preface, “About This Guide.”

If your department template includes the word Preface, you may instead refer to it as  
the preface.

preferences  When discussing System Preferences (in macOS), you can shorten the name 
of each set of system preferences to [preference name] preferences, as in Accessibility 
preferences (note lowercase preferences). When discussing preferences for any app, use 
lowercase for preferences (but always capitalize the name System Preferences).

Use the Trackpad pane of System Preferences to set the tracking speed.

Use Sound preferences to change volume settings.

Use the Privacy pane of Safari preferences to block website cookies.
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prefixes  In most cases, close up prefixes (such as multi, non, post, and pre) with the 
following word. Exceptions:

• Compounds that contain proper nouns (non-Apple)

• Compounds with double i’s or double a’s (anti-inflammatory, meta-analysis)

• Compounds that are homographs or could be misread (re-cover)

• Compounds with double prefixes (sub-subentry)

• Compounds that contain a compound term (non-self-sustaining)

See The Chicago Manual of Style for more examples.

preinstalled, preloaded  Avoid. Say installed, loaded, included, or other wording when 
possible.

prepositions  It’s OK to end a sentence with a preposition, especially when rewriting would 
produce a stiff-sounding phrase.

Play a trailer you’re working on.

Select the playlist you want to add songs to.

preset (n., adj.)  Use to refer to a group of customized settings an app provides or the 
user saves for reuse.

In most cases you can use the default settings, but you can also choose 
a preset you saved from a previous print job.

To share a preset, copy the preset file to another computer.

See also default (n., adj.).

press  Use to describe the act of pressing and quickly releasing keys on the keyboard and 
mechanical buttons and switches. Don’t use click, hit, push, tap, or type. 

Correct: Press the Return key.

Correct: Press the power button.

Incorrect: Type your password and hit the Return key.

• On a Mac: Don’t use press to refer to onscreen items; use click, force click, or click  
and hold.

Correct: Click and hold an icon in the Dock until a menu appears.

Correct: Force click an address to see it on a map.

Incorrect: Press an icon in the Dock until a menu appears.

However, you can use press when giving instructions for using the accelerator feature 
of a Force Touch trackpad. (In such cases, users aren’t pressing an onscreen item; it’s 
implied that they’re pressing the trackpad.)

Click and hold the Next button; press harder to increase the speed.

Start drawing a line, and then press harder to make the line thicker.

See also click and hold; force click (v.).
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• On Apple Watch: Use firmly press to describe pressing the display. Don’t use hard press.

While viewing the watch face, firmly press the display.

Note that with Apple Watch, users press the display while viewing items on the screen; 
with iOS and iPadOS devices, users press items on the screen.

• Press versus press and hold: Don’t use press when you mean press and hold, unless the 
sentence makes it clear that the user needs to press continuously.

Correct: Press and hold the C key while you restart the computer.

Correct: Press the side button until the Power Reserve slider appears.

Incorrect: Press the C key and restart the computer. [It’s not clear that 
the user needs to keep pressing.]

See also press and hold.

• Don’t say press and drag; simply say drag.

See also click; enter; tap (n., v.); type (v.).

press and hold  Use press and hold (not hold down) to describe the act of pressing the 
mouse or trackpad, a key on the keyboard, or a mechanical button until a specified action 
or result occurs.

Don’t use press and hold when you mean press, which means to press and quickly release 
a key or mechanical button.

Correct: To restart your Mac, press and hold the power button.

Incorrect: To restart your Mac, press the power button.

Don’t use press and hold when you mean click and hold. Click and hold refers to using the 
mouse or trackpad to interact with onscreen items; press and hold refers to interacting 
with the physical mouse or trackpad itself.

Click the Next button to go to the next clip, or click and hold the Next 
button to fast-forward.

Drag refers to the act of positioning the pointer, pressing and holding 
the mouse, moving the mouse, and then releasing.

See also click and hold; press; touch and hold.

print (v.)  Not print out.

printed circuit board (n., adj.)  No hyphen.

printout (n.)  One word.

print out (v.)  Don’t use; use print.

print server  Two words.
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problem  Don’t use in phrases such as this is a known problem or this version fixes that 
problem. Use condition, issue, or situation. It’s OK to use problem in a general way, such as 
the following:

If you have a problem registering, try again in a few moments.

processor  Synonymous with microprocessor for Apple products. In user materials, the 
simpler processor is preferred. See also CPU.

product  Use to refer generically to items customers can get from Apple, including 
hardware, software, and services.

To get support for your Apple product, go to support.apple.com.

Apple products are intuitive and easy to use.

Don’t use product in materials that discuss using and working with a specific device, such 
as a Mac or Apple Watch. Instead, use the name of the device or an acceptable short 
form—for example, computer instead of Mac, or watch instead of Apple Watch.

Acceptable: Slide the computer out of the rack.

Preferable: Slide the Mac Pro out of the rack.

Incorrect: Slide the product out of the rack.

See also device.

product names  Follow the capitalization style of the official product name. Don’t capitalize 
words like card and driver unless they’re part of the product name. Don’t use quotation 
marks around product names.

• The company name: Use the company name (Apple) with the product at its first use in 
both the preface and main text to establish ownership of the product. Thereafter, it’s 
OK to drop the name of the company.

• Possessives: In general, avoid forming possessives of product names, whether or not 
the names are trademarked. For example, avoid AirPort Card’s features (AirPort Card 
isn’t trademarked).

See also plurals; trademarks (usage).

professional  Don’t shorten to pro.

program  See app, application, program.

progress indicator  The generic term for an onscreen element that lets users know a 
process is taking place.

https://support.apple.com
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In developer materials, use asynchronous progress indicator for the spinning gear, 
determinate progress bar for the bar that has a fill that moves left to right, and 
indeterminate progress bar for the spinning striped cylinder.

If you have to mention a progress indicator in user materials, use the generic term and 
describe it.

A progress indicator (looks like a spinning gear) appears.

A progress indicator (a moving bar) shows the status of the download.

A progress indicator (a spinning striped cylinder) lets you know that a 
process is taking place.

See also asynchronous progress indicator; determinate progress bar; indeterminate 
progress bar; spinning wait cursor.

prompt (n., v., adj.)  Avoid using prompt as a verb if you can simply tell users to do 
something, or if you can use friendlier wording such as when asked or you may be asked.

Avoid: Double-click the side button, and then enter your passcode when 
prompted.

Preferable: Double-click the side button, and then enter your passcode.

If you do use prompt, don’t make hardware or software the actor; instead, use passive voice.

Correct: If you select Image, you’re prompted to select an image file.

Incorrect: If you select Image, the app prompts you to select an image file.

It’s OK to use prompt as a noun or an adjective when referring to the prompt character in a 
command-line interface.

At the prompt, enter resetpassword and press Return.

You can change the prompt character from a bracket to a flashing gray bar.

pronouns  When referring to individuals of unspecified gender, don’t use gender-specific 
pronouns (he, his, him, she, her, hers) or combinations of gender-specific pronouns  
(he or she, he/she, s/he). Instead, it’s OK to use they, their, or them as a singular,  
gender-neutral pronoun.

Correct: A subscriber can post their recipes to your shared folder.

Incorrect: A subscriber can post his or her recipes to your shared folder.

They always takes a plural verb, even when used as a singular pronoun.

Each person keeps the items they purchase using the family organizer’s 
account, even if the organizer stops Family Sharing.

You can also rewrite a sentence to avoid gender-specific pronouns. For example, you could 
use the plural form of the noun (Subscribers can post their recipes to your shared folder), 
or omit the pronoun altogether (A subscriber can post recipes to your shared folder).

See also Writing inclusively.
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pronunciation  If the pronunciation of an acronym isn’t self-evident, provide a 
pronunciation key.

Use all caps for the stressed syllable; use a hyphen between syllables. Enclose the 
phonetic spelling in quotation marks.

WYSIWYG (pronounced “WIZ-zee-wig”)

This style guide provides pronunciation keys for many acronyms. Don’t invent your own 
pronunciation key unless this guide doesn’t show the pronunciation. Consult your editor.

propeller  Use Command key, not propeller key, to refer to the key with the  symbol. See 
also Command key.

protocol  When the word is part of the name of a protocol, capitalize Protocol.

Name Binding Protocol (NBP)

File Transfer Protocol (FTP)

When you use protocol as a generic term, use lowercase.

standard internet protocols

• Third-party products: When you refer to protocol names in third-party products, 
capitalize according to the third-party company’s style.

• Articles: Use an article before the spelled-out name of the protocol. Don’t use an article 
before the abbreviation when it stands alone.

The Name Binding Protocol resides at the transport layer of the 
reference model.

A protocol like NBP resides at the transport layer of the reference 
model.

pull-down (adj.)  To refer to methods of converting film or video frame rates, use 
pulldown. See also menus.

punctuation  Punctuation marks should be in the same type style and font as the main 
body text, except for punctuation that belongs to a title in a different font.

This address, called a vector, directs program control to a specified 
destination. [The second comma isn’t italicized.] 

See What is Motion? for more information. [The question mark  
is italicized.]
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Note the following:

• Punctuation in code font: Punctuation following code font in running text should be in 
the font of the overall sentence, not in code font, unless the punctuation mark is part 
of what actually appears on the screen or in the code listing. Avoid punctuation after 
something the user should type. (The user may type the punctuation.)

• Parentheses, brackets, and quotation marks: Parentheses, brackets, and quotation 
marks (“paired punctuation”) should be in the same style as the body text. For example, 
the parentheses around an italicized word should be in plain style, not italics.

Read the manual (iPhone User Guide). [The parentheses aren’t italicized.]

• Plurals: When you form the plural of an italicized letter used as a letter, a number used 
as a number, or a word used as a word, don’t use italics for the apostrophe or the s.

Enter a series of D’s. [The apostrophe and s aren’t italicized.]

See also apostrophes; commas; dash (em); dash (en); ellipsis; hyphenation; quotation marks.

push  Don’t use to refer to the act of pressing a button or a key on a keyboard; use press. 
See also press.

Don’t use push when discussing services (such as iCloud) that send content to devices 
automatically; instead, say content appears automatically or is updated.

iCloud updates your photos on all your devices.

pushpin  One word.

put  Don’t use when you mean drag.

Correct: Drag the file to the Trash.

Incorrect: Put the file in the Trash.

Q
quad  Hyphenate compound adjectives beginning with quad.

quad-band, quad-channel, quad-core, quad-port

quality  Don’t use quality alone as an adjective; include a modifier. The compound 
adjective is hyphenated.

broadcast-quality, high-quality, professional-quality

question-mark button  Don’t use; use Help button.

Quick Look  Capitalize when you refer to the feature in macOS. Don’t use quick look as  
a verb.

quick reference card  No hyphen.

QuickTime Player  Don’t precede with the.

Open QuickTime Player.
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quit  Use quit to refer to stopping an app from running completely. Don’t use exit, exit 
from, or leave when you mean quit. See also close; force quit; interrupt; stop.

quotation marks  Use curly opening and closing quotation marks except in code font. Don’t 
use single or double quotation marks for units of measure; use the prime symbol for feet 
(Option-Shift-E) and the double prime symbol for inches (Option-Shift-G).

• With periods and commas: Put periods and commas within quotation marks. If 
necessary for clarity, periods and commas can go outside, as in AN$ = "1". 

• With other punctuation: Semicolons, colons, question marks, and exclamation points go 
outside quotation marks unless they’re part of an actual quotation.

• Four-character identifiers: When you give the name of four-character identifiers such as 
file types, use straight, single quotation marks in code font and place any punctuation 
outside the quotation marks.

Examples of file types are 'TEXT', 'PICT', and 'APPL'.

• Terminology: Use quotation marks, not quote marks or quotes. (Quote is a verb; 
quotation is a noun or an adjective.)

• Cross-references and quotations: Cross-references to sections and chapter titles 
are traditionally set off in quotation marks (unless they are hyperlinks); follow your 
department’s style. Use quotation marks for direct quotations.

• Onscreen messages: Enclose quotations from the screen, such as alert messages, in 
quotation marks.

• Terms that stand for or define other terms: Use italics, not quotation marks, for terms 
after called, known as, labeled, stands for, termed, and so on. Use plain style for 
onscreen elements whose names are in title-style capitalization.

A folder called My Files appears.

• Text the user types: Use quotation marks or code font to represent what the user 
actually types, depending on your department’s style guidelines.

For example, type “dog” in the search field to find photos of dogs.

In the Title field, type Exchange Rate per $1.

• Sentence-style onscreen elements: Use quotation marks for elements whose names use 
sentence-style capitalization.

Select the checkbox labeled “Keep lines together.”

Search for “Apps for college.”

• Title-style onscreen elements: For title-style elements, use quotation marks only if 
there’s a significant chance the name could be misread in context.

Tap Use as Wallpaper.

To store media outside the library, click the Media pop-up menu, choose 
“Choose,” and then select a storage location.

• Smart quotation marks: Most apps have an option called “smart” quotation marks, 
which automatically generates curly quotation marks (and apostrophes) as you type.

See also italics (n.), italic (adj.); titles of works.
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R
racism, racist language  See Writing inclusively.

radio button  A labeled circular button used to present a set of mutually exclusive options.

Users select an option. Avoid the term radio button, except in developer materials. You can 
refer to the option’s label, or to the label used to introduce a group of radio buttons.

Select “Automatically based on mouse or trackpad.”

In the “Show scroll bars” area, select “When scrolling.”

To change the location of the Dock, select an option next to “Position 
on screen.”

See also checkbox.

radio-frequency interference  See RFI.

RAID  Acronym for Redundant Array of Independent Disks, a storage method in which data 
is distributed among two or more hard disk drives to improve performance and reliability. 
Storage methods are called levels: RAID level 0, RAID level 1, RAID level 0+1, and so on. 
OK to shorten to RAID 0, RAID 1, RAID 0+1, and so on. For guidelines about spelling out 
acronyms, see abbreviations and acronyms.

Raise to Speak  Note capitalization. An Apple Watch feature.

When Raise to Speak is on, you can raise your wrist and speak your 
request.

Raise to Wake  Note capitalization. An iPhone feature.

When Raise to Wake is on, you can wake your iPhone by raising it.

RAM  Acronym for random-access memory. For guidelines about spelling out acronyms, 
see abbreviations and acronyms.

random-access memory  See RAM.

raw  A format for image files. Use lowercase; raw is a generic term used to describe many 
different file types. Don’t use raw alone; use raw file, raw image, raw setting, and so on.

When you take photos using your camera’s raw setting, the camera  
creates a raw file that retains all the image data captured by the camera.

re (prefix)  Close up unless the resulting word creates another word.

reenter, reinstall, reevaluate

re-create (recreate), re-sort (resort)
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Reader  Always capitalize when referring to the Safari feature. Don’t precede with the.

You can use Reader to view articles without distracting ads.

Reading List  Always capitalize when referring to the Safari feature. Refer to the user’s 
Reading List as your Reading List.

You can add webpages to your Reading List.

Read Me  A document that accompanies a product and contains information the user 
needs to read before installing or using the product.

In user materials, don’t call such documents the Read Me or Read Me file. Instead, use 
the document’s name enclosed in quotation marks. Call a file “Read Me” only if that’s the 
actual filename.

read-only memory  See ROM.

read/write (adj.)  Note slash, as in read/write memory.

real time (n.), real-time (adj.)  Note hyphenation of adjective. Don’t use realtime.

Correct: You can edit multicamera footage in real time.

Correct: You can group unrelated clips together for real-time  
montage editing.

Incorrect: Many transitions can play back in real-time.

receipt  A written acknowledgment by a receiver of money that payment or delivery  
has been made. If payment has already been made, use receipt and not invoice. See  
also invoice.

recommend  When describing something users are encouraged to do, don’t use we 
recommend or Apple recommends; use recommended.

Correct: It’s recommended that you import video using the same 
camera you used to record it.

Incorrect: We recommend that you import video using the same camera 
you used to record it.

You can also use less formal phrases like it’s a good idea to.

It’s a good idea to create a password hint.

recovery mode (n., adj.)  Don’t hyphenate the adjective form.

To put your device in recovery mode…

Wait until you see the recovery mode screen, then…

redownload  Don’t use; use download again. See also download (n., v.), downloadable (adj.).

Redundant Array of Independent Disks  See RAID.

reference  Don’t use as a verb; use refer to.

register  Capitalize names of specific registers, but don’t capitalize the word register. Don’t 
capitalize generic register names such as floating-point registers and vector registers.
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regular  Don’t use when you mean standard, as in Use standard settings.

release  Refers to the issuing of software, as in a major release of iOS. Don’t use when 
referring to a macOS version number.

Correct: The next major release of macOS will be available this fall.

Incorrect: The 10.12 release of macOS will be available this fall.

See also version number.

reminder, Reminders  Use lowercase to refer to a reminder the user creates. Use 
uppercase to refer to the app.

Type a name for the reminder.

Use the Reminders app to stay organized.

Refer to a list of reminders as a reminder list.

You can share a reminder list with other iCloud users.

representative  Don’t use to refer to an AppleCare Support person. See also advisor, 
Advisor.

reset (v., adj.)  Don’t use reset as a noun. See also Reset.

Reset  The button or switch, which may be labeled with the word Reset or with a  
triangle symbol.

resizable  Not resizeable.

resize  Not size or grow. OK to use change the size of.

resize control  The area in the lower-right corner of a window that users drag to resize  
the window.

resolution  Use a lowercase letter x (not the word by) to express screen or other resolution 
(640 x 480). See also dimensions; x.

restart (v.)  Don’t use as a noun.

restore (v., adj.)  Don’t use as a noun.

Correct: Avoid stopping the restore process.

Incorrect: Avoid stopping a restore in progress.

Correct: Restoring stopped because the disk is full.

Incorrect: The restore stopped because the disk is full.

return character  Not carriage return character, except in developer materials when you’re 
referring to ASCII character $0D.

Return key  Capitalize when you refer to the key on the keyboard. Use lowercase when you 
refer to the character.

When you press Return, you generate a return character.

RFI  Abbreviation for radio-frequency interference. Note hyphenation of the spelled-out 
version. For guidelines about spelling out abbreviations, see abbreviations and acronyms.

Rich Text Format  See RTF.
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right arrow  Use to refer to a button that looks like a right arrow and lets users navigate 
horizontally through content, such as a category of TV shows in the Apple TV app.

Don’t call it the right arrow button or the right-pointing arrow.

Click the right arrow to view more episodes.

Don’t use when you mean Forward button.

See also disclosure arrow; Forward button; Right Arrow key.

Right Arrow key  When you refer to arrow keys generically, use lowercase, but capitalize 
and use the complete name when you refer to one or more arrow keys by name. See also 
arrow keys.

right-click (v.)  For Windows only, use to refer to clicking the secondary (usually the right) 
mouse button. For Mac, use Control-click instead.

Windows: Right-click the app icon to open a shortcut menu.

Mac: Control-click the app icon to open a shortcut menu.

See also Control-click (v.).

right-hand  Avoid except in reference to right-hand (recto) pages; use just right whenever 
possible.

rightmost  No hyphen.

right side  Not right-hand side.

ringtone  One word.

road map  Two words.

ROM  Acronym for read-only memory. For guidelines about spelling out acronyms, see 
abbreviations and acronyms.

roman, Roman (adj.)  Use lowercase when you refer to numerals and to font style. 
Capitalize when you refer to the term Standard Roman character set. See also arabic, 
Arabic (adj.).

root  The top-level folder in a file system. In pathnames, the root of the file system is 
designated by a leading slash (/). Avoid using root as a synonym for System Administrator. 
See also pathnames; System Administrator.

root user  See System Administrator.

rotate  Refers to the act of placing two fingers slightly apart on a touchscreen or trackpad 
and twisting them clockwise or counterclockwise.

Rotate to change the photo’s orientation.

See also gestures.
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rotor  A navigation tool in VoiceOver. In materials that refer to more than one rotor, use 
a rotor’s full name on first mention: VoiceOver rotor, gestures rotor, Quick Nav rotor, 
Verbosity rotor. On subsequent mentions, it’s OK to shorten to the rotor if it’s clear which 
rotor you’re referring to.

router  Don’t use interchangeably with bridge. A bridge joins two networks to form an 
expanded network, not an internet. A router maintains a logical map of the networks and 
other routers in an internet, allowing the networks to retain separate identities.

RSS  Abbreviation for Really Simple Syndication. A format for displaying the latest changes 
to websites and blogs. Users access these RSS feeds with an RSS reader. For guidelines 
about spelling out abbreviations, see abbreviations and acronyms.

RTF  Abbreviation for Rich Text Format. For guidelines about spelling out abbreviations, 
see abbreviations and acronyms.

rule  An editable action in Mail.

rule of thumb  Avoid; use general rule, general recommendation, guideline, or as a rule.

run (v.), running (adj.)  Use running for programs or processes that operate in the 
background and have no graphical interface.

Open Activity Monitor to see what processes are running.

• Apps: Don’t use run to describe what a user does with an app (a program that has a 
graphical interface); say use instead.

Correct: Before installing the software, use Disk Utility to verify  
your disk.

Incorrect: Before installing the software, run Disk Utility.

Don’t use running to refer to an open app; use open.

Correct: Check to see whether any apps are open.

Incorrect: Check to see whether any apps are running.

• Software versions: In user materials, avoid using running to refer to versions of the 
operating system or apps. Instead, use alternatives such as use, using, or installed. In 
server materials or materials for more technical users, it’s OK to use running to refer to 
versions of the operating system or apps.

Correct: If you’re using iOS 12 or earlier, follow these instructions.

Incorrect: If you’re running iOS 12 or earlier, follow these instructions.

Correct: To use Siri on your Mac, you must have macOS 10.12 or later 
installed.

Incorrect: To use Siri on your Mac, you must be running macOS 10.12  
or later.

runtime (n., adj.)  One word.
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S
safe mode  Note lowercase.

sample rate  The number of times per second an audio file is sampled. Don’t use  
sampling rate.

SAN  Acronym for storage area network. Precede with a, not an. For guidelines about 
spelling out acronyms, see abbreviations and acronyms.

sanity check, sanity test  Don’t use; use an alternative such as consistency check, logic 
check, final check, or final pass.

Correct: A consistency check can help confirm that software is 
behaving as expected.

Incorrect: A sanity check can help confirm that software is behaving  
as expected.

sans serif (adj.)  Two words.

SATA  See Serial ATA.

save  You save a file on a disk or to a disk, not onto a disk.

scalable, scalability  Not scaleable, scaleability.

screen  Use to refer to what the user looks at while working on a computer or device. Don’t 
use when you mean display. The display is the hardware component that contains the 
screen; the screen is the surface the user views.

Correct: Use screen sharing to show others what’s on your screen.

Incorrect: Use screen sharing to show others what’s on your display.

Correct: Position the display to minimize reflections and glare on  
your screen.

See also display (n.).

screen saver (n., adj.)  Two words.

screen sharing (n.), screen-sharing (adj.)  Note hyphenation of adjective.

screenshot (n., adj.)  One word.

script system  When appropriate, refer to a script system by its product name, which may 
or may not include the words script system. Don’t capitalize generic references to types of 
script systems.

KanjiTalk is Apple’s version of the Japanese script system.

The Roman Script System is available on all Mac computers.
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scroll  Avoid using as a transitive verb.

Correct: Scroll through a document.

Correct: Scroll to view more of the document.

Incorrect: Scroll a document.

In user materials, when describing the act of moving through documents, webpages, 
groups of options, and other items, it’s often preferable to use scroll instead of specific 
actions and gestures such as drag or swipe.

Acceptable: Drag up or down to scroll through the songs in the list until 
you find the one you want.

Preferable: Scroll through the songs in the list until you find the one  
you want.

See also gestures.

scroll bar  The whole control is the scroll bar. In macOS, the control that users drag is the 
scroller.

scroller  The control users drag in the scroll bar. See also scroll bar.

SD  Abbreviation for standard definition (n.) and standard-definition (adj.). For guidelines 
about spelling out abbreviations, see abbreviations and acronyms.

SDH  Short for subtitles for the deaf and hard of hearing. Define on first mention.

Subtitles for the deaf and hard of hearing (SDH) differ from closed 
captions in several ways.

Use SDH when referring to the technology.

You’ll find SDH on more media types than closed captioning.

Use SDH subtitles when you’re referring to the titles themselves.

SDH subtitles and closed captions are encoded differently.

See also closed captions (n.), closed captioning (n., adj.), closed-captioned (adj.).

SDK  Abbreviation for software development kit. For guidelines about spelling out 
abbreviations, see abbreviations and acronyms.

SDR (n., adj.)  Abbreviation for standard dynamic range (n.) and standard-dynamic-range 
(adj.). A legacy video or still-image format with limited levels of brightness per color 
component.

See also HDR (n., adj.).

SDRAM  Abbreviation for synchronous dynamic random-access memory. For guidelines 
about spelling out abbreviations, see abbreviations and acronyms.

search field  Note lowercase.

secondary cache, second-level cache  Don’t use; use level 2 cache or L2 cache.
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Secure Element, Secure Enclave  The Secure Element is a chip in an Apple device that 
securely stores confidential data such as payment information. The Secure Enclave is a 
system on chip (SoC) that stores private keys and is isolated from the main processor to 
provide an extra layer of security. It processes fingerprint and face data from Touch ID and 
Face ID sensors, and then allows access or purchases on behalf of the user.

The Secure Element hosts an applet to manage Apple Pay and also 
includes payment applets certified by the payment networks.

On iPhone, iPad, and Apple Watch, the Secure Enclave manages the 
authentication process and allows a payment transaction to proceed.

See also system on chip (n.), system-on-chip (adj.).

select (adj.)  OK to use select to mean special or exclusive.

Select Apple Store locations offer coding sessions for coders of  
all ages.

select (v.)  Use select, not choose, to refer to the action users perform when they select 
among multiple objects—such as icons, graphic images, radio buttons, or checkboxes—or 
when they highlight text for editing.

Select a name in the list.

To select several files at once, Command-click them.

Select the text you want to make bold.

Select the Shadow checkbox.

• Selecting objects: Although users generally click to select objects (they can also use 
the keyboard), you need to use the complete phrase click to select only if you think 
there’s potential for confusion. Both of the following examples are acceptable.

Click (or tap) to select a name in the list.

Select a name in the list.

• Interface items: Although it’s usually clearest to include an item’s name (if it has one) 
and type of item (such as a checkbox), you can also refer to an item as an option or use 
only the item’s name.

Select the option “Object causes wrap.”

To position the Dock on your screen, select Left, Bottom, or Right.

Use choose for menu items, including those in pop-up and shortcut menus.

See also checkbox; choose; click; deselect; highlight (v.); menus; unselected (adj.).

selection rectangle  The rectangular outline that appears when users drag across items on 
the screen to select them. Often, you can simply say drag to select.

Drag a selection rectangle around the clips you want to add to  
your project.

Drag to select the clips you want to add to your project.
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self  Use a hyphen in terms beginning with self.

self-paced, self-playing, self-running, self-service

self-powered  See bus-powered, self-powered.

self-test (n., adj.)  Don’t use as a verb.

sentence-style capitalization  Capitalize only the first letter of the first word, proper 
nouns, and proper adjectives. See also capitalization.

Serial ATA  A hardware interface that connects a computer to network or storage devices. 
Short for Serial Advanced Technology Attachment. OK to use the acronym SATA (precede 
with a, not an) if space is limited, but spell out as Serial ATA whenever possible. See also 
hard disk (n., adj.).

server  A computer or device (or the software on it) that’s on a network and manages the 
network’s resources. Types of servers include the following:

application server, database server, file server, HTTP server, mail server, 
network server, print server, streaming server, web server

service manual  Note lowercase.

Setup Assistant  Capitalize when you refer to an app that helps users configure the system 
or software; use lowercase for generic references. Don’t use the before Setup Assistant.

You must have an AirPort Extreme Card installed in your computer to 
use AirPort Setup Assistant.

Apple Remote Desktop provides an easy-to-use setup assistant to 
guide you through the process.

See also Assistant.

setup (n., adj.), set up (v.)  One word except as a verb.

sexism, sexist language  See Writing inclusively.

Shared Albums  An iCloud feature that allows users to share photo albums with other 
iCloud users. Note capitalization; don’t use iCloud Photo Sharing, Shared iCloud Albums, or 
similar. You turn on or turn off Shared Albums. Use shared album to refer generically to an 
album that’s shared using Shared Albums. See also iCloud.

shared disk  In user materials, use shared disk when you discuss connecting to another 
computer over the network. When you discuss setting up a folder to share on your own 
computer, use shared folder. Use file server only when explaining the concept of file servers.

shared folder  In user materials, use shared folder when you discuss setting up a folder 
to share on the user’s computer. Use shared disk when you discuss connecting to another 
computer over the network. See also shared disk.
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share sheet  Note capitalization. In most user materials, avoid using share sheet; instead, 
describe what the user must select or do.

Correct: Tap , and then tap Messages.

Incorrect: Tap , and then tap Messages in the share sheet.

It’s OK to use share sheet in developer materials and user materials that describe making 
changes to the options in the share sheet.

To allow a shortcut to run from within other apps, you must enable it to 
appear in the share sheet.

See also action sheet; sheet.

sheet  In macOS, refers to a dialog that’s attached to a specific window—usually a 
document—and prevents further interaction with the window until the sheet is dismissed.

In user materials, call a sheet a dialog (sheet is used mainly in developer materials).

User materials: Use the Print dialog to choose a printer and select  
print options.

Developer materials: When the user responds to a sheet and another 
sheet for that document opens, the first sheet must close before the 
second one opens.

See also action sheet; share sheet.

Shift-click (v.)  Equivalent to press the Shift key while you click.

To include another item in the selection, Shift-click the item.

See also key, keys.

Shift-drag (v.)  Equivalent to press and hold the Shift key while you drag.

Shift-drag a selection rectangle over selected points.

See also key, keys.

Shift key  Note capitalization.

Shift lock  Don’t use; use Caps Lock.

shortcut  One word. See also keyboard shortcut; Siri Shortcuts.
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shortcut menu  See menus.

shows up  Don’t use; use appears. OK to use show when referring to showing and hiding 
onscreen elements.

The Portrait Lighting slider appears below the frame.

To show a hidden photo, choose View > Hidden Photos.

shuffle  Lowercase except in the names of interface elements: shuffle your songs; click 
Shuffle to mix up your music.

shutdown (n., adj.), shut down (v.)  One word except as a verb.

sidebar  Use to refer to a column in a Finder window or an app window that shows items 
such as available disks and other devices, mailboxes, playlists, or favorite items.

side button  Use to refer to the button next to the Digital Crown on Apple Watch. Don’t 
shorten to the button.

Sidecar  The feature for using iPad as a second display with a Mac. Don’t precede with the.

Sidecar lets you extend your workspace by using your iPad as a  
second display.

sighted  To refer to a person with sight, you can say a person who is sighted, a sighted 
person, a person with sight. See also blind, low vision; Writing about disability.

sign  Use sign, not symbol, in the following terms: division sign, equal sign, greater-than 
sign, less-than sign, minus sign, multiplication sign, number sign, and plus sign.

signaled, signaling  Not signalled, signalling.

sign-in (n., adj.), sign in (v.)  Use to refer to creating a session for an internet account. 
Users sign in to Apple services; computers, devices, and apps do not. Use sign in to, not 
sign into.

Correct: Sign in to the App Store using the Apple ID that you used to 
purchase the app.

Incorrect: The computer must be signed in to the App Store using the 
Apple ID that you used to purchase the app.

Users sign out of services (not sign off, sign off of, or sign off from).

See also login (n., adj.), log in (v.).

Sign in with Apple  Note capitalization. The feature that lets users sign in to apps and 
websites securely using their Apple ID. The word in is lowercase in both the name of the 
service and the label on the Sign in with Apple button.

Sign in with Apple is the fast, easy way to sign in to apps and websites.

When you visit a participating website, tap Sign in with Apple.

sign-on (n., adj.), sign on (v.)  No hyphen in verb. Note hyphenation in phrases such as 
single sign-on authentication.
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SIM  Acronym for Subscriber Identity Module, a smart card that holds subscriber 
information and settings. Precede with a, not an. OK to use SIM or SIM card. SIM formats 
include micro-SIM and nano-SIM. Related terms include Apple SIM, embedded Apple SIM, 
Dual SIM, and eSIM.

iPhone models with Dual SIM have an eSIM and a nano-SIM card.

Your iPad might use an embedded Apple SIM, an Apple SIM card in the 
SIM-card tray, or a SIM card from a wireless carrier.

SIMM  Acronym for single inline memory module. No hyphen in the spelled-out version. For 
guidelines about spelling out acronyms, see abbreviations and acronyms.

Simple Mail Transfer Protocol  See SMTP.

since, because  Use since to mean during the period subsequent to the time when. Use 
because to mean for the reason that.

Correct: It’s been five hours since you checked your email.

Correct: Because you made a backup copy, you didn’t lose your work.

Incorrect: Since you made a backup copy, you didn’t lose your work.

single  Hyphenate compound adjectives beginning with single.

single-button, single-core, single-layer, single-precision,  
single-processor

single inline memory module  See SIMM.

single sign-on (n., adj.)  A service that permits a user to access multiple apps using a 
single ID and password.

For a list of TV providers that support single sign-on, see…

Apple TV offers single sign-on authentication for users of some apps.

See also sign-in (n., adj.), sign in (v.).

Siri  The voice-activated assistant.

Don’t refer to Siri as she or her; always say Siri. If that means repeating Siri too often, you 
can occasionally refer to Siri as it. Users can summon Siri, ask Siri, or make requests; users 
don’t open Siri.

Avoid using Hey Siri as a feature name; in most cases just tell users how to use it.

Avoid: You can use Hey Siri to schedule a meeting.

Preferable: To use Siri without pressing the Home button, say “Hey Siri,” 
and then make your request.

Siri Remote  Use to refer to the remote control that’s compatible with Apple TV HD and 
Apple TV 4K. In countries or regions where Siri isn’t available for use with Apple TV, use 
Apple TV Remote instead.

Use the Touch surface on the Siri Remote to set up your Apple TV.

To activate Siri, press and hold the Siri button on the Siri Remote.

See also Apple TV Remote; Touch surface.
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Siri Shortcuts  When you refer to the feature, capitalize Shortcuts and use an s at the end. 
Siri Shortcuts takes a plural verb.

Correct: Siri Shortcuts provide a quick way to get things done.

Incorrect: You can use Siri shortcuts to do everyday tasks.

When referring generally to individual shortcuts, use lowercase shortcut and omit Siri.

Correct: Create a shortcut that plays your favorite podcast on the  
drive home.

Incorrect: Create a Siri Shortcut that plays your favorite podcast on  
the drive home.

Siri Suggestions  When you refer to the feature, capitalize Suggestions and use an s at the 
end. Siri Suggestions takes a plural verb.

Correct: Siri Suggestions give you help right when you need it.

Incorrect: You can view Siri suggestions on your watch face.

When referring generally to individual suggestions, use lowercase suggestion and omit Siri.

Correct: To use a suggestion, tap it on the Lock Screen.

Incorrect: To use a Siri Suggestion, tap it on the Lock Screen.

site license, site licensing (n., adj.)  No hyphen.

size (adj.)  Hyphenate compound words ending with size. Not sized. 

letter-size, medium-size, pocket-size

size (v.)  Don’t use; use resize or change the size of (in reference to a window or an 
object).

slash  Use slash to describe this character: /. See also backslash.

slave  Don’t use to refer to a device or process. See also master/slave.

sleep  An energy-saving feature of some computers. The computer goes to sleep (or the 
user can put it to sleep); the computer is then in sleep or in sleep mode. Don’t use the 
computer is sleeping or the computer is asleep.

slide (v.)  Avoid when describing how users operate a slider or switch. Use tap, click, or 
drag instead.

Correct: To increase or decrease the effect, drag the slider.

Incorrect: To increase or decrease the effect, slide the slider.

Correct: Tap the switch to turn airplane mode on or off.

Incorrect: Slide the switch to turn airplane mode on or off.

It’s OK to use other meanings of slide, in other contexts.

To slide smoothly between notes (called portamento), tap Pitch.

The second app slides in from the right edge of the iPad screen.

See also slider; switch (n.).
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slider  The object users drag to set a value on a continuum (a range of values). The whole 
control is called the slider control.

Depending on the context, users may click, tap, or drag a slider. Avoid using the verb slide 
with slider.

Correct: Tap the slider, and then swipe up or down with one finger.

Correct: To adjust the magnification, drag the Zoom Level slider.

Incorrect: Slide the slider, and then swipe up or down with one finger.

See also slide (v.).

slideshow  One word.

slot  A long, thin socket on the main logic board where peripheral cards are inserted. Don’t 
use connector to refer to a slot. Use lowercase for slot when it’s followed by a number 
(slot 1, slot 2). See also connector; jack; port; socket.

slot-loading (adj.)  Not slot-load. See also tray-loading (adj.).

small outline dual inline memory module  See SO-DIMM.

Smart  When you refer to items that are updated automatically based on search criteria the 
user selects, capitalize both the word Smart and the noun it modifies: Smart Album, Smart 
Collection, Smart Folder, Smart Group, Smart Mailbox, Smart Playlist.

smart card  Note lowercase.

smartphone  One word.

Smart Stack  Precede the singular form with a.

You can swipe through a Smart Stack to see the widgets in it.

To use Smart Stacks, you need to be using iPadOS 14 or later.

smart TV  Note capitalization. Use to refer generically to TVs with integrated network 
connectivity and streaming capabilities.

See a list of smart TVs that support the Apple TV app.

See also streaming device, streaming player.

smiley  Don’t use on its own in place of emoji or emoticon. It’s OK to use smiley or smiley 
face to describe a particular emoji or emoticon.

You can type a text message to include with your photos—and even 
include an emoji, such as a smiley face.

See also emoji; emoticon.

SMTP  Abbreviation for Simple Mail Transfer Protocol. For guidelines about spelling out 
abbreviations, see abbreviations and acronyms.

snapshot  OK to use as a synonym for photo, but avoid using snapshot to refer generally to 
a user’s photos. Snapshot connotes a photo taken quickly and informally, without attention 
to lighting or composition. See also photo.

so-called (adj.)  Don’t italicize or use quotation marks around terms following so-called.
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social media (pl. n., adj.)  Websites and apps through which people share links and 
content, such as messages, photos, videos, blog postings, and more. When possible, name 
specific apps instead of using the general term social media. Users post to, share on, or 
publish to most social media networks.

You can publish videos to Facebook.

Post photos from your library to sites such as Instagram.

Set up email and social media accounts.

socket  Use to refer to a receptacle with holes that receives a plug or another connector. 
Don’t use female connector. See also connector; jack; port; slot.

SO-DIMM  Acronym for small outline dual inline memory module. Note hyphenation of the 
acronym. For guidelines about spelling out acronyms, see abbreviations and acronyms.

soft copy  Avoid; use a term such as file or electronic document.

softcover  One word.

software  Programs that perform operations on a computer. Types of software include 
application (or app) software and system software. Use software alone if you don’t need to 
refer to a specific type of software. Don’t use software program.

Apple periodically releases updates to your computer’s software.

See also app, application, program; system software.

software development kit  See SDK.

software license agreement  Not software licensing agreement.

software version numbers  See version number.

solid-state drive  Use to refer to a device that stores data using flash memory and has no 
moving parts. OK to use just drive after you first specify the type of drive. It’s also OK to 
use disk to refer generically to solid-state drives. Avoid abbreviating as SSD. See also  
disk; drive.

sound input, sound input/output, sound output (n., adj.)  Avoid unless it appears in the 
user interface. Use audio input, and so on, instead. See also audio input, audio input/
output, audio output (n., adj.).

soundtrack  One word.

source code  Two words.

source file  Two words.

Space bar  Two words.

space character  Not blank or blank character. OK to use just space, but in many cases 
it’s necessary to remind the user that a space is actually a character and that margins, 
indentation, word wrap, and page breaks can sometimes be affected by extra space 
characters (or a lack of them).
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Spaces  Capitalize only when explicitly referring to the feature.

You can use Spaces to organize your windows into groups and reduce 
clutter.

Use Mission Control to add and delete desktop spaces.

spam  Refers to unwanted electronic messages, often sent in bulk, by a bot or another 
unknown sender. Spam—which can contain hostile elements such as malware—appears not 
only in email but also in instant messaging, social media, newsgroups, and other systems.

The Mail app and iCloud Mail use junk mail, not spam, to refer to all unwanted mail. It’s OK 
to use spam to help define junk mail.

When you receive unwanted mail (known as junk mail or spam), select it 
and choose Message > Mark > As Junk Mail.

Don’t use spam as a verb. See also junk mail (n., adj.).

spatial audio  Note lowercase.

You can turn spatial audio on or off for all shows and movies.

S/PDIF  Acronym for Sony/Philips Digital Interface Format. Don’t use S/P-DIF. The acronym 
is pronounced “spid-iff,” so it’s preceded by a, not an. For guidelines about spelling out 
acronyms, see abbreviations and acronyms.

speakerphone  One word.

special effects (n., adj.)  No hyphen.

speed  For the speed of optical drives, use a lowercase x—for example, 24x speed. Note 
that there’s no space between the numeral and the x.

spell-check (v.)  Also OK to use check the spelling of a document.

spell checker, spelling checker  Either term is OK.

spin down (v.)  Avoid using. Use stop spinning instead. OK for use in service-related 
publications.

spinning gear  See progress indicator.

spinning wait cursor  In developer materials, the colored pinwheel cursor. In user 
materials, use wait cursor.

Developer materials: Try to avoid situations in your app that cause the 
window server to display the spinning wait cursor.

User materials: You might see a wait cursor (looks like a colored 
pinwheel) while the app is opening.

splash screen  Don’t use; use opening display, startup display, or startup screen.

Split View  Note capitalization. The feature for viewing two apps or windows side by side 
on a Mac or iPad. In most cases, say that users do things in Split View; they don’t use  
Split View.

Avoid: You can use Split View to view two apps side by side.

Preferable: You can view two apps side by side in Split View.
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Spotlight  The search feature in macOS. Related terms include the following:

• Spotlight icon: In the menu bar

• search field: The area where users enter search terms

• Spotlight window: Shows the results list (on the left) and a preview (on the right)

SSD  See solid-state drive.

Stacks  The macOS feature that automatically groups files on the desktop and gives you 
quick access to folders in the Dock. Capitalize only when referring to the feature.

With the Stacks feature, you can easily organize the files on  
your desktop.

You can change how stacks are grouped.

Files you download appear in the Downloads stack.

standalone (adj.)  Don’t use as a noun.

standard definition (n.), standard-definition (adj.)  See SD.

standard dynamic range (n.), standard-dynamic-range (adj.)  See SDR (n., adj.).

Standard Roman character set  Note capitalization.

standard user  Use in macOS to describe a user whose account is more restrictive than 
that of an administrator user. Don’t use normal user. See also administrator (adj.). 

standby (n., adj.), stand by (v.)  One word except as a verb.

start  Don’t use when you mean open (as in open an app).

startup disk  The preferred term in user materials.

Startup Disk  A pane in System Preferences.

startup display, startup screen  Not splash screen. Startup display, startup screen, and 
opening display are all OK.

startup sound  Use to refer to the chord heard during a successful startup sequence. 
Don’t use boot chime.

startup (n., adj.), start up (v.)  In user materials, try to avoid using startup as a noun, 
except when repeated occurrences of when you start up become unwieldy. Rewrite when 
possible to use a more specific term or description.

For AppleCare and developer materials, startup is an acceptable generic term for the 
period of time it takes the computer to start up.

Start up the computer.

After a few seconds, the startup display appears.

While the computer is starting up, you can check your voicemail.

AppleCare: During startup, you can scan the manual that came with 
your computer.

See also boot.
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statement  Not necessarily the same as line. One line may contain several statements, and 
one statement may extend over several lines.

stationery  A feature of the Mail app in macOS.

step  Don’t capitalize, even in specific references.

step 1, steps 1 and 2, several steps

stepper  In developer materials, use to refer to a control that has up and down arrows, or 
left and right arrows, to increase or decrease a value. Don’t use in user materials unless it’s 
necessary to refer to the control itself; use up arrow, down arrow, right arrow, left arrow,  
or arrows, as appropriate. For example, Click one of the arrows to increase or decrease  
the volume.

stereotypes  See Writing inclusively.

Stickies  Don’t use to refer to the things you create using Stickies; use notes.

Sticky Keys  Capitalize when you refer to the feature that can be set in the Accessibility 
pane of System Preferences.

still image (n.), still-image (adj.)  Note hyphenation of adjective. Use in video editing  
or multimedia contexts to refer to a single static image, such as a photo, a title, or  
an illustration.

You can import video, audio, and still-image files.

stop  A general term meaning to cause a process, command, or program to cease. Don’t 
use when you mean quit an app. See also exit; interrupt; quit.

storage  Use storage space (or just space) to refer to the space used to store data and 
information on a computer or device.

You can make more storage space available by deleting files you no 
longer use.

If you’re running out of space, you can store files in iCloud Drive.

You can also use storage by itself, especially when discussing storage management, as in 
the phrases Optimized Storage, buy more storage, and so on.

Optimized Storage suggests ways you can automatically free up space 
on your Mac.

To upgrade your iCloud storage, click Buy More Storage.

See also memory.

storage device  Use instead of disk to refer generally to computer storage devices that 
might include hard disks, solid-state drives, and flash storage.

Correct: You can import photos from an external storage device.

Incorrect: You can import photos from an external disk.

When possible, use a more specific term.
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stream (n., v.), streaming (n., adj.)  Use to refer to watching or listening to media content 
as it’s delivered to a device (instead of downloading it completely first).

This stream is best experienced on an iPhone, iPad, or iPod touch with 
iOS 10 or later.

Use AirPlay to stream content from iPhone to Apple TV.

Activities like streaming and downloading large files can slow down  
a network.

Apple TV+ is a streaming service featuring award-winning series, 
documentaries, kids’ entertainment, and more.

Content can be streamed on demand (at any time) or in real time. You can use livestream to 
refer to content that’s streamed in real time.

Watch the livestream of this year’s Worldwide Developers Conference, 
or stream it on demand on Apple Podcasts.

See also livestream (n., v.), livestreaming (n.).

streaming device, streaming player  Use either term to refer generically to digital media 
players (such as Roku) that stream content over a network to a TV.

Open the Apple TV app on your smart TV or streaming device.

See also smart TV.

style (of type)  Not typestyle or type style.

sub (prefix)  Close up words beginning with sub.

subaccount, subdirectory, submenu, subnetwork

subdirectory  In developer materials, can be used to refer to a directory within another 
directory. In user materials, use folder. See also folder.

submenus  Use when you describe hierarchical menus. When the user highlights a menu 
item with a submenu indicator (which looks like a right arrow), a submenu appears.
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To describe choosing an item from a submenu, use one of these styles:

Choose View > Sort By > Name.

Choose View > Sort By, and then choose an item from the submenu.

See also choose; menus.

super (prefix)  Close up words beginning with super.

supercomputer, superfine, supermodern

SuperDrive  Apple’s optical drive that reads and writes (burns) CDs and DVDs. SuperDrive 
is typically preceded by an article (a or the) or a possessive adjective (such as your).

support  Avoid in user materials when you can use compatible, works with, or another 
appropriate word or phrase.

Avoid: The first-generation iPad didn’t support AirPlay Mirroring.

Preferable: AirPlay Mirroring works with iPad 2 or later.

Avoid: iMovie supports most QuickTime formats.

Preferable: You can use files in most QuickTime formats with iMovie.

It’s OK to use support to refer to a product or feature that Apple doesn’t provide but that 
the user can obtain (for example, using software from other manufacturers). Avoid saying 
Apple doesn’t support something.

Check the iMovie website for a list of supported camcorders.

See also Apple Support.

surround sound (n., adj.)  Note lowercase; no hyphen.

Apple TV 4K lets you enjoy Dolby Digital 5.1 surround sound.

Spatial audio brings a theater-like surround sound experience to the 
movies you watch.

It’s OK to use surround alone (deliver in both stereo and surround).

See also Dolby formats.

S-video  Note hyphenation.

swipe (n., v.)  Refers to the act of quickly sliding one or more fingers across a touchscreen 
or trackpad.

Users swipe to navigate documents, webpages, and areas of the interface, and to browse 
lists and groups of items. Include the direction of the swipe—up, down, left, or right—if it’s 
needed to describe the action.

Tap the movie, and then swipe to choose a duration.

Swipe left to read the next story.

Swipe up from the bottom edge of the screen to open Control Center.
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You can use prepositions such as over and on to make it clear where to swipe.

Swipe over the selected text to highlight it.

Swipe down on the title bar of a message you’re writing.

Swipe can take a direct object in cases where users must precisely move an item (such as 
when closing an iOS app) instead of simply swiping anywhere in a general area (such as 
when paging through a book).

In the app switcher, swipe an app up to close it.

To describe swiping with more than one finger, say, for example, swipe with two fingers (for 
the verb form) or two-finger swipe (for the noun form).

Swipe up with four fingers to open Mission Control.

Use a three-finger swipe to rapidly page through documents.

See also drag; gestures.

switch (n.)  An interface element that offers two mutually exclusive choices—usually on 
and off (use lowercase for on and off, even if the control options are uppercase). It’s often 
unnecessary to refer to the switch itself; instead, describe the action the user takes to 
operate it.

Tap to turn on Location Services.

Tap to turn airplane mode on or off.

If you do need to refer to the switch (in order to specify its location, for example), avoid 
using the verbs switch or slide with it; use tap or click instead.

Correct: To turn airplane mode on or off, tap the switch in the  
upper-right corner.

Incorrect: To turn airplane mode on or off, slide the switch in the  
upper-right corner.

See also  switch (v.).

switch (v.)  OK to use to mean change or substitute.

You can have more than one music library and switch between them.

The table includes key commands for switching modes and showing 
inspectors.

Don’t use switch on or off or toggle to mean turn on or off.

Correct: You can turn the Accent setting on or off for each drum sound.

Incorrect: You can switch the Accent setting on or off for each drum sound.

Incorrect: You can toggle the Accent setting for each drum sound.

See also slide (v.); switch (n.); toggle (v.).
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switch on, switch off  Don’t use switch on, switch off, power down, power off, power on, 
or power up in user materials; use turn on and turn off. See also turn on, turn off.

symbol  When referring to onscreen items, don’t use symbol when you mean button or 
icon. A symbol signifies an idea or concept, but it doesn’t do anything when clicked or 
tapped, and it doesn’t represent a single item (such as a file icon or a battery icon).

When referring to text characters, it’s OK to use symbol in a generic sense, as in the 
percent symbol (%). Don’t use symbol when you mean character, letter, or digit.

Use sign, not symbol, in the following terms: division sign, equal sign, greater-than sign, 
less-than sign, minus sign, multiplication sign, number sign, and plus sign.

See also button; icon.

synchronous dynamic random-access memory  See SDRAM.

sync, synced, syncing  Not synch, synched, or synching.

In general, syncing refers to copying content directly between two devices. You can use 
sync to refer to syncing devices or the content that’s on them.

• Devices: Use with rather than from or to.

Correct: Sync iPhone with your Mac.

Incorrect: Sync iPhone to your Mac.

• Content: Use to to specify the target, from to specify the source, or between if 
information is synced both to and from each source.

You can sync contacts and calendars to iPad from your Mac.

Sync contacts between iPhone and your Mac.

Don’t use synchronize or synchronization as alternative terms for sync or as an explanation 
of the term sync.

Correct: Make sure syncing is turned on for the device.

Incorrect: Make sure synchronization is turned on for the device.
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Although sync is most often used as a verb, it can also be used as a noun or an adjective.

You can also start a sync manually.

Avoid changing sync settings while iPhone is syncing.

Don’t use sync to refer to what iCloud does with information; instead, use alternatives such 
as keep up to date, update automatically, and appear automatically. (It’s OK to occasionally 
use phrases like iCloud keeps your data in sync.) See also iCloud.

system  Don’t use system to refer to a computer by itself.

Correct: You must restart your computer for the changes to take effect.

Incorrect: You must restart your system for the changes to take effect.

If you’re referring to a computer and its peripheral devices, accessories, and software, it’s 
OK to use system.

For best results color correcting HDR video in Final Cut Pro, use a 
system with a Pro Display XDR.

System Administrator  Avoid, except when you’re referring to the macOS user account 
identified as System Administrator (long name) and root (short name).

Anyone with access to the System Administrator account can obtain read-and-write 
access to all settings and files on the system, including hidden system files that a regular 
administrator user can’t modify. Each computer can have multiple administrator accounts 
but only one System Administrator account.

Lowercase system administrator is an acceptable and frequently used variant of the  
noun administrator.

To obtain a static IP address for your computer, contact your system 
administrator or network administrator.

See also administrator (n.); administrator (adj.).

system files  Refers to any files used by the computer to start up or to provide systemwide 
information.

System folder  Note lowercase f.

system on chip (n.), system-on-chip (adj.)  Note hyphenation of adjective. The plural 
form is systems on chip. It’s OK to abbreviate as SoC; precede with an, not a. See also 
Secure Element, Secure Enclave.

System Preferences  Note capitalization for the name of the app. See also preferences.

system software  Not systems software. See also app, application, program; version number.

systemwide (adj.)  One word.
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T
tab  You can use tab to refer to two different elements in the UI:

• A separate view of content a user can open in an app (such as Safari).

Use tab for the entire view—both the part that’s visible in the tab bar, and what users 
see when they click or tap it.

You can open a webpage in a new tab.

Drag a tab out of the window to make it a separate window.

• A control at the bottom of the screen that lets users quickly switch between different 
sections of an iOS app.

Use tab for the entire view—both the control at the bottom of the screen, and what 
users see when they tap it.

The screenshot is added to the Photos tab in Photos.

In developer materials, use tab bar to refer to the entire group of tabs.

In user materials, don’t use tab to refer to a changeable area of content built into a window 
in macOS (such as a preferences window); use pane. Use button for the control users click 
to see the pane (or simply refer to the control by its label).

You can set the color of text in the Style pane.

To change the number of columns, click Layout.

In developer materials, use tab to refer to the control users click; use pane or view to refer 
to the view users see when they click.

See also button; pane.
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Tab key, tab character  Capitalize when you refer to the key on the keyboard. Use 
lowercase when you refer to the character.

When you press Tab, you generate a tab character.

The tab character (HT, for horizontal tab) has the ASCII value $09.

table captions  Table captions include a table number and a table title. In developer 
materials, most tables are numbered. In user materials, tables typically don’t have numbers 
or titles.

When you use table titles, keep them short; don’t exceed a line and a half of text. Avoid 
using complete sentences for table titles.

tables  Use tables for information that would be easier to scan in columnar form than in 
running text. Also use tables for “information matrixes,” which provide an effective way to 
present quick-reference instructions or descriptions.

• Capitalization: Use sentence-style capitalization for all parts of a table, including the 
column headings.

• Headings: Make column headings short and descriptive.

• In-text references: Provide in-text references to all tables. In general, place the 
reference in the paragraph immediately preceding the table. In user materials, you can 
use below to refer to a table that immediately follows the paragraph.

In-text references can stand alone as a complete sentence (with or without 
parentheses) or can occur within a sentence (with or without parentheses). Use a 
consistent style throughout a document.

The following table shows how the tools work and what they do.

The app provides several tools (see the following table).

See the table below for details.

If the table has a number, use it in the in-text reference.

Table 3-2 lists the signal and pin assignments for the DVI connector.

See Table 3-10 for additional result codes.

• Table notes and footnotes: Information that pertains to an entire table is generally set 
as a table note, before any table footnotes.

The table note begins with the word Note (not all caps) followed by a colon. To make the 
information in a table note more prominent than a note allows, you can add it instead 
after the table title, in parentheses, with no capitalization or ending punctuation (even if 
it’s a complete sentence).
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When specific items in a table require footnotes, either number the items consecutively 
starting with 1 or use the following symbols, in the order shown. Consult your 
department’s guidelines for which style to use. (If you need more symbols, double them, 
in the same order.)

asterisk (*)

dagger (†, Option-T)

double dagger (‡, Option-Shift-7)

section (§, Option-6)

paragraph (¶, Option-7)

number (#)

tap (n., v.)  Use to refer to the act of quickly touching and releasing a touchscreen or 
trackpad. Users can tap with one or more fingers (depending on the device and the action 
the user is performing). Don’t use tap on.

Correct: Tap Return to move from one field to another.

Correct: To zoom in or out, double-tap with two fingers.

Incorrect: Tap on the video you want to play.

When discussing the Digital Touch feature in watchOS and iOS, don’t say that users tap 
another device or person; they send a tap.

When discussing haptic feedback, don’t say that a device or trackpad taps you; say you 
feel a tap.

See also click; Digital Touch; double tap (n.), double-tap (v.), double-tapping (n., v.); 
gestures; haptic (adj.), haptics (n.); press; touch and hold.

tap and hold  Don’t use. Tap means to touch and release quickly, so use touch and hold 
instead. See also tap (n., v.); touch and hold.

Tapback  A feature in the Messages app. Don’t use as a verb.

taptic  Don’t use. See also haptic (adj.), haptics (n.); tap (n., v.); Taptic Engine.

Taptic Engine  Technology that provides haptic feedback in iOS devices and Apple Watch. 
Precede with the. Don’t use the word taptic by itself; use only in the term Taptic Engine. 
See also haptic (adj.), haptics (n.).

Tap to Wake  Note capitalization. An iPhone feature.

To wake your iPhone by tapping the screen, turn on Tap to Wake.

target disk mode  Note lowercase.
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TB (n., adj.)  Abbreviation for terabyte. TB equals 10004 bytes in the context of file size or 
storage capacity, and 10244 bytes in the context of computer memory. For guidelines about 
spelling out abbreviations, see abbreviations and acronyms. 

• Noun: In the noun form, use a space between the numeral and the abbreviation. The 
preposition of is necessary before the unit that the value quantifies.

1 TB of memory

2 TB of storage capacity

• Adjective: Don’t hyphenate the adjective form.

a 1 TB memory card

a 2 TB Serial ATA hard drive

Tbit (n., adj.)  Abbreviation for terabit. For guidelines about spelling out abbreviations, see 
abbreviations and acronyms.

• Noun: In the noun form, use a space between the numeral and the abbreviation. The 
preposition of is necessary before the unit that the value quantifies.

1 Tbit of line capacity

• Adjective: Don’t hyphenate the adjective form.

10 Tbit router

Tbit/s  Standard international abbreviation for terabits per second. See also Names and 
unit symbols for units of measure and abbreviations and acronyms. 

TB/s  Abbreviation for terabytes per second. For guidelines about spelling out 
abbreviations, see abbreviations and acronyms. 

TCP/IP  Abbreviation for Transmission Control Protocol/Internet Protocol. For guidelines 
about spelling out abbreviations, see abbreviations and acronyms.

telecommunication  Telecommunication refers to the act; telecommunications refers to the 
field. When used as an adjective, the correct term is telecommunications.

Telecommunication gets simpler by the day, though you can’t prove it 
by most manuals on this subject.

The telecommunications industry is expanding rapidly.

telephone numbers  Use hyphens in U.S. phone and fax numbers; don’t use parentheses 
or a leading 1. Use toll-free number, not 800 number. For numbers with extensions, use 
extension or ext., not x. For phone numbers that use letters for easier recall, include the 
numeric form in parentheses when possible.

800-282-2732

800-MY-APPLE (800-692-7753)

800-800-APPL (800-800-2775)

408-996-1010

See also addresses (mailing). For information about international telephone numbers, see 
Telephone numbers.
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television  TV is preferred. Don’t use television set or TV set. See also Apple TV.

television monitor  Don’t use. Use video monitor or monitor.

temperatures  To list temperatures, repeat the degree symbol but not the abbreviation. 
Use a space between the symbol and the abbreviation: 50° to 104° F (0° to 40° C).

terabit  See Tbit (n., adj.).

terabits per second  See Tbit/s.

terabyte  See TB (n., adj.).

terabytes per second  See TB/s.

terminal  A device or software for sending commands to a computer. Capitalize when 
referring to the Terminal app.

terminal emulation (n., adj.)  No hyphen.

text field  See field.

text file  Two words.

text message  OK to shorten to message if the context is clear. Avoid using text and texts 
as nouns.

Correct: Click Reply in a notification to reply to an email or text message.

Correct: To delete all messages in the thread, tap Delete All.

Incorrect: To delete all texts in the thread, tap Delete All.

Use text as a verb only in informal contexts; otherwise, use send a text message.

See also message.

that  Use to introduce a restrictive clause; clauses beginning with that are generally not set 
off with commas.

This is the computer that has network access. [There are many 
computers; the phrase that has network access restricts—narrows the 
meaning of—the subject of the sentence to one computer.]

The newest computer in the lab, which is a Mac Pro, is also the 
students’ favorite. [There’s only one newest computer; the phrase 
which is a Mac Pro, although it provides more information, doesn’t 
restrict the subject of the sentence.]

See also which.

theater  Not theatre.

they, their, them  See pronouns.
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third party (n.), third-party (adj.)  The adjective is hyphenated. Avoid in user materials.  
If possible, replace with another descriptive term, such as not made by Apple or from  
other manufacturers.

Avoid: If you’ve installed third-party plug-ins, one of the plug-ins could 
be causing the problem.

Preferable: If you’ve installed plug-ins from manufacturers other than 
Apple, one of those plug-ins could be causing the problem.

thread  In the context of a series of related files, such as email messages, items are in  
a thread.

You can reply to an earlier message in the thread.

three-dimensional  See 3D.

three-prong outlet  Don’t use. Use grounded outlet. 

throw away  Don’t use when you mean drag an item to the Trash.

Correct: After you’ve expanded the compressed file, drag it to the Trash.

Incorrect: Throw away the compressed file after you expand it.

thumb  Don’t use when you mean scroller or slider.

tilde (~)  See pathnames.

timecode  One word.

timeline  One word.

time of day  Follow these guidelines for times, unless your department uses international 
style (see Dates and times):

• Numerals: Use numerals for times of day.

2:00, 4:15, 7:30

• a.m. and p.m.: Include a.m. and p.m. (lowercase, with periods, preceded by a space)  
as needed.

10:45 a.m., 6:30 p.m.

• Noon and midnight: Use 12:00 noon and 12:00 midnight or just noon and midnight.

• Range of times: In text, it’s preferable to use to with a range of times.

10:00 a.m. to 2:00 p.m., 1:30 to 3:00 p.m.

Otherwise—for example, in an event agenda or a course listing—use an en dash 
(Option-Hyphen).

10:00 a.m.–2:00 p.m.

If times in a range are both a.m. or both p.m., the first abbreviation can be omitted or 
included, depending on the design.

1:30–3:00 p.m. or 1:30 p.m.–3:00 p.m.

Don’t use from with the en dash.

Correct: from 1:30 to 3:00

Incorrect: from 1:30–3:00
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timeout (n., adj.)  One word.

timestamp (n., v.)  One word.

time zone  Use lowercase for the names of time zones except for proper nouns.

Pacific standard time (PST), Pacific daylight time (PDT), mountain 
standard time (MST), mountain daylight time (MDT), central standard 
time (CST), central daylight time (CDT), eastern standard time (EST), 
eastern daylight time (EDT)

title bar  Two words.

titled  Not entitled.

titles, disc  See disc titles.

titles, document  See document titles.

titles of works  Use italics for the titles of books, magazines, newspapers, manuals, 
movies, videos, plays, television shows, radio shows, podcast series, blogs, music albums, 
and works of art.

Use plain text and quotation marks for the titles of works that are more limited in scope, 
such as articles, stories, reports, TV episodes, podcast episodes, sections of blogs, songs, 
chapters and sections of works, and photographs.

See also disc titles; document titles.

title-style capitalization  Capitalize each word—except for articles, prepositions of four or 
fewer letters, and so on. See also capitalization.

titles, window  See window titles.

to-do (adj.)  Note hyphen: to-do list. Don’t use as a noun.

Today View  Don’t precede with the.

Drag the widget to a new location in Today View.

toggle (v.)  OK to use in developer materials. Don’t use in user materials; instead, say turn 
on or off, switch between, or whatever wording is appropriate in the context.

See also switch (v.).

toolbar  One word.

toolkit  One word.

tooltip  Don’t use, except in developer materials; use help tag instead. See also help tag.

Torx screwdriver  Not Torex or Torque.

TOSLINK  Note spelling. A connector used in optical digital audio cables.

touch and hold  Refers to the act of touching a touchscreen and leaving the finger 
motionless until an action or result occurs.

Touch and hold the Mute button to hold a call.

Don’t use tap and hold. Don’t use long press in user materials (it’s OK in developer materials).

See also click and hold; gestures; long press (n.), long-press (adj.); tap (n., v.).
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Touch Bar  A narrow Multi-Touch surface above the keyboard on some portable Mac 
computers. Don’t shorten to the Bar. Refer generically to items in the Touch Bar as 
controls, items, or tools. Items are in (not on) the Touch Bar. Use standard Multi-Touch 
gestures (including tap, swipe, drag, and touch and hold) to describe how users interact 
with the Touch Bar. Users don’t press the Touch Bar.

You can use the controls in the Touch Bar to play and pause a movie.

Tap Edit in the Touch Bar.

Drag the scrubber in the Touch Bar.

You can also simply say use the Touch Bar to point users to a Touch Bar method of doing  
a task.

To change the color of the selected object, click a color in the color 
well, or use the Touch Bar.

See also Control Strip; gestures; Touch ID.

Touch ID  A fingerprint identity sensor built into some iOS and iPadOS devices and 
portable Mac computers. The Touch ID sensor is integrated into the Home button on iOS 
and iPadOS devices or the power button on a Mac. In most cases, use Touch ID sensor to 
refer to where users place their finger when they use Touch ID; use Home button or power 
button to refer to the button when you’re not discussing its Touch ID function.

To add your fingerprint, place your finger on the Touch ID sensor.

Click the Apple Pay button, and then use Touch ID to complete  
the payment.

To put your computer to sleep, press the power button. [Not press  
the Touch ID sensor]

touchscreen  One word.

Touch surface  The touch-sensitive upper half of the Siri Remote. You press the Touch 
surface, rather than tap or click.

Press left or right on the Touch surface to skip backward or forward.

Swipe up on the Touch surface to reveal more information.

To access contextual (shortcut) menus, press and hold the  
Touch surface.

See also Apple TV Remote; Siri Remote.

touch-tone (adj.)  Note hyphenation.

toward  Not towards.

trackball  One word.

track list  Two words.

trackpad  One word.
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trademarks (credit lines and symbols)  The name of any trademarked Apple product 
or service mentioned in a document must appear in the appropriate credit line on the 
copyright page. Categories include registered trademarks (®), trademarks (™), registered 
service marks (®), and service marks (SM).

Final Cut Pro is a trademark of Apple Inc., registered in the U.S. and 
other countries. [Registered trademark]

Multi-Touch is a trademark of Apple Inc. [Unregistered trademark]

AppleCare is a service mark of Apple Inc., registered in the U.S. and 
other countries. [Registered service mark]

Apple Consultants Network is a service mark of Apple Inc. [Unregistered 
service mark]

• Third-party trademarks: Some companies have special requirements for the use of their 
trademarks in Apple documents and for the wording in a trademark notice. For a list of 
those trademarks and their notices, see the “Special and Licensed Trademarks and/or 
Copyrights” section of the Apple trademark list.

• Trademark symbols: In user and developer materials (print and electronic), don’t use 
trademark symbols for Apple trademarks in headings or text. Note that other types 
of documents, such as press releases, do use trademark symbols in text. Follow the 
guidelines for your type of documentation.

Trademark status may change with time. For the most current Apple trademarks, 
consult the Apple trademark list.

trademarks (usage)  Follow these guidelines for using trademarks in text:

• Plural form: Don’t use a trademarked name in the plural form.

Correct: If you have more than one Mac computer…

Incorrect: If you have several Macs…

• Possessive form: Don’t use a trademarked name in the possessive form.

Correct: Learn more about MacBook features.

Incorrect: Learn more about your MacBook’s features.

• Multiple-word trademarks: If a trademark is more than one word (for example, Apple TV, 
iPod touch), don’t break it across multiple lines of text. In many cases, you can use a 
nonbreaking space (Option-Space bar) to keep the name on one line.

• Third-party trademarks: For third-party trademarks, follow the usage guidelines posted 
on the Apple trademark list.

Transmission Control Protocol/Internet Protocol  See TCP/IP.

Trash  Use an article (drag the file to the Trash).

tray-loading (adj.)  Not tray-load. See also slot-loading (adj.).

troubleshoot (v.), troubleshooting (n., adj.)  One word.

TrueDepth  One word. The Apple camera system that enables Face ID.

https://www.apple.com/legal/intellectual-property/trademark/appletmlist.html
https://www.apple.com/legal/intellectual-property/trademark/appletmlist.html
https://www.apple.com/legal/intellectual-property/trademark/appletmlist.html
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True Tone  Two words. Can refer to Apple display or LED flash technology.

The True Tone display automatically adjusts to the surrounding light.

iPhone XS features a True Tone LED flash.

tune in to  Three words. See also into, in to.

turn on, turn off  OK to use when you describe power to a computer or peripheral device. 
You can also use turn on to describe enabling features such as file sharing, as in turn on 
file sharing. See also startup (n., adj.), start up (v.).

TV  Not TV set or television set. See also Apple TV.

TV monitor  Don’t use. Use video monitor or monitor. See also display (n.); monitor.

tvOS  Apple’s operating system for Apple TV. Use without an article.

Thousands of apps are available for tvOS.

See also iOS; Mac operating systems; watchOS.

tweet (n., v.)  Note lowercase.

twisted-pair cable  Note hyphenation.

two-dimensional  See 2D.

two-factor authentication  A security feature that requires users to enter a code from a 
trusted device when signing in to their Apple ID account on a new device.

two-step verification  A security feature that requires users to enter a code from a trusted 
device when signing in to an app or a service.

type (n.)  Use in general references to the text that appears on a page. Don’t use type 
when you mean font. See also font.

type (v.)  Use to describe the act of pressing keys to produce characters on the screen. 
Use code font or quotation marks to represent what the user actually types, depending on 
your department’s style guidelines.

In the Title field, type Exchange Rate per $1.

For example, type “dog” in the search field to find photos of dogs.

Use regular text font to describe generically what the user types.

Type a new timecode value and press Return.

Don’t use type in when you mean type. See also enter; press.

Type 1 font  A font that conforms to the ISO 9541 standard.

type-ahead (n., adj.)  Refers to the queuing of a user’s keystrokes until an app is ready to 
process them.

typeface  Don’t use; use font. See also font.

type size  Don’t use; use size or font size. See also font size.

type style  Don’t use; use style or font style. See also font style.
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U
UDF  Abbreviation for Universal Disk Format. For guidelines about spelling out 
abbreviations, see abbreviations and acronyms.

UFS  Abbreviation for UNIX File System, a file format available in Disk Utility that’s used 
primarily by UNIX and UNIX-based operating systems. Not necessary to spell out on first 
occurrence.

UI  Abbreviation for user interface. OK to use in developer materials. In user materials,  
use interface.

UK  No periods. OK to abbreviate or to spell out United Kingdom as a noun. Use the 
abbreviation for the adjective form.

ultra (prefix)  Close up except before a vowel.

ultrafast, ultralight, ultrasharp, ultrathin, ultrawide

ultra-efficient

unavailable  Use to describe an item—such as a menu command or an option in a dialog—
that the user can’t select or choose because certain conditions aren’t met.

The Copy command is unavailable if there’s no text selected.

See also dimmed.

uncheck  Don’t use; use deselect. See also checkbox.

unclick  Don’t use; use deselect. See also checkbox.

under  Don’t use to describe an operating system environment. Use in or with (in macOS, 
not under macOS).

Don’t use to refer to items in menus.

Correct: Use the commands in the Arrange menu.

Incorrect: Use the commands under the Arrange menu.

Don’t use to describe where things are in the interface; use below instead.

Correct: The mailboxes below On My Mac are stored on your computer.

Incorrect: The mailboxes under On My Mac are stored on your 
computer.

unhighlight (v.)  Don’t use. Use deselect for the action of clicking to remove highlighting.

unhighlighted (adj.)  Don’t use; use not highlighted. See also unselected (adj.).

Unicode  A 16-bit character encoding standard developed by the Unicode Consortium; 
used for representing characters as integers.

Uniform Resource Locator  See URL.

uninstall  OK to use uninstall and uninstaller. See also install.
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unit  Don’t use to refer to a hardware product. Use a different noun as appropriate.

Correct: Take apart the computer.

Incorrect: Take apart the unit.

Universal Disk Format  See UDF.

Universal Serial Bus  See USB.

UNIX  All caps; there’s no spelled-out version.

UNIX File System  See UFS.

unmount (v.)  In user materials, avoid when referring to making a disk or disk image 
unavailable; use alternatives such as eject or make unavailable, or describe what the user 
must do to make the disk unavailable.

Avoid: Unmount the disc when you finish using it.

Preferable: Eject the disc when you finish using it.

In server materials or materials for more technical users, it’s OK to use unmount.

In Disk Utility, select the disk you want to unmount and click Unmount in 
the toolbar.

Use this function to unmount one or more server volumes.

Don’t use unmount as an intransitive verb.

Correct: Unmount the volume.

Incorrect: The volume unmounts.

See also mount (v.); mounted (adj.).

unmounted (adj.)  In user materials, avoid when referring to a disk or disk image that isn’t 
available; use alternatives such as not available or not visible in a Finder window.

Avoid: If a disk is unmounted, you can’t access files on it until you 
mount it again.

Preferable: If a disk is unavailable, you can’t access files on it until you 
make it available again.

In server materials or materials for more technical users, it’s OK to use unmounted.

Disk Utility lists both mounted and unmounted volumes.

See also mount (v.); mounted (adj.).

unselected (adj.)  Use to describe something that’s not selected. Not deselected, 
unchecked, or dehighlighted. See also checkbox; deselect; unhighlighted (adj.).
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up arrow  Use to refer to the small arrow that users click to increase a value in a stepper.

Click the up arrow to increase the text indent.

See also stepper; Up Arrow key.

Up Arrow key  When you refer to arrow keys generically, use lowercase. When you refer  
to one or more arrow keys by name, capitalize and use the complete name. See also  
arrow keys.

update  Use to refer to a minor software release that updates a version of software, but 
doesn’t upgrade it to the next major version.

macOS Mojave 10.14.1 is an update to macOS Mojave 10.14.

Don’t use maintenance release or dot release. See also upgrade; version number. 

upgradable  Not upgradeable.

upgrade  Use to refer to a major version of a software product. For example, macOS 
Mojave is an upgrade to macOS High Sierra. See also update; version number.

upload  Reword if possible, but OK to use when you refer to copying files to a server.

Avoid using upload to refer to what iCloud does; instead, content is stored, is kept up to 
date, appears automatically, and so on.

Avoid: Every new photo you take is uploaded to My Photo Stream.

Preferable: Every new photo you take appears in My Photo Stream.

See also iCloud.

uppercase (n., adj.)  When used in conjunction with lowercase as a noun (or to modify a 
noun), use uppercase and lowercase (both words spelled out, in that order).

upside-down (adj.)  Note hyphenation.

uptime  One word.

upward  Not upwards.

URL  Abbreviation for Uniform Resource Locator, which is another term for an internet 
address. URL is pronounced “you-are-ell” and should be preceded by a, not an. In most 
user materials, use internet address or web address, not URL. For guidelines about spelling 
out abbreviations, see abbreviations and acronyms. See also internet addresses.

U.S.  Use periods except when the abbreviation appears close to other country or region 
name abbreviations that don’t use periods. Use the abbreviation as an adjective only; as a 
noun, spell out United States (except in trademark notices). To include the country name in 
a U.S.-based Apple address, use USA (no periods). See also America, American.
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USB  Abbreviation for Universal Serial Bus. Avoid as a noun. For guidelines about spelling 
out abbreviations, see abbreviations and acronyms.

USB connector types  There are several types of USB connectors (and corresponding ports):

• USB Type-A: On first mention, describe what the connector looks like (rectangular). OK 
to shorten to USB-A connector (or USB-A port).

• USB Type-B: On first mention describe what the connector looks like (square). OK to 
shorten to USB-B connector (or USB-B port).

• USB Type-C: A tiny USB connector that supports USB 3.1 and USB power delivery. OK 
to shorten to USB-C connector (or USB-C port).

user  If the audience of your document consists of users, avoid this term. Instead, address 
the reader as you.

Correct: You can make movies with effects and a soundtrack.

Incorrect: Users can make movies with effects and a soundtrack.

When the audience consists of developers or administrators, use user to refer to end users 
and you to address the developer or administrator.

You may need to prevent users from accidentally making changes.

You can give users access to the server.

User is also appropriate in the context of macOS users—for example, when you discuss the 
Users & Groups pane in System Preferences.

See also end user (n.), end-user (adj.).

user-friendly (adj.), user friendly (pred. adj.)  Note hyphenation of adjective.

user group  Not users group or user’s group.

user guide, user manual  The terms user’s guide, instructor guide, and student guide are 
alternative forms used by some Apple groups; consult your department’s style guidelines. 
See also manual.

user interface  Don’t use in user materials; use interface. See also UI.

user name  Two words.

utility  Use lowercase when utility isn’t part of a proper name or when you use it 
generically. Capitalize, and don’t use the, when the word is part of a proper name.

Use Apple Loops Utility to…

Use the Audio MIDI Setup utility to…

You can use the utility to…

utility application  OK to use when you compare utility applications to other apps; 
otherwise, use utility. See also utility.

utility program  Don’t use; use utility. See also utility.
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V
value slider  A type of slider that includes the numeric value of the parameter in the 
control. Users can drag up or to the right to increase the value, and drag down or to the 
left to decrease the value.

variables  In code and other technical notation, refers to artificial terms that are to be 
replaced by a value or symbol. In running text, use italics when you refer to a variable, and 
spell the variable just as it would appear in a syntax description.

Replace volumeName with a name of up to 12 characters.

When the words are being used as a regular English phrase, put spaces between words 
and don’t use italics.

Correct: The volume name may have up to 12 characters.

Incorrect: The volumeName may have up to 12 characters.

Incorrect: The volumeName may have up to 12 characters.

See also placeholder names; Technical notation overview.

version number  Include a version number with software names as needed—for example, 
when describing a new version of a product or comparing two versions of a product. 
Otherwise the version number can usually be omitted.

Don’t include the word version or the letter v when you refer to versions of software—for 
example, Keynote 8.3, not Keynote version 8.3.

Compressor 4 includes support for 360° video.

Final Cut Pro is the software of choice for professional video editors.

When referring to a major release number (such as macOS 10.14 or iOS 12), omit any 
trailing .0 unless it’s needed for clarity.

Pages 6.0 must be installed before you update to Pages 6.1.

• Earlier or later: Use earlier or later, rather than lower or higher or newer or older.

To use Handoff, you need iOS 8 or later.

• The letter x: Except in developer materials, don’t use x to mean “any number,” as in 
10.x; use a specific number or range of numbers.

See also latest; Mac operating systems.

versus  Not vs. Rewrite to avoid using versus when possible.

via  Don’t use unless space is tight. Instead, use by, by way of, from, through, using, or with.
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video  Note the treatment of these terms beginning with video:

video camera, video capture card, video conference, video editing, 
video game, video podcast, video tutorial

But: videotape

Don’t use a hyphen in compound adjectives that include video: video editing app.

In help for video editing apps, it’s generally preferable to use video to refer to the user’s 
source footage and movie to refer to the edited program.

Final Cut Pro can automatically sync video and audio clips in  
your project.

You can share your finished movie on the web.

Use media rather than video when referring to more than one type of media.

The first step is to import your media—your photos, video files, and 
audio files—into Final Cut Pro.

See also media, medium; movie.

video cable  Don’t use to describe a cable connecting a display or monitor to a computer; 
use display cable (for Apple displays) or monitor cable (for non-Apple displays). OK to use 
for a cable that connects audio/video equipment, such as a television or VCR. See also 
display cable; monitor cable.

video camera  Use to refer to a camera that captures motion picture images as an 
electronic video signal and doesn’t have a built-in recording device. Don’t use when you 
mean camcorder.

If you forget to focus your video camera during shooting, you may not 
be able to fix the problem in post-production.

Because most video cameras are now digital, it usually isn’t necessary to include the word 
digital, but you can use digital video camera if the context requires it.

Digital video cameras use a digital video signal rather than an analog 
video signal.

In general references, it’s OK to use just camera.

A multicamera shoot uses multiple cameras to record an event from 
different angles.

See also camcorder.

video card  Don’t use; use graphics card. See also graphics card.

video chat, video chatting (n., v., adj.)  OK to use video chat or video conference.

video conference, video conferencing (n., v., adj.)  OK to use video conference or  
video chat.
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video input, video input/output, video output (n., adj.)  You can shorten to video in, video 
in/out, and video out. Types of video input/output include component video, composite 
video, DVI, HDMI, S-video, and VGA video.

video jack  Not video connector.

video mirroring (n., adj.)  A dual-display mode in which the same image appears on two 
displays.

video port  Don’t use when you mean the port to which the display is connected; use 
display port (for Apple displays) or monitor port (for non-Apple displays). See also display 
port; monitor port.

video random-access memory  See VRAM.

View control  The four-button unit for changing views of Finder windows. The View control 
contains the Icon View button, the List View button, the Column View button, and the 
Gallery View button. See also Column View button; Gallery View button; Icon View button; 
List View button.

viewer window  In the Mail app in macOS, the main window where mailboxes and messages 
appear. On first occurrence, call it the Mail viewer window; for later references, use the 
viewer window.

virtual machine  Note lowercase.

virtual memory  Not Virtual Memory or VM.

visually impaired  Avoid. See also blind, low vision; impairment; Writing about disability.

voicemail  Don’t use as a verb.

Voice Memos  Capitalize when referring to the app name. Use lowercase when referring to 
the recordings you make with the app. You can also use recordings.

To record a voice memo, open the Voice Memos app and tap Record.

voiceover, VoiceOver  Use lowercase when you refer to recorded narration; capitalize 
when you refer to the Apple screen reader.

You can record your own voiceover to add to your movie.

VoiceOver lets you navigate your device just by listening.

voice-quality microphone  Note hyphenation.

volume (disk)  A single storage area with a single file system. It typically resides on a 
single partition of a single disk, but it may span multiple disks.

In user materials, use volume only if you need to match the user interface.

• To refer generically to storage that may include different kinds of disks, just use disk.

Avoid: You can use the Find command to search for items on all volumes 
connected to your computer.

Preferable: You can use the Find command to search for items on all 
disks connected to your computer.

• To refer to a specific kind of disk, use hard disk, solid-state drive, or flash storage.
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• For special audiences, such as administrators, use volume if a precise distinction 
between the logical (volume) and physical (partition) aspects of the disk is relevant and 
helpful to the reader.

Don’t rename a NetBoot share point or the volume it resides on.

Xsan SAN storage appears to clients as one or more volumes that 
behave like local disks.

See also disk.

Volume Down key, Volume Up key  Note capitalization.

volume license, volume licensing  No hyphen.

VPN  Abbreviation for virtual private network or virtual private networking. For guidelines 
about spelling out abbreviations, see abbreviations and acronyms.

VRAM  Acronym for video random-access memory. Pronounced “VEE-ram.” For guidelines 
about spelling out acronyms, see abbreviations and acronyms.

vs.  Don’t use; use versus when absolutely necessary, but rewrite to avoid the term  
when possible.

W
wait cursor  See spinning wait cursor.

Walkie-Talkie  A watchOS app. Don’t use as a verb; say use Walkie-Talkie, have a Walkie-
Talkie conversation, or similar.

WAN  Acronym for wide area network. Note no hyphen in the spelled-out version. For 
guidelines about spelling out acronyms, see abbreviations and acronyms.

want  Make sure that an object follows the verb want.

Correct: Make a copy if you want a duplicate. [The word duplicate is  
the object.]

Correct: Sign up if you want to attend. [The infinitive, to attend, is  
the object.]

You can often avoid the issue entirely. For example, If you want to introduce alternative 
methods can be changed to To introduce alternative methods.

warm start (n.), warm-start (adj.)  Note hyphenation of adjective.

Warning  Use a Warning notice when the reader needs to know that an action may cause 
bodily injury, damage to hardware or software, or loss of data.

Use warnings and other notices sparingly. They lose their effectiveness if they appear too 
often. Don’t use a Warning notice immediately before or after a note, an Important notice, 
or another Warning notice, or immediately after a text heading.

See also Important; Note.
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watch face  Use to refer to what you see when Apple Watch is displaying a watch. Don’t 
shorten to face.

Correct: With the watch face showing, press the display.

Incorrect: You can add stock info to the face.

In most cases, don’t say press the watch face; users press the display while viewing the 
watch face. See also display (n.).

watchlist  One word when referring to the list of stocks in the Stocks app.

watchOS  The operating system for Apple Watch.

waveform (n., adj.)  One word.

wavelength (n.)  One word.

we  Don’t use first person; rewrite in terms of the reader or the product.

Correct: For best results, the image should be at least 600 x 600 pixels.

Incorrect: We recommend that the image be at least 600 x 600 pixels.

See also recommend.

web  Short for World Wide Web. You go to, visit, or view pages on the web. Note the 
treatment of terms beginning with web:

webcam, webcast, webcasting, weblog, webmail, webmaster,  
webpage, website

web authoring, web browser, web camera, web clip, web publishing, 
web server

Don’t use web and internet interchangeably; the web is just one part of the global internet.

See also internet addresses; World Wide Web.

web addresses  See internet addresses; URL; webpage.

web clip  Capitalize when referring to the Dashboard widget; otherwise, use lowercase.

webpage  One word. A self-contained document that can be viewed on a website. A single 
website can contain many webpages. You connect to (or go to) a page; you’re then at that 
page. Text, graphics, and links, however, are on the page.

Don’t use website and webpage interchangeably.

See also homepage; internet addresses; website.

website  Refers to a collection of webpages stored in a particular location.

A website may be organized into several parts, sections, or areas, each of which may 
contain more than one page. Use part, section, or area to refer to such an entity. Use page 
to refer to a single webpage. Use website to refer to the entire collection.

You can browse, visit, or go to a website, but don’t use such phrases as point your browser 
at the website and surf the website.

See also homepage; webpage.
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well-behaved  Don’t use to describe software; use compatible, well-constructed, and  
the like.

wheelchair user  OK to use to describe a person in a wheelchair; also OK to say a person  
in a wheelchair or a person who uses a wheelchair. Don’t use wheelchair-bound, confined 
to a wheelchair, or handicapped. See also Writing about disability.

whether  See if, whether.

which  Use only to introduce a nonrestrictive clause; clauses beginning with which are 
always set off with commas.

The newest computer in the lab, which is a Mac Pro, is also the 
students’ favorite. [There’s only one newest computer; the phrase 
which is a Mac Pro, although it provides more information, doesn’t 
restrict the subject of the sentence.]

This is the computer that has network access. [There are many 
computers; the phrase that has network access restricts—narrows the 
meaning of—the subject of the sentence to one computer.]

See also that.

while, although, whereas  While means during the time that and implies concurrent 
activities. Use although to mean in spite of the fact that. Use whereas to mean it being the 
fact that or while on the contrary.

Correct: Although the clip won’t play back at 1x (normal) speed, every 
frame plays back, with no frames dropped.

Incorrect: While the clip won’t play back at 1x (normal) speed, every 
frame plays back, with no frames dropped.

Correct: SD video uses interlaced scanning, whereas HD formats may 
use either interlaced or progressive scanning.

Incorrect: SD video uses interlaced scanning, while HD formats may use 
either interlaced or progressive scanning.

whir  Not whirr. But whirring.

The disk drive whirs, and in a moment the startup screen appears.

whitelist  Don’t use. See also blacklist/whitelist (n., v.).

who, whom  Who should always be used as the subject of a verb or as a subject 
complement. Whom should always be used as the object of a verb or preposition.

Who is the new system administrator?

This manual is intended for the person who manages the network.

Be selective about the people to whom you give network access.
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wide  Use a hyphen in compound adjectives beginning with wide.

wide-angle viewing, wide-format screen

Exception: widescreen

Close up words that end with wide.

companywide, enterprisewide, industrywide, systemwide, worldwide

If part of the compound is a proper noun, use a hyphen: Apple-wide.

wide area network  See WAN.

wide color gamut (n.), wide-color-gamut (adj.)  A video color space capable of 
reproducing a broader palette of colors than legacy (standard color gamut) color spaces. 
OK to shorten to wide gamut (n.) and wide-gamut (adj.) if the context is clear.

widescreen (adj.)  One word.

widget  Capitalize the names of widgets.

To customize the Weather widget…

To add a Stocks widget to Notification Center…

Wi-Fi  Not wifi, wi-fi, or WiFi.

wiggle  Don’t use to describe the movement of icons on a screen; use jiggle. See also jiggle.

wiki  A collaborative website that can be modified by members of a group.

window  In user materials, use window for these interface elements:

• Document windows

• Main app windows, such as Finder windows and the viewer window in Mail

• Windows with controls or options that affect the active document or selection, such as 
the Equalizer window in the Music app and the Fonts window (common to many apps)

All windows have a functional close button in the title bar.

Don’t use window to refer to interface elements in iOS. Instead, simply describe what  
the user must select or do. If necessary, you can use alternative words such as list. See 
also popover.

Correct: To see more table styles, scroll left or right.

Incorrect: To see more table styles, scroll left or right in the  
Tables window.

Correct: Tap an item in the search results list.

Incorrect: Tap an item in the search results window.

See also dialog; pane.

window controls  Standard controls for windows include the close button, the minimize 
button, and the maximize button.

Windows  See Microsoft Windows.
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Windows-based (adj.), Windows based (pred. adj.)  Refers to computers that use 
Microsoft Windows. See also Microsoft Windows; PC.

window titles  When you refer to a window by name, use the exact words in the title bar 
of the window (the Mail window, the About This Mac window). Use lowercase for window 
(unless it’s included in the window title and capitalized).

wired  Equipped with or connected by wires or cables. Related terms include wired 
connections, wired keyboard, wired mouse, wired networking, wired remote, and so on.

wireless-enabled  Not wirelessly-enabled.

wish  Don’t use; use want. See also want.

word processing (n.), word-processing (adj.)  Note hyphenation of adjective.

words as words  Italicize a word when it’s used as a word. Use an apostrophe and an s to 
form the plural, but don’t italicize the apostrophe or the s.

He had too many and’s in the sentence.

See also letters as letters.

word wrap  Not wraparound or word wraparound. In documentation written for new users, 
however, you may want to mention the term wraparound or include it in a glossary because 
users may see it elsewhere.

work  Close up the following words beginning with work:

workflow, workforce, workgroup, workplace, workshop, workspace, 
workstation

workflow  One word.

workspace  Don’t use as a synonym for desktop or Finder.

workstation (n., adj.)  Don’t use when you mean desktop computer. OK to use when you 
discuss network administration.

Worldwide Developers Conference  See WWDC.

World Wide Web  In most cases, just use the web. When you do use World Wide Web, 
don’t abbreviate as WWW. See also internet, Internet; web.

wraparound (n.)  Don’t use; use word wrap. See also word wrap.

write  Avoid using as a verb in user materials; use copy or burn. In developer or server 
materials, the following are acceptable: write to a disk, write to disk, write on a disk. Don’t 
use write a disk.

User materials: Copy the files to your computer.

Developer materials: The app needs to write to the disk.

Server materials: Give the user permission to write to the disk.

See also burn.

WWDC  Abbreviation for Worldwide Developers Conference. For guidelines about spelling 
out abbreviations, see abbreviations and acronyms.

WWW  Don’t use as an abbreviation for World Wide Web. Use web instead.
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X
x  Follow these guidelines when you use the letter x to stand for something else:

• Screen resolutions: Use a lowercase x in screen resolutions.

1024 x 768 [Note the space before and after the x.]

• As a placeholder (variable): When you use x as a placeholder for replaceable numbers, 
the x is lowercase and in regular text.

$02xx [The x’s represent a range of memory addresses.]

• For a range of version numbers: Except in developer materials, don’t use x to  
express a range of software version numbers, as in 10.x; use a specific number or  
range of numbers.

• To designate speed: For the speed of optical drives, use a lowercase x—for example, 
24x speed. There’s no space between the numeral and the x.

See also dimensions; version number.

x and y axes  See also x-axis; y-axis.

x and y coordinates  No hyphen. See also x-coordinate; y-coordinate.

x-axis  Note hyphenation. See also x and y axes.

x-coordinate  Note hyphenation. See also x and y coordinates.

Y
Y-adapter  Note hyphenation.

y-axis  Note hyphenation. See also x and y axes.

y-coordinate  Note hyphenation. See also x and y coordinates.

Z
zero character  OK to use for the ASCII character $30. Don’t confuse with null character 
($00).

zeros  Not zeroes.

zip code  Note lowercase.

zoom, Zoom  Use lowercase when referring to the action of zooming. It’s OK to use zoom, 
zoom in, zoom in on, zoom in to, zoom out, and zoom out of.

You can pinch to zoom in on apps, photos, and other items on iPad.

Capitalize when referring to the feature.

Use Zoom to magnify what’s on the Apple Watch display.
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Writing inclusively

Overview
The people who use Apple products reflect the diversity of the world at large. This chapter 
provides guidelines and tips for how you can write consciously to include everyone.

Note: Guidance about inclusive writing may change over time, so check back for updates. 
Also keep in mind that inclusive language may vary slightly in different locales, so you may 
need to adapt the principles here to the unique needs of your language or region.

General guidelines

Think inclusively.
As you write, think about your potential audience, and try to imagine your content from 
their perspective. Will the words and phrases you use be understood by everyone? Do 
these words and phrases have any harmful or negative associations?

Keep in mind that words can sometimes carry meanings you don’t intend. Be open to 
learning about the impact of language, and be respectful of those who may receive words 
differently from how you intended them.

Research words.
Investigating the history and usage of a word can help you decide whether to use it. For 
example, some common expressions (like grandfathered in) arose from oppressive or 
exclusionary contexts. If you’re unsure about a word or expression, be sure to research 
both how it originated and how it’s understood by people now.
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Consider the context.
Even if a common word has one negative use that you should avoid, it may still be 
acceptable in other contexts. For example, although it’s inappropriate to use mute to refer 
to a person who is nonspeaking, it’s OK to use it to refer to silencing a device. Take context 
into account when making wording decisions.

Avoid terms that are violent, oppressive, or ableist.
Don’t describe technology using terms that are inherently violent—like kill or hang. Don’t 
use the terms master and slave, which describe an oppressive human relationship. Finally, 
don’t use terms like sanity check, which associates mental health with being functional.

In general, it’s a good idea to avoid describing software or hardware using human or 
biological attributes; doing so can lead to unintended hurtful implications.

Avoid idioms and colloquial expressions.
Common sayings—like fall through the cracks, on the same page, or backseat driver—
can add flavor to writing, but they can also be difficult to understand for people who are 
learning the language. If your content is localized, using phrases like these can also make it 
more difficult to translate.

Don’t use color to convey positive or negative qualities.
Avoid assigning good and bad values to colors (for example, blacklist, white hat hacker, or 
red team hacker) or using colors as metaphors to convey larger concepts. Use colors only 
to describe actual colors (for example, black text on a white background, the white point of 
a display).

Err on the side of caution.
If you’re not sure about a term, but you believe it might be questionable based on your 
research or feedback from others, then choose a different term. The beauty of language is 
that there’s usually a term that expresses the meaning you want to convey just as well—or 
even more clearly.
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Inclusive representation
Remember that the people who use Apple products have a broad variety of life 
experiences, cultures, and backgrounds. When your content depicts people—real or 
fictional—make sure to represent the diversity of the world.

Use diverse names as examples.
Sometimes you may use names as examples. Include names that reflect a variety of 
ethnicities and genders.

Given name examples: Blair, Etienne, Guillermo, Lee, Mayuri, Priyanka, 
Shannon, Yen

Family name examples: Kawashima, Lai, McNeil, Melnykova, Salinas, 
Sears, Zhao

Also keep in mind that some cultures don’t use a Western-style name structure (given 
name followed by a family name). In addition, some cultures may use multiple family 
names. Try to reflect this diversity in your examples.

Avoid biases and stereotypes.
Bias is a tendency to think and behave in ways that are favorable (or unfavorable) to certain 
people or communities. Be aware of ways your content may unintentionally reinforce 
biases, and consciously work to avoid doing so. For example:

• If your content uses text or imagery to depict people in certain occupations or settings, 
include a variety of ethnicities, genders, ages, body types, and abilities.

• If your content mentions examples of holidays, foods, or sports, don’t just give 
examples from Western culture.

• Avoid using examples that reflect primarily an affluent lifestyle.

A stereotype is a fixed belief about people or groups based on identifying characteristics, 
like gender, race, physical capability, or age. Avoid stereotypes in how people are 
presented in your content. For example, don’t only represent a family as a woman, a man, 
and their biological children; remember to include a variety of family types.
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Gender identity
Because not everyone identifies as male or female, avoid binary representations of gender 
when you can reword using gender-neutral language.

Avoid: Hiring men and women of diverse backgrounds fosters a culture 
of innovation.

Preferable: Hiring people of diverse backgrounds fosters a culture  
of innovation.

It’s fine to refer to specific genders if the context requires it.

The percentage of female employees has increased.

Women should earn the same as men for comparable work.

Use gender-neutral pronouns.
Don’t use gender-specific pronouns (such as he, she, he or she, and so on) to refer to 
people of unspecified gender. Instead, it’s OK to use they, their, or them as a singular, 
gender-neutral pronoun.

Correct: A subscriber can post their recipes to your shared folder.

Incorrect: A subscriber can post his or her recipes to your shared folder.

You can also avoid gender-specific pronouns by rewriting a sentence—for example, using 
the plural form of the noun (subscribers can post their recipes), or simply omitting the 
pronoun (a subscriber can post recipes).

If you refer to a specific person, don’t make assumptions about which pronouns to use 
based on the person’s name or appearance. If you’re unsure how to refer to someone,  
you can ask them. Individuals may go by he/him, she/her, they/them, other pronouns,  
or no pronouns.

Use gender-neutral titles and honorifics when appropriate.
Some people may choose to use a gender-neutral title (such as Mx.). If you’re writing 
content about (or addressed to) a real person, and your style requires you to include a title, 
ask the person what title they use. If you can’t ask them, consider adopting a style that 
refers to people using only their name.



208Apple Style Guide

Writing about disability
When you write about people with disabilities, keep the focus on talents, skills, and 
accomplishments—just as you would for anyone you write about. You may not even need 
to mention someone’s disability unless it’s essential to the content; if you do refer to 
someone’s disability, follow the guidelines below.

Put people first.
In most cases, use people-first language when referring to people with disabilities. This 
means describing and talking about individuals as people before mentioning any disability 
they may have.

Avoid: Blind people

Preferable: People who are blind or have low vision

Avoid: A wheelchair-bound person

Preferable: A person in a wheelchair, a person who uses a wheelchair

Note: Members of some disability communities may consider their disabilities to be part 
of their identity, so they choose language that places an emphasis on culture first. For 
example, some people may prefer disabled to a person with a disability, or Deaf to a person 
who is deaf. When writing about specific individuals, always ask them how they prefer to 
be identified. See A guide to terms about disability, below.

Acknowledge a wide range of disability.
It’s helpful to think about disability on a spectrum. For example, with blindness, there’s a 
wide range of vision differences—from people who are born blind, to those with low vision, 
to others with loss of vision in certain areas, such as peripheral vision. In addition, some 
people may have multiple disabilities.
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Write about people with disabilities as you would 
about anyone.
When you write about a person with a disability, focus on their life, their personality and 
interests, or what they’ve created or accomplished—aside from their disability. Don’t 
treat disability as something to overcome, and don’t describe people with disabilities as 
brave, courageous, or inspiring. In general, people with disabilities want to be treated like 
everyone else.

Avoid language that refers to using specific senses.
When writing instructions (such as in training manuals or user guides), avoid using phrases 
that refer to the use of specific senses, like you see a message, you see a flashing light, or 
you hear an alert sound. Instead, simply describe what happens: A message appears,  
a light flashes, an alert sound plays.

Also avoid using idioms that send negative messages about disability—for example, that’s 
crazy, fell on deaf ears, or turned a blind eye to.

Some phrases and idioms are OK.
It’s OK to use commonly understood phrases such as the ones below:

I see your point.

You can watch your favorite movies on the Apple TV app.

Hear about the latest news right when it happens.

Don’t hesitate to speak your mind.

Even if people in your audience can’t see, hear, or speak, they’ll typically understand the 
intent of the words.

It’s also OK to use the common cross-reference See when linking to other material  
(for example, See the Apple Support article “Set up Family Sharing”).
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A guide to terms about disability
Use the table below as a general guide when writing about disability.

Note: Members of some disability communities may consider their disabilities to be part  
of their identity, so they choose language that places an emphasis on culture first. When 
you write about specific people with disabilities, be sure to find out how they prefer to  
be identified.

OK to use Don’t use

A person with disabilities

People with disabilities

Note: A disabled person (or disabled people) may also 
be acceptable to people who consider their disability 
part of their identity. If you’re writing about someone 
specific, ask them what they prefer.

Differently abled

Special needs

Special abilities

Handicapable

Person without a disability

Nondisabled person

Sighted person

Hearing person

Normal

Healthy

Regular

Able-bodied

Person who is blind

Person who has low vision

Note: Some organizations and communities may still 
use the term visually impaired. If you’re writing about 
someone specific, ask them what they prefer.

A blind person

Person who is deaf

Person who is hard of hearing

People who are deaf or hard of hearing

A deaf person

Hearing impaired

Note: It’s OK to use a Deaf person or the Deaf community 
(with a capital D) to refer to those who identify culturally 
as Deaf. If you’re writing about someone specific, ask 
them how they prefer to be identified.

Deafblind

Deafblindness

Note: Some communities capitalize the B—DeafBlind, 
DeafBlindness. If you’re writing about someone 
specific, ask them what spelling they prefer.

Deaf and dumb

Deaf-mute

Person who uses a wheelchair

Person in a wheelchair

Wheelchair user

Wheelchair-bound

Confined to a wheelchair

Handicapped

Person who is nonspeaking

Person who is nonverbal

Note: The terms above have distinct meanings; if 
you’re writing about someone specific, ask them how 
they prefer to be identified.

Mute
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Units of measure

Units of measure overview
This chapter provides usage guidelines for units of measure and lists abbreviations and 
symbols for frequently used units.

Follow these guidelines when you use units of measure in documentation:

• When to spell out: In user documentation, spell out units of measure and give the 
abbreviation in parentheses on first occurrence. Repeat the spelled-out version in new 
sections and chapters if the unit symbol or abbreviation is obscure and if the audience 
requires it.

20 gigabytes (GB) of memory

Subsequent occurrences: 20 GB of memory

Always spell out nonmetric units of measure in text (for example, 17-inch display). It’s 
OK to abbreviate such units in tables and technical specifications (Display size: 17 in.).

• Noun: When you use a unit symbol or abbreviation as a noun, insert a space between 
the number and the abbreviation, and use the preposition of before the unit the  
value quantifies.

20 GB of memory

Note that Apple Marketing Communications style for many abbreviations is to close up 
the number and the abbreviation (20GB of memory).

• Adjective: When you use a spelled-out unit of measure in a compound adjective, 
hyphenate the compound.

17-inch display

3-meter cable

When you use a unit symbol or abbreviation in a compound adjective, don’t hyphenate; 
add a space between the number and the abbreviation.

20 nA battery

30 GB capacity

• Capitalization: With the exception of degrees Celsius, Fahrenheit, and Rankine, units of 
measure derived from a proper name aren’t capitalized when spelled out, but their unit 
symbols are capitalized. (For example, the unit symbol for joule is J.)
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• Plurals: Unit symbols and abbreviations are unaltered in the plural forms (for example, 
lb., not lbs.).

• International System of Units: Use the unit symbol for units of the International System 
of Units (SI) after first occurrence. If the unit symbol for meter could be confused with 
another term in your document, spell out meter.

The maximum size for a memory card is 35 mm.

The Ethernet cable is 40 meters long.

Don’t use a period after an SI unit (unless the unit appears at the end of a sentence).

• Mixing symbols and names: Don’t mix unit symbols and names (m/second) or unit 
symbols and abbreviations (J/sec.). Don’t mix a prefix name with a unit symbol (kiloHz), 
or a prefix symbol with a unit name (khertz).

Prefixes for units of measure
Factor Prefix Symbol or abbreviation

1024 yotta Y

1021 zetta Z

1018 exa E

1015 peta P

1012 tera T

109 giga G

106 mega M

103 kilo k

102 hecto h

101 deka da

10–1 deci d

10–2 centi c

10–3 milli m

10–6 micro µ

10–9 nano n

10–12 pico p

10–15 femto f

10–18 atto a

10–21 zepto z

10–24 yocto y
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Names and unit symbols for units of measure
In the following table, when a unit symbol includes a nonalphanumeric character, the 
keystrokes that generate the character are included in brackets after the unit symbol  
or abbreviation.

Unit Unit symbol or abbreviation Quantity

ampere A electric current

ampere-hour Ah rate of delivery of electricity

ampere-second. See coulomb.

amperes per meter A/m magnetic field strength

amperes per square meter A/m2 current density

amperes per volt. See siemens.

angstrom (10–10 meters) Å [Option-Shift-A] optical wavelength

attoampere (10–18 amperes) aA electric current

baud (signal events per second) Bd speed of data transmission

bel (10 decibels) B sound intensity

bit bit size of data

bits per second bit/s speed of data transmission

byte B size of data

candela cd luminous intensity

candela per square inch cd/sq. in. luminance

candela per square meter cd/m2 luminance

centimeter cm length

characters per inch cpi letter spacing (in type)

coulomb (ampere-second) C electric charge, quantity of 
electricity

coulombs per volt. See farad.

cubic centimeter cm3 volume

cubic foot cu. ft. volume

cubic inch cu. in. volume

cubic meter m3 volume

cubic yard cu. yd. volume

cycle c complete execution of a periodically 
repeated phenomenon

cycles per second. See hertz.
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Unit Unit symbol or abbreviation Quantity

day d time

decibel (0.10 bels) dB sound intensity

degree ° [Option-Shift-8] angular measure

degree Celsius ° C [Option-Shift-8] temperature

degree Fahrenheit ° F [Option-Shift-8] temperature

degree K=kelvin. See kelvin.

degree Rankine ° R [Option-Shift-8] temperature

dots per inch dpi resolution

electromotive force emf energy derived from electrical 
source per unit quantity of 
electricity

electron volt eV energy

farad (coulombs per volt) F capacitance

foot ft. length

gallon gal. volume

gigabit Gbit computer memory

gigabits per second Gbit/s (standard)

Gbps (some Apple groups)

speed of data transmission

gigabyte GB computer memory

gigabytes per second GB/s speed of data transmission

gigahertz GHz frequency

gilbert Gb magnetomotive force

gram g mass, weight

grams per cubic centimeter g/cm3 density

henry H inductance

hertz (cycles per second) Hz frequency

horsepower HP power

hour h time

inch in. length

joule (kilogram-meter) J energy

joules per second. See watt.

kelvin K thermodynamic temperature

kilobit (1000 bits) kbit computer memory
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Unit Unit symbol or abbreviation Quantity

kilobits per second kbit/s (standard)

kbps (some Apple groups)

speed of data transmission

kilobyte (1024 bytes) KB computer memory

kilobytes per second KB/s speed of data transmission

kilogram kg mass, weight

kilogram-force centimeter kgf cm torque

kilogram-meter. See joule.

kilogram-meters per second 
squared. See newton.

kilograms per cubic meter kg/m3 density

kilohertz kHz frequency

kilohm kΩ [Option-Z] electric resistance

kilometer km length, distance

kilometers per hour km/h velocity

kilowatt (kilovolt-ampere) kW power

kilowatt-hour kWh energy (usually electric power 
consumption)

lines per inch lpi resolution

liter l volume

liters per second l/s change in volume over time

lumen lm flux of light

lux lx illumination

megabit Mbit computer memory

megabits per second Mbit/s (standard)

Mbps (some Apple groups)

speed of data transmission

megabyte MB computer memory

megabytes per second MB/s speed of data transmission

megahertz MHz frequency

megapixel MP resolution

meter m length, distance

meters per second m/s velocity

micrometer (10–6 meters) µm [Option-M] length

micron. See micrometer.

mil (10–3 inches) mil length
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Unit Unit symbol or abbreviation Quantity

mile mi. [except in mph] length, distance

miles per hour mph velocity

millimeter (10–3 meters) mm length

million instructions per second MIPS microprocessor speed

millisecond (10–3 seconds) ms time

millivolt (10–3 volts) mV electric potential

milliwatt (10–3 watts) mW power

minute min. time

month mo. time

newton (kilogram-meters per 
second squared)

N force

newtons per square meter. See 
pascal.

ohm Ω [Option-Z] electric resistance

ounce oz. volume, weight

pascal (newtons per square meter) Pa pressure, stress

petabyte PB computer memory

point pt font size

pound lb. weight

poundal pdl. force

radian rad plane angle

radians per second rad/s angular velocity

radians per second squared rad/s2 angular acceleration

revolutions per minute rpm angular velocity

second s (unit symbol) or sec. 
(abbreviation)

time

siemens (amperes per volt) S conductance

square foot sq. ft. area

square inch sq. in. area

square meter m2 area

square mile sq. mi. area

square yard sq. yd. area

steradian sr solid angle

terabit Tbit computer memory
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Unit Unit symbol or abbreviation Quantity

terabits per second Tbit/s (standard)

Tbps (some Apple groups)

speed of data transmission

terabyte TB computer memory

terabytes per second TB/s speed of data transmission

tesla (webers per square meter) T magnetic flux density

ton tn. or ton mass, weight

volt V electric potential difference, 
electromotive force

volt-ampere. See watt.

volts (point-to-point) Vpp electric potential

volts (root mean square) Vrms electric potential

watt (joules per second) W power

watt-hour Wh energy

weber Wb magnetic flux

webers per square meter. See tesla.

yard yd. length, distance

year yr. time
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Technical notation

Technical notation overview
This chapter gives special style and usage rules that apply largely or exclusively to 
developer documentation.

When writing about a particular programming language, be careful to follow the 
capitalization style of that language.

Code
Use code font for code.

Develop a method of spacing around punctuation and use the method consistently. It’s 
often best to use “English-style” spacing (one space character between words) because 
it’s easy to remember and to stick with.

(height, width: extended; quo: integer); PageSize = 1024

Syntax descriptions
Use code font for literals (parts of the language, values, and so on), italics for placeholder 
names, and regular text for the brackets that enclose something that’s optional. Pay close 
attention to punctuation.

Read ([file, ] var)

Use embedded caps to connect words that act as a single placeholder name (sourceFile).

Be consistent when naming placeholders; for example, don’t alternate between commands 
and commandList.
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Code font in text
Most developer documentation uses code font for computer-language elements in text. 
Whether to use code font in text for other documents is a matter of judgment.

• Use code font for all text fragments that represent expressions in a programming 
language.

• Use code font for names of files, volumes, directories, and libraries.

StandardCRuntime.o library

MainProg.c file

• Don’t use a function or method name as a verb.

Correct: Run ls on both directories.

Incorrect: ls both directories.

Correct: Use cd to change to the root directory.

Incorrect: cd to the root directory.

• Don’t mix fonts within a single word. Rewrite to avoid forming the plural of a word in 
code font.

Correct: values of type integer

Incorrect: integers

• Use regular text font, not code font, for punctuation following a word or phrase in 
code font, unless the punctuation mark is part of the computer-language element 
represented.

NAN(004), nan(4), and NaN are examples of acceptable input.

Placeholder names in text
In running text, use italics when referring to a placeholder name (that is, an artificial term 
that has meaning only in your documentation and is to be replaced by a value or symbol). 
Spell the name just as it would appear in a syntax description. Don’t use a placeholder as 
you would use a regular English term.

Correct: Replace volumeName with a name of up to 12 characters.

Correct: The volume name can be up to 12 characters long.

Incorrect: The volumeName can be up to 12 characters long.

Avoid foo, bar, and baz to represent hierarchical or ordered placeholder names in code 
examples. Instead, use names that suggest the kind of item.

TObject.FirstMethod

TObject.SecondMethod
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International style

International style overview
Following international style helps readers with limited English proficiency read what you 
write. By following international style, you also help translators—human or machine—
localize your writing by minimizing the burdens of cultural and customary language usage.

Writing in the international style means that you write simply and that you express yourself 
using standard international conventions. These are the basic rules:

• Write in simple structures.

• Don’t use idiomatic or colloquial expressions.

• Avoid shortcuts, symbols, and abbreviations that could easily be spelled out.

• Express data using the standard international conventions outlined in this chapter. You 
should vary from these standards only when there’s a truly compelling advantage in 
using a proprietary or customary style.

For more information about standard international conventions, visit the websites listed in 
this chapter.

Countries
Country names are represented by a two-character code.

• International authority: International Organization for Standardization (ISO),  
http://www.iso.org

• Standard: ISO 3166

• Usage: Countries are represented by a two-character code in a table, column, or row 
that clearly indicates that the code represents a country.

http://www.iso.org
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The following table shows examples of country codes.

Code Country

DE Germany

ES Spain

FR France

IT Italy

JP Japan

MX Mexico

US United States

Currency
Currency amounts are expressed with a three-letter currency code.

• International authority: International Organization for Standardization (ISO),  
http://www.iso.org

• Standard: ISO 4217

• Rationale: Currency codes are specific to a currency and can’t be confused or 
misinterpreted by the reader. Currency symbols such as the dollar sign ($) aren’t unique 
and are easily misread.

• Usage: Write the amount followed by a space and the currency code in capitals.

The computer is priced at 1199 USD.

The computer costs 1980 EUR.

The following table shows examples of currency codes.

Code Currency

CAD Canadian dollar

EUR euro

GBP pound sterling

JPY yen

USD U.S. dollar

http://www.iso.org
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Dates and times
Dates are expressed as year, month, day and are separated by a hyphen. Times are 
expressed on a 24-hour clock.

• International authority: International Organization for Standardization (ISO),  
http://www.iso.org

• Standard: ISO 8601

• Rationale: Date and time formats are represented with the largest units given first. From 
left to right the ranking is year, month, week, day, hour, minute, second. This standard, 
in addition to being used in many Asian languages, solves ambiguities in the date 
notations used in Canada, the United States, and the United Kingdom.

• Usage: Dates are expressed numerically as year, month, day and are separated by a 
hyphen. Times are expressed on a 24-hour clock. A colon separates hours, minutes, 
and seconds. Coordinated Universal Time (UTC) times are expressed as “Z.” Local time 
zones are expressed as the number of hours from UTC.

The Apple Watch Series 6 was introduced on 2020-09-15.

The file will be posted at 18:00Z.

The file will be posted at 18:00 PST (UTC–8).

Decimals
Decimals are expressed by a period or comma. For numbers larger than 999, don’t  
use a period or comma as a separator. A nonbreaking space (Option-Space bar) may  
be used instead.

• International authority: Bureau International des Poids et Mesures (BIPM),  
http://www.bipm.org

• Standard: BIPM SI Brochure

• Rationale: Breaking up large numbers makes them easier to read, especially in tables.  
A nonbreaking space can’t be misinterpreted as a decimal marker.

• Usage: Use a period to produce a decimal in English. Numbers may be divided in groups 
of three on either side of the decimal to make them easy to read. Use a nonbreaking 
space instead of a period or comma to divide numbers. Express large numbers in their 
smallest form to make them easier to read.

A kilobyte is 1024 bytes.

Apple sold 300 000 iMac computers in the first quarter.

Apple sold 3.7 million iMac computers in 2 years.

http://www.iso.org
http://www.bipm.org


223Apple Style Guide

Languages
Language names are represented by a two-character code.

• International authority: International Organization for Standardization (ISO),  
http://www.iso.org

• Standard: ISO 639

• Usage: Languages are represented by a two-character code in a table, column, or row 
that clearly indicates that the code represents a language.

The following table shows examples of language codes.

Code Language

de German

en English

es Spanish

fr French

it Italian

jp Japanese

nl Dutch

mul Multiple languages

In some cases, you may need to append an extension to the code to represent a particular 
Apple localization.

Code Language

en-GB British English

zh-CN Simplified Chinese

zh-TW Traditional Chinese

http://www.iso.org
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Telephone numbers
Telephone numbers begin with the plus sign and are followed by the country code, the 
city code, and the number. Freephone (toll-free) numbers are expressed in the local style. 
Always give a toll number if one is available.

• International authority: International Telecommunication Union (ITU),  
http://www.itu.int

• Standard: ITU-T E.123

• Rationale: The plus sign (+) represents any number a caller must dial to get an outside 
line, like 9. The caller then dials the remaining digits. Freephone numbers are usually 
impossible to dial globally, even between Canada and the United States. Providing a 
freephone number with a toll number allows customers to call no matter where  
they’re from.

• Usage: Telephone number notations begin with the plus sign and are followed by the 
country code, the city code, and the number. Breaks in national numbering plans may 
be represented by a space. Toll-free numbers are expressed in the local style.

You can reach Apple by calling +1 408 996 1010 or 800-692-7753  
(in North America).

You can reach Apple France by calling +33 1 69 86 34 00 or  
0800 046 046.

Units of measure
Use only units of the International System of Units (SI) to express the values of quantities. 
Equivalent values in nonmetric units may be given in parentheses following SI values in 
cases where safety may be an issue, or when they’re used in a product’s name.

• International authority: Bureau International des Poids et Mesures (BIPM),  
http://www.bipm.org

• Standard: BIPM SI Brochure. United States interpretation is available from the 
Department of Commerce at http://www.nist.gov/pml/pubs.

• Usage: Quantities are always expressed with a unit symbol. Use a nonbreaking space 
(Option-Space bar) between the quantity and its symbol. Unit symbols are unaltered 
in the plural, and are never hyphenated, even when they’re used as an adjective. Unit 
symbols aren’t followed by a period unless they appear at the end of a sentence. Don’t 
imply more precision than is reasonable in choosing a unit symbol.

The Apple HDMI to HDMI Cable is 1.8 m long.

The 13-inch MacBook Air computer weighs 1.35 kg.

The iPad mini 4 Wi-Fi models weigh 298.8 g (0.65 lb.).

The iMac computer has a 1.6 GHz, 2.8 GHz, or 3.1 GHz processor.

http://www.itu.int
http://www.bipm.org
http://www.nist.gov/pml/pubs
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